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[Application note – Queensferry Road, Edinburgh]

iSTAR & Agisoft PhotoScan
Date: 12 November 2015
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Agisoft PhotoScan
Products used: NCTech Immersive Studio, iSTAR and Agisoft PhotoScan

Point clouds using NCTech iSTAR 360 HDR images

The iSTAR 360° degree camera provides rapid,
automatic HDR (High Dynamic Range) 360°
imaging and can be used as a standalone
device to create point clouds, especially
indoors or in challenging lighting conditions.
iSTAR can be used to provide HDR imagery
rapidly with up to nine exposures and a total

EV range of 27 f-stops. The aim of this report is
to test the Agisoft PhotoScan software, using
iSTAR images to create 3D point clouds and/or a
digital surface model (DSM). The results of the
project showed that iSTAR provides the ability to
efficiently capture HDR colour images for point
cloud creation, even in low light conditions.
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The aim if this report is to show the required workflow to achieve a
high quality coloured point cloud using NCTech iSTAR imaging and
Agisoft PhotoScan.
01. Software installation
02. Photo Capture
03. General Workflow
04. Results
05. Conclusion
06. Acknowledgements

“Capture with current analysis” iSTAR mode: This is a default iSTAR
setting which activates automatically after taking the first photo.
When the iSTAR camera takes an image, it first analyses the whole
scene to establish the appropriate exposure value averaged across
the 360° degree view. These settings are then saved by default,
meaning analysis time can be saved between multiple captures
within similar conditions. However, for scenes with very changeable
light conditions between shots the function should be cancelled by
pressing the green arrow on the top left corner, the new scene is
then analysed during the next capture.

01. Software installation
Installing NCTech Immersive Studio:
https://www.nctechimaging.com/immersive-studio/
Installing Agisoft PhotoScan:
http://www.agisoft.com/downloads/installer/

02. Photo Capture
Before loading photos in PhotoScan it is required to select those most
suitable for model reconstruction. Considering general environmental
requirements for Agisoft PhotoScan performance:
• Avoid un-textured, shiny, mirror or transparent objects.
• Avoid unwanted foregrounds.
• Avoid moving objects within the scene to be reconstructed.
02.01. PLANNING STATIONS.
Planning capture strategy in advanced is critical. You should consider
the following recommendations:
• Ensure the number of photos gives enough coverage to avoid
blind zones. To reconstruct an area, it is necessary for it to be
visible in at least two images.
• Image overlapping should be 60% or more.
• The object to be reconstructed should take up the maximum
area in the photo.
02.02. CAMERA SETTINGS.
ISO value: in general, the ISO level should be set to the lowest value.
The lower the ISO value, the lower the noise. Nevertheless, depending
on the light conditions, a lower ISO value may increase the exposure
time greater than desired, in which case a higher ISO value can be
used.
HDR value: iSTAR can be set as “Single exposure”, “HDR ON” (5
exposure levels), or “HDR PRO” (9 exposure levels). In general, “HDR
ON” gives excellent results for indoor capture. However, where the
lighting conditions are very extreme with very high levels of light and
dark shadows to be captured in the same scene, HDR PRO will provide
better results for building point clouds.

Img. 02.02. “Capture with current analysis” mode activated.

03. General workflow
General iSTAR workflow within Agisoft PhotoScan differs slightly from
standard, which commonly uses frame images instead of panoramas
but it is nevertheless still user-friendly. The aim of this section is
to explain the general workflow using iSTAR data within Agisoft
PhotoScan workflow.
03.01. PROCESSING PANORAMAS INTO NCTECH IMMERSIVE STUDIO.
Firstly, it is necessary to process iSTAR raw data using NCTech
Immersive Studio in order to produce stitched equirectangular
images. The Immersive Studio stitching process uses the specific
iSTAR calibration file which is created in controlled conditions during
NCTech the factory calibration process for each camera. Processing
images in NCTech Immersive Studio therefore means the user
benefits from this precision calibration with reduced stitching error.
AutoPano Giga 4.2 produced by Kolor, can also be used for stitching of
iSTAR images as it works with iSTAR raw data.
NCTech Immersive Studio automatically sets the output image
resolution to maximum (10K), or alternatively resolution can be
selected from several other pre-set options (2K, 4K or 16 Mpixel).
Resulting point cloud resolution and therefore accuracy, relates
directly to the input image resolution, therefore maximum resolution
is recommended.
NCTech Immersive Studio has a simple and user-friendly interface. To
process iSTAR raw data in Immersive Studio just drag and drop the
corresponding image folders on to the Immersive Studio window,
or select the corresponding directory. Both options lead to the same
result. By default, the output directory is set the same as the input
directory, but can be changed easily by clicking on the dotted button.

Img. 02.01. Low light condition in which iSTAR can provide high quality
results working with HDR ON values.

For further information about how to use Immersive Studio visit
https://www.nctechimaging.com/immersive-studio/
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Img. 03.01. NCTech Immersive Studio interface.
After processing iSTAR raw data in NCTech Immersive Studio,
panoramas will appear into an “Output folder” in *.jpg format.

Img. 03.04. Camera Alignment in Agisoft PhotoScan.
03.03. BUILDING DENSE POINT CLOUD, MESH AND TEXTURING
Building the dense point cloud, mesh and texture doesn’t require any
change from standard workflow using frame images instead of iSTAR
spherical images, so a detailed explanation of these functions are not
included in this Application Note. The General workflow corresponding
to the specifically required process is however considered to show
that it does not change from the frame images common workflow.
Based on estimated camera positions and pictures, a dense point
cloud is obtained after camera alignment stage (Workflow>Build
Dense Point Cloud).

Img. 03.02. Panorama in *.jpg format, after processing in Immersive
Studio.
03.02. LOADING PHOTOS, SENSOR TYPE AND CALIBRATION.
After processing iSTAR raw data, *jpg panoramas must be imported
into Agisoft PhotoScan (1. Add Chunk 2. Workflow>Add Photos or
corresponding icon) then select the appropriate sensor type for iSTAR.
(Tools> Camera Calibration, Camera types: Spherical).
Img. 03.05. Dense point cloud in Agisoft PhotoScan.
PhotoScan reconstructs the 3D polygonal mesh based on the dense
point cloud (Workflow>Build Mesh).

Img. 03.03. Camera Calibration window in Agisoft PhotoScan.

Img. 03.06. Mesh in Agisoft PhotoScan.

Note that calibration parameters are disabled. Because calibration
parameter characteristics for each iSTAR camera have already
been applied during the Immersive Studio stitching process (See
03.01. Processing panoramas into NCTech Immersive Studio) no
further calibration data needs to be applied in the Agisoft PhotoScan
workflow.

After geometry is reconstructed, the model can be textured
(Workflow> Build Texture).

03.02. CAMERA ALIGNMENT.
Agisoft PhotoScan searches for common points on input photos and
automatically matches them. At this stage PhotoScan calculates the
positions of each photo station/placement and its external orientation
(Workflow>Align Photos) from which a sparse point cloud and camera
positions are obtained.
Img. 03.07. Textured Mesh in Agisoft PhotoScan.
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Img. 03.08. Textured mesh. 702,577 faces.
From these 11 panoramas a point cloud of 5,496,728 points and a
mesh of 702,577 faces was obtained, following the general Agisoft
PhotoScan workflow as described above.

04. Results
Coloured point clouds, meshes or intermediate outputs of the process
can be obtained using the described workflow in Agisoft PhotoScan.
The aim of this section is to show the results that can be achieved
using the NCTech iSTAR camera within Agisoft PhotoScan.
The project selected for the purpose of this standard workflow
explanation required 11 panoramas, 5 of them under the archway and
6 external to it.

05. Conclusion
High quality coloured point clouds can be obtained from using
iSTAR within Agisoft PhotoScan, following the general workflow
as described here. The benefits of working with NCTech solutions
combined with the Agisoft PhotoScan for high quality coloured point
clouds and meshes are:
Only one iSTAR shot is needed to cover a 360 environment surface,
which means saving time against taking a larger amount of images to
cover the same area with a non 360 camera.
Larger surface covered per lens. The iSTAR fisheye lens not only
covers a 360 view, but also a larger area per lens.

Img. 04.01. Camera positions used in the current project in Agisoft
PhotoScan.

A knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and automatically calculates the most
suitable camera settings for the full 360 view.
Simple to use, minimal training needed. iSTAR and NCTech software
are designed to be highly automated and user friendly, minimal
training is required.
High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV range of 27
f-stops.
Texture Quality. iSTAR’s whole scene analysis in combination with its
HDR imaging enables the creation of high resolution models with high
quality surface textures.

Img. 04.02. Coloured point cloud. 496.728 points.

To conclude, iSTAR provides imaging which is highly suitable for
photogrammetry purposes within Agisoft PhotoScan. It provides
particularly strong benefits in low light or high contrast environments,
indoors and where there are complex architectures.

06. Acknowledgements
NCTech greatly thanks the Agisoft PhotoScan Team
http://www.agisoft.com/, specially Alexey Pasumansky for their
collaboration and technical support in this Application Note.
Img. 04.03. Textured Mesh (detail). Notice the quality of texture
provided by NCTech iSTAR within Agisoft PhotoScan.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Application note – Various Europe locations]

iSTAR & Agisoft PhotoScan II
Date: 25 April 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Agisoft PhotoScan
Products used: NCTech Immersive Studio, iSTAR and Agisoft PhotoScan

Point clouds from NCTech iSTAR 360 HDR images
Challenges, performance capabilities and accuracy
within PhotoScan automatic basic workflow

The iSTAR 360° camera provides rapid,
automatic High Dynamic Range (HDR) 360
imaging and can be used as a standalone device
to create point clouds, especially indoors, for
complex architectures or challenging light
condition environments. iSTAR can be used
to provide HDR imagery with more exposure
steps and also reduced processing and capture
time compared to standard frame cameras.

The aim of this report is to explain how
iSTAR capabilities can provide improved
results in comparison to frame images
within PhotoScan basic automatic workflow,
in challenging and/or complex situations
(from an image based technique viewpoint).
Furthermore, a deviation comparison of laser
scanning and structure-from-motion point
cloud distances is included.
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The aim of this report is to explore iSTAR performance within
Agisoft PhotoScan basic automatic workflow to virtualise complex
architecture and/or environments and provide accuracy analysis
corresponding to a heterogenic scene to better understand if the
results are within the same range of accuracy than using frame
standard cameras.
01. Software installation
02. Challenging environments
03. NCTech iSTAR features
04. Data capture & General workflow
05. Results
06. Laser scanning comparison
07. Accuracy
08. Conclusion
09. Acknowledgements

01. Software installation
Installing NCTech Immersive Studio:
https://www.nctechimaging.com/immersive-studio/
Installing Agisoft PhotoScan:
http://www.agisoft.com/downloads/installer/

02. Challenging environments
In this Application Note, when talking about challenging environment
we refer to complexity from a virtualisation viewpoint. Therefore,
there are some characteristics that make the task of reconstruct
complex by building point clouds from image matching techniques.
Thus, an architecture or environment can be complex or challenging
due to:
Light conditions: low light conditions, changeable light conditions and
high contrast environments make it difficult to achieve the uniform
light conditions recommended by most photogrammetry or Structure
from Motion software.
Geometry conditions: Sometimes, the shape and the space influence
the photo capture by limiting the capture options available or forcing
us to adopt capture strategies far from the ones recommended.
Texture: Richness of texture as, for instance, provided by granite
stone is far different from the one offered by an immaculate wall
painted white. Both given examples could represent the extremes of
suitable texture (granite stone) and non-suitable texture (immaculate
white wall).
In-between these extremes there are a lot of possibilities and texture
combinations because in reality, not everything is made with granite
stone (or similar) and represents a suitable texture for building point
clouds from image based techniques.
Pattern: This characteristic could be easily included in “Texture”
or “Geometry conditions” since both can generate patterns in
images and therefore difficulties within the image matching process
and introduction of error. However, ‘Patterns’ require specific
consideration so are dealt with separately here.
Size: Small spaces force us to increase the number of images
needed to reconstruct our target and, generally speaking, larger
environments require more images for complete coverage. Large
image sets can lead to processing difficulties due to computing
memory requirements.
Because photo capture technique in such potentially diverse
conditions can affect the results obtained, these factors are
considered as “challenging environments”.
These are situations far from the “recommended conditions” from
main image based technique software vendors, but as they are part
of the daily capture reality, they cannot be avoided.

03. NCTech iSTAR features
HDR capabilities: iSTAR HDR capabilities (HDR ON and HDR PRO) enable
capture of high resolution quality images within low light and high
contrast environments, where details in shadows and bright areas
are also captured. This capability means tie points can be matched
and extracted from shadows and bright areas, meaning overall
number of tie points is higher compared to single exposure images
which provide fewer or no tie points in high contrast areas.
Fisheye lenses: iSTAR is mounted with 4 fisheye lenses which capture
larger areas from the same position in each shot compared with a
standard lens. As a result, the number of images needed is reduced,
saving time on site and at the processing stage. Furthermore, with
fewer images required the computer resource needed is also reduced.
360° images: iSTAR captures 360° spherical images (360° x 137.5°
+/- 5°) which covers the whole scene view in each position, therefore,
problems related with ‘pattern’ are less likely to affect our restitution.
In addition, 360° images provide greater coverage per capture than
regular frames therefore are more efficient in both time on site and
data processing.
Accurate calibration: each iSTAR is precision engineered to 0.002
mm and calibrated at a manufacture stage using over 800 survey
targets in 360 degrees. The user therefore benefits from this accurate
calibration when working with iSTAR data for point cloud creation
from image based techniques.
In comparison with standard cameras used for close-range
photogrammetry, the combination of iSTAR capabilities make it easier
to virtualise indoor environments, locations where high contrast is
likely and spaces tend to be small or reduced.

04. Data Capture & General workflow
In this section, general workflow within Agisoft PhotoScan is covered.
Firstly, before loading photos in PhotoScan, it is needed to check and
select the most suitable for model reconstruction. Considering general
environment requirements for Agisoft PhotoScan performance:
• Avoid non-textured, shiny, mirrored or transparent objects.
• Avoid unwanted foregrounds.
• Avoid moving objects within the scene to be reconstructed.
The aforementioned requirements are extracted from Agisoft
PhotoScan user manual. Note that the first relates to texture of the
virtualisation target and establishes the fundamental limitation or
requirement for proper software performance.
04.01. PLANNING STATIONS
Planning capture strategy in advanced is a must. You should consider
the following recommendations:
• Ensure the number of photos is more than enough, avoiding
blind zones. To reconstruct an area, it is necessary to see it, at
least, in two images.
• Image overlapping should be 60% or more.
• The object is being reconstructed should take up the
maximum area in the photo.
04.02. CAMERA SETTINGS
ISO value: generally speaking, ISO should be set to the lowest value.
The lower the ISO value, the lower the image noise. Nevertheless,
depending on the light conditions, sometimes a lower ISO value
increases the time of exposure beyond that desired so it could be
preferred to balance capture time against the best practice of using
the lowest ISO level.
HDR value: iSTAR can be set to HDR OFF (Single exposure), HDR ON
(5 exposure levels), HDR PRO (up to 9 exposure levels). Generally
speaking, HDR ON can be more than sufficient for indoor capture.
However, there are some landscapes, scenes or building rooms with
a wider dynamic range. In such cases, HDR PRO will provide better
results for building point clouds.
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04.03. PROCESSING PANORAMAS INTO NCTECH IMMERSIVE STUDIO.
Firstly, it is necessary to process iSTAR raw data using NCTech
Immersive Studio. Each iSTAR camera is carefully calibrated in highly
controlled conditions during manufacture by NCTech and has its own
calibration file. Processing images within Immersive Studio therefore
means the user gains the advantage of this precise calibration,
thus, the error is generally reduced compared to stitching in other
software. Kolor Autopano Giga can also work with iSTAR data but
we nevertheless recommend to use ImmersiveStudio, which is
continuously being improved by the NCTech development team.
NCTech Immersive Studio can set the output image resolution
automatically or It can be selected from several pre-set options (2K,
4K or 16 Mpixel). Resolution is known to be directly related with
accuracy so, it is advised to select the 10K highest resolution option
(Auto).

Img. 04.01. Low light condition in which iSTAR can provide high quality
results working with HDR ON values.

NCTech ImmersiveStudio has a simple and user-friendly interface. To
process iSTAR raw data into Immersive Studio just drag and drop the
corresponding folders of each image on the Immersive Studio window
or, select the corresponding directory. Both options lead to the same
result. As default, output directory is the same as input directory
but it can be changed easily by clicking on dotted button. For further
information about how to use ImmersiveStudio visit
https://www.nctechimaging.com/immersive-studio/

Img. 04.02. Challenging light conditions in which iSTAR can provide
high quality results working with HDR ON.
“Capture with current analysis” iSTAR mode: This is a default iSTAR
setting which activates automatically after taking the first photo.
When iSTAR camera takes an image, firstly it analyses the whole
scene to establish the proper time exposure value averaged to the
360° view, and then it takes the image. Using this setting means
analysis time can be saved between captures in similar conditions.
However, scenes with changeable light conditions require the
analysis to optimise per shot. Going back one screen by pressing the
green arrow on the left up corner will disable the setting.

Img. 04.04. NCTech ImmersiveStudio interface.
After processing iSTAR raw data into NCTech Immersive Studio,
panoramas will appear into an “Output folder” in *.jpg format.

Img. 04.05. Panorama in *.jpg equirectangular format, after processing
in NCTech ImmersiveStudio.
04.04. LOADING PHOTOS, SENSOR TYPE AND CALIBRATION.
After processing iSTAR raw data, *jpg panoramas need to be imported
into Agisoft PhotoScan (1. Add Chunk 2. Workflow>Add Photos or
corresponding icon) and select the suitable sensor type for iSTAR.
(Tools> Camera Calibration, Camera types: Spherical).
Img. 04.03. “Capture with current analysis “mode activated.
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Generally speaking, around 12 images would be needed on average to
virtualise such an example as this church entrance, by using a
standard frame camera, whereas the following results were obtained
by using just two iSTAR images. Due to it’s 360° coverage, iSTAR is
capable of covering several surface angles and therefore build point
clouds from targets with complex shapes with much fewer images.
Note that the level of detail and/or definition gained is comparable
to that obtained with a standard frame camera commonly used for
close-range photogrammetry.

Img. 04.06. Camera Calibration window in Agisoft PhotoScan.
Notice calibration parameters will appear disabled. Calibration
parameters characteristic of each NCTech iSTAR camera have been
applied within NCTech Immersive Studio processing (See 04.03.
Processing panoramas into NCTech Immersive Studio) so, after
processing it is considered to be without lens deformation in Agisoft
PhotoScan workflow.
04.05. FLOOR RECONSTRUCTION.
When the target of our virtualisation includes the floor, consideration
should be made for the camera position and, camera FOV in order
to maintain the required overlap between images. Depending on the
project, the number of images may need to be increased if full and
accurate floor coverage is needed. Furthermore, it is recommended to
consider applying a mask on the nadir area.
04.06. CAMERA ALIGNMENT.
Agisoft PhotoScan searches common points on photos and matches
them. At this stage PhotoScan finds the positions of each photo
station/placement and its external orientation (Workflow>Align
Photos). After this process, a sparse point cloud and camera positions
are obtained.
04.07. BUILDING DENSE POINT CLOUD, MESH AND TEXTURING.
The process of building dense point cloud, mesh and texture for
iSTAR images does not change from the common workflow using
frame images, so, the description and function of each option is not
explained in this Application Note.
Based on estimated camera positions and pictures, a dense point
cloud is obtained after camera alignment stage (Workflow>Build
Dense Point Cloud). PhotoScan reconstructs the 3D polygonal
mesh based on the dense point cloud (Workflow>Build Mesh). After
geometry is reconstructed, the model can be textured (Workflow>
Build Texture).

Img. 05.01. Point cloud gained from two iSTAR 360 images within
PhotoScan. Morningside church door. Note level of detail obtained from
just two images.
05. 02. VAULT LINKS.
Glasgow university vault links project (Glasgow city, United Kingdom)
is used to show the results achieved using iSTAR images with
Agisoft PhotoScan for complex architectural shapes in combination
with changeable challenging conditions. Note that virtualising this
environment using a frame camera and fully automatic PhotoScan
settings could lead to orientation problems due to repeated patterns.
However, iSTAR 360 images overcome pattern problem easily and
no orientation problems were experienced, even when only using
PhotoScan automatic settings. Furthermore, iSTAR automatically
analyses the whole scene dynamic range to establish the most
suitable exposure values, providing HDR results with no user-decision
making.
Note that taking images with a standard frame camera in changeable
light conditions (due to vault links architecture) for building point
clouds by image matching techniques would be a challenging
exercise.

05. Results
Coloured point clouds, meshes or intermediate products of the
process can be obtained using the described workflow in Agisoft
PhotoScan. The aim of this section is to show the results that can be
achieved using NCTech iSTAR camera with Agisoft PhotoScan.
Several PhotoScan projects were carried out to show the results
possible using iSTAR within Agisoft PhotoScan, in situations
considered complex for building pointclouds based on image
matching techniques (See 02. Challenging environments).
05.01. CHURCH DOOR.
A project to digitise a church door and entranceway (Edinburgh city,
United Kingdom) shows the advantages of using iSTAR in typically
challenging situations. A church door / entranceway or other similar
historical subjects are common examples for those needing to
virtualise architectural features using close-range photogrammetry
techniques.

Img. 05.02. Textured mesh gained from HDR iSTAR images within
PhotoScan. Glasgow university vault links.
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05. 03. BRIDGE.
Queensferry bridge project (Edinburgh city, United Kingdom) shows
the benefit of using iSTAR for building point clouds within low light
conditions. Note that the main problem in such environments
(bridges, tunnels, galleries etc.) occurs at the entrance, where HDR
capabilities became almost mandatory in order to achieve good
results. Indoor tunnels or under bridges low light conditions with a
wide dynamic range environment are common. Furthermore, note
that using a standard frame camera will introduce divergences
between images and therefore, point cloud noise is likely to increase
if sufficient user care is not taken. As has been commented, the
required number of images will likely increase, even more in those
cases (bridges, tunnels, galleries etc.) where space is reduced. In
addition, using a standard frame camera to virtualize this kind of
environment will introduce pattern and therefore, orientation
problems are likely to appear.

Img. 05.05. Urban environment textured mesh gained from HDR iSTAR
images within PhotoScan. Façade with rich geometry detail (general).

06. Laser scanning comparison

Img. 05.03. Coloured point cloud within low light conditions gained
from HDR iSTAR images within PhotoScan.
05. 04. URBAN ENVIRONMENT.
Urban environments represent a virtualisation challenge for image
matching techniques for point cloud creation because of their
heterogeneity. The texture and shape of buildings usually is very
changeable in these environments, especially where the planning
guidelines do not establish common criteria for building materials and
shape and therefore capture strategy must be adjusted to suit each
situation/area or neighbourhood, depending on specific conditions.
An urban environment project (A Coruña, Spain) was carried out to
compare the accuracy differences that can be achieved by using iSTAR
images within Agisoft PhotoScan depending on the texture of the
subject. Urban environments also benefit from 360° features which
capture both sides of a street or more at the same time, ideal for
squares and crossings.

Img. 05.04. Urban environment textured mesh gained from HDR iSTAR
images within PhotoScan. Plan.

Laser scanning and photogrammetry are two of the main
technologies traditionally used for documentation tasks based on
reality capture. Historically, professionals and researchers from both
sides have discussed comparative suitability and performance. Over
the last decade, laser scanning has become the dominant technology
for reality capture. Nevertheless, the rapid improvement of camera
systems, software and computer capabilities have increased the
competitiveness of photogrammetry, especially when considering
cost differences. Nevertheless, it is not the aim of this report to
argue for one or other side, rather to explain the comparative results
which can be obtained from both technologies for the same urban
environment, using standard capture and processing conditions.
It can be seen that there are some holes in both models. These relate
to people and cars passing through the (public) scene during capture.
Scan stations were established to capture the environment, taking
care of the crossing cars and very windy weather conditions.

Img. 05.06. Urban environment textured mesh gained from HDR iSTAR
images within PhotoScan. Façade with rich geometry (detail).
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In this example each laser scan station took around 8 minutes
including single exposure colour capture from the laser scanner
internal camera (FARO Focus X130).
iSTAR was set to HDR ON (5 exposure values) mode resulting in
capture times of around 25 seconds per position - critical phase
during when iSTAR must be stationary. Additional approx. 1min per
position for data save between captures (iSTAR can be moved in this
phase).
Quicker capture not only saves time but is also more likely to avoid
traffic inconvenience issues.

Img. 06.04. Urban environment point cloud gained from iSTAR data
within Agisoft PhotoScan. Note the colour representation is improved
compare to Img. 05.10. and some occluded areas have no points.
The previous images show the point cloud results obtained from laser
scanning and photogrammetry from a similar view point within an
urban environment.

Img. 06.01. Urban environment laser scanning grey point cloud. Plant.
Note the holes corresponding to station positions, occluded areas and
crossing cars.

Note that the pointcloud obtained from laser scanning doesn’t match
the real colour of the environment, showing brighter areas increasing
along the building heights and general miscolourisation as a result
of single exposure image capture not adequately coping with the
dynamic range of lighting in the scene. Furthermore, virtualisation
problems in windows and door glass are more frequent in the point
cloud gained from laser scanning.
In comparison, the point cloud obtained from structure-from-motion is
less uniform and more dependable on surface texture (white building
in the background or cream building on the left where texture is plain,
would give lower quality results). Visually, it could be perceived that
the noise level in such areas is similar to the others, but unfortunately
that is not the case upon closer inspection.
There are some techniques to improve results from plain or poor
texture however it is not the aim of this report explain those, our key
objective is to show the comparative standard results that can be
obtained by using the very basic automatic workflow within Agisoft
PhotoScan.

Img. 06.02. Urban environment laser scanning coloured point cloud
using single exposure laser scanner internal camera. Note bright areas
of colour “hide” the point cloud.

Img. 06.05. Urban environment laser scanner point cloud coloured from
laser scanner internal camera. Note miscolourisation, bright areas and
missing points in glass areas.

Img. 06.03. Urban environment laser scanning grey point cloud. Note
glass areas information don’t match the reality and some occlude areas
has no points.
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Img. 06.06. Urban environment laser scanner grey point cloud. Note
missing points in glass areas and occluded elements.

Img. 06.09. Church detailed façade coloured point cloud obtained from
iSTAR data within PhotoScan on the right and laser scanning on the
left. Note the results are very close each other although laser scanning
presents some colour limitations.

07. Accuracy

Img. 06.07. Urban environment textured mesh obtained from iSTAR
data within Agisoft PhotoScan. Note the realistic colour fidelity.
The images Img.06.05, Img. 06.06 and Img. 06.07 show point cloud
obtained from laser scanning and textured mesh obtained from
structure-from-motion within the standard PhotoScan workflow of
urban heterogeneous building facades. At Img. 05.11 miscolourisation
is evident. Generally speaking, definition increases with a textured
mesh reducing the need to deal with a very dense point cloud, which
for elements without complex geometry this is not a requirement.
Observing to church facade with rich texture for photogrammetry
purposes, it can be seen that it looks reasonably close in quality to a
laser scanner point cloud, even when we look in detail. In this case,
general visual quality is better than the that obtained from the laser
scanner only, considering the single exposure colour capture of the
laser scanner internal camera.

Img. 06.08. Detailed church façade coloured point cloud obtained from
iSTAR data within PhotoScan. Note the results are very close to the
results that can be obtained from laser scanning.

Accuracy gained from image matching techniques for point cloud
creation depends on several factors: camera-object positioning, pixel
size, camera calibration, texture of the object, external environmental
parameters like weather conditions, using control points or not, using
natural dot or coded targets. Therefore, different situations lead to
different accuracy values although for similar situations accuracy
values are expected to be within a similar range.
The process of obtaining point clouds and textured meshes from
image matching techniques is easy and the learning curve of the
process is almost nil. However, it is of paramount importance that
photogrammetry principles are understood and considered in each
situation to pursue accurate results. In addition, a net of control points
is advisable to gain the best and most accurate results.
In this section, a cloud-to-cloud distance comparison between point
cloud obtained from iSTAR data within Agisoft PhotoScan and that
from the laser scan was made. The environment was chosen because
of its heterogeneity which will allow us to identify and analyse
different accuracy results depending on target features. It needs to
be highlighted that the aim of photo capture was to virtualise the
general urban environment without paying close consideration to
reconstruction of detailed areas, which may improve the accuracy
results in detailed areas.

Img. 07.01. Urban heterogeneous group of facades. Laser scanner point
cloud.
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Img. 07.02. Urban heterogeneous group of facades. iSTAR – laser
scanning pointcloud distance comparison.
Seeing at Img. 07.02 several issues need to be pointed out. As was
mention in the previous section, the cream façade showed a higher
level of noise and had to be filtered for better cloud-to-cloud distance
computation. Thus, the red areas mainly correspond to door or
window zones, which are not reliable areas within a pointcloud
gained from laser scanning so, we should exclude windows and
doors from accuracy comparisons. In addition, the are some façade
areas in red which mainly correspond to missing areas in the
pointcloud gained from the laser scanner due to the different capture
station for iSTAR data and laser scanning.

Img. 07.03. Cloud to Cloud distances distribution graphic. Heterogenic
façade group.
If we consider just this group of facades, the most common deviation
between both point clouds is around 5 mm. (See Img. 07.03. Cloud to
cloud distance distribution graphic).
When analysing an area with richer texture we gain more uniform
values as can be seen at Img. 07.04. Where most values are in blue
and the green values could be improved with a capture process
focussing on the façade details instead of a general capture for the
urban environment site. Red areas correspond to strong shadows
from the door details as can be seen at Img. 07. 05.

Img. 07.04. Church detailed facade. iSTAR
– laser scanning pointcloud distances.

Img. 07.05. Church detailed facade. iSTAR panoramic image. Note
strong dark shadows at the top of the door.
When analysing the whole point cloud, the majority of error values
achieved are under 1 cm, as shown in the following graphic:

Img. 07.06. Cloud to Cloud distances distribution graphic. General
analysed urban environment.
It is shown that the number of “red” points with greater distance
increases in the far right column of the graphic. These points
correspond to the specific areas explained before (glass, windows
and non-common points) and missing zones on the scan point cloud
as scan stations, cars and people.

Img. 07.07. Holes within laser scanning point cloud that add “red
points” to our cloud to cloud distance analysis.
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These accuracy values correspond to this unique photo capture
situation with its specific conditions and restrictions, and therefore
it should not be extended to be applied to all situations. However,
similar capture conditions will lead to accuracy results within the
same range.

High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV range up to
27 f-stops.
Texture quality. iSTAR whole scene analysis in combination with HDR
provides models with high quality textures.

08. Conclusion
Point clouds obtained using iSTAR data for image matching
techniques share the general advantages of this technique against
other virtualisation methods/procedures such as the laser scanner
(mainly cost advantages and simple data processing among others).
However, using iSTAR for image capture adds new advantages
compared to data obtained from standard frame cameras commonly
used for the same purpose, as explained before:
Only one iSTAR shot is needed to cover a 360 degree environment
surface, which means saving time against taking a larger amount of
images to cover the same area with a non 360 camera.
Larger surface covered per lens. iSTAR fisheye lens permits not only
covering a 360 view but also a larger area per lens and therefore, the
number of images needed is reduced. Furthermore, pattern problems
are less likely to occur.
The number of images needed to accomplish a virtualisation is
reduced, especially within objects with close spaces, complex shapes
and/or several surface angles. The number of images also decreases
within challenging lightning conditions because of iSTAR’s automatic
HDR capabilities.
Time saving on-site and processing. By decreasing the number of
images needed to virtualise a scene time consumed on site is reduced
as also is the time and resource needed to process the captured data.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and work out the most suitable camera
settings for the full 360 view.
Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, minimal training
is required.

Adding extra value. Additional deliverables such as virtual tours can
be produced form the same source iSTAR images without increasing
time on site.
Less resources needed. Coloured point cloud, mesh and/or
textured mesh can be automatically obtained following a simple
straightforward workflow within Agisoft PhotoScan. Results gained
from image matching techniques require, on average, less computing
resources than products obtained from laser scanning.
Accuracy. Note that the accuracy values analysed at section 07
are gained by using fully automatic basic PhotoScan workflow
and neither dot-targets or coded-targets were used in the scene.
Therefore, results could be improved by not limiting use to the
automatic basic PhotoScan workflow.
To conclude, iSTAR capabilities are worth considering it for
photogrammetry purposes. Especially in low light condition
environments, indoors, and some complex architecture where iSTAR
benefits make a difference. The 360° FOV in combination with HDR
capabilities and highly accurate calibration at the manufacture stage
improves the workflow and results by reducing capture and process
time and increasing the tie points detection within challenging light
conditions.
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[Application note – Blackburn Rovers, Ewood park]

Trimble TX8 scan colourisation with iSTAR HDR images
Date: 18 September 2015
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Trimble, Korec Group, Blackburn Rovers
Products used: NCTech Immersive Studio, NCTech ColourCloud and TRIMBLE RealWorks

Using the NCTech iSTAR 360 camera and ColourCloud
point cloud colourisation software to provide
rapid HDR imaging for Trimble’s TX8

The iSTAR 360 degree camera provides rapid,
automatic HDR (High Dynamic Range) 360
imaging and can be used as a standalone device
or for colourisation of point clouds created by
spherical terrestrial scanners. Trimble’s TX8
scanner does not provide for internal colour
capture so iSTAR can be used as a companion
HDR external camera.

A project was undertaken to scan and image
the Blackburn Rovers football stadium, Ewood
Park using both technologies, to show their
combined capabilities. The results of the
project showed that iSTAR provides the ability
to efficiently capture HDR colour and accurately
combine this with the scan data for significantly
improved 3D visualisation.
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There are two different office workflows that can be used for point
colourisation, either in NCTech ColourCloud or TRIMBLE Realworks v.9.
Users can choose the option most suitable depending on the project
requirements.
01. Software installation
02. Fieldworks
03. Office-work
04. Results
05. Conclusion
06. Acknowledgements

01. Software installation

02.03. CAPTURE iSTAR IMAGES by replacing the TX8 with the iSTAR¹
camera at each scan station, and capture 360 images in full HDR
colour. NCTech supply adaptor rods with a Tribrach quick release
repeatable connector to accurately and quickly locate iSTAR at the
same central capture position as the scanner. iSTAR has different HDR
modes enabling single exposure, five exposure and nine exposure
360 images to be created. Five exposure HDR imaging was used here.
The total iSTAR capture and data save process is approximately90s
per scan position, however the camera can be moved after the
capture phase completes which is typically around 15-20 seconds.
iSTAR’s on camera user interface is designed to be like a regular
automatic digital camera. Knowledge of photographic techniques is
not required with iSTAR automatically calculating the most suitable
exposure value taking into account the entire 360 scene.

Installing NCTech Immersive Studio:
https://www.nctechimaging.com/immersive-studio/
Installing NCTech ColourCloud:
https://www.nctechimaging.com/colourcloud/
Installing TRIMBLE Realworks:
http://www.trimble.com/3d-laser-scanning/realworks.aspx

02. Fieldworks
Working with NCTech solutions is the easiest and most accurate
method of colouring point clouds with iSTAR images:
02.01. PLANNING SCAN STATIONS requires no change to standard
process for scanning with or without colour.
02.02. CAPTURING POINT CLOUDS with the TX8, choose the Laser
Scanner resolution you consider most suitable for the job as in normal
use. NCTech solutions work well irrespective of scan resolution.

Img. 02.03 and Img. 02.04. LaserScanner and iSTAR station (general).

Img. 02.05 and Img. 02.06. LaserScanner and iSTAR station (detail).

03. Office-work
Img. 02.01. Target placements to register point clouds.

03.A. NCTech ColourCloud v.1.1 with TRIMBLE Realworks v.9.
03.A.01. REGISTER MULTIPLE SCANS. Open your scans (*.tzf format)
into TRIMBLE Realworks and register using the ordinary method most
suitable for your scan stations (based on targets, cloud-to-cloud, etc).

Img. 02.02. Common targets between scan stations. At least, 3
common targets are needed to register in TRIMBLE RealWorks point
clouds based on targets.

Img. 03.01. Scan Stations open into TRIMBLE RealWorks before
registration. Each station appears with different colour.

1 - NCTech recommend using its adaptor poles to accurately locate the camera in the correct
position, different adaptors are used for other laser scanning systems (Leica, Faro, Trimble,
Topcon, Z_+F, Surphaser etc).
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Img. 03.02. Scan Stations open into TRIMBLE RealWorks after
registration. Target based and cloud-to-cloud registration methods
were used in this study case.

Img. 03.05. TRIMBLE RealWorks interface. Scan Stations have been
already opened but point clouds cannot be seen in it.

03.A.02. SAVE REGISTER FILE and EXPORT TO *.e57 FORMAT. Save your
project register information as *.rmx file and export each scan station
into *.e57 format. Notice *.e57 files must be exported with intensity
information. Although you choose “save *.rmx data once, a *.rmx file
will be created for each station.

Img. 03.06. TRIMBLE Scan Explorer interface. Scan Station must be
chosen to charge its point cloud on TRIMBLE RealWorks interface.
Img. 03.03. Export Scan Stations from TRIMBLE RealWorks after
registration into *.e57 format with intensity values.

Img. 03.07. TRIMBLE Scan Explorer interface. *.e57 file exportation.

Img. 03.04. *.rmx files which registration information. There will be a
*.rmx file for each station but you only have to “click” save RMX once.
If the scan stations don’t appear when you open Realworks, you can
load them into Realworks and Export them from “Scan Explorer”
window.

03.A.03. COLOUR POINT CLOUDS. Drag and drop into ColourCloud
each folder containing the point cloud (*.e57 format) file with the
corresponding station iSTAR files (*.yml calibration file and *.nctri raw
data file). Simply press ‘Process’ in ColourCloud, the colourisation
process is fully automatic and typically takes around 160s per scan/
capture position (point cloud size, resolution and PC specification
dependant). Batches of data can be processed together with each
scan position folder containing the correct files are all located in one
parent folder, which is dropped into ColourCloud. NCTech ColourCloud
will save the point cloud with colour in the same directory as your
original point cloud without colour. “iSTAR” will automatically be added
to the name of your new coloured point cloud (*.e57) file.
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03.B. ALTERNATIVE METHOD USING TRIMBLE Realworks & RealColor v.9
FOR COLOURISATION.
03.B.01.iSTAR PANORAMAS. Process iSTAR images using NCTech
Immersive Studio. Simply drag and drop your images folders from
iSTAR to NCTech Immersive Studio window, select the operations you
want to performance (Stitch images) and “click” “Process”. By default,
Immersive Studio save the images in the same folder of the images
you are processing but you can choose the folder you want.

Img. 03.08. NCTech ColourCloud interface after drag and drop.

Img. 03.09.*.e57 file automatically created in the original directory.
“iSTAR” has been added automatically to the name.
03.A.04. IMPORT point clouds WITH COLOUR AND REGISTER FILE. To
continue your works into TRIMBLE Realworks you only have to open
and import the coloured point clouds from NCTech ColourCloud and
the registered file *.rmx into Realworks. Notice that the name of
registration (*.rmx) files and point clouds (*.e57) must be the same in
each station.

Img. 03.12.NCTech Immersive Studio interface. Stitching images in
process.
03.B.02. REGISTER. (only if more than one scan station) Open your
scans (*.tzf format ) into TRIMBLE Realworks and register using the
method most suitable for your scan stations (based on targets, cloudto-cloud, etc).
03.B.03. COLOUR POINT CLOUDS. Open “RealColor” and import iSTAR
panoramas to RealColor workspace. Once they are imported you only
have to match each panorama with its corresponding scan station
and click on “Process”. When complete, revert back to Realworks
workspace to continue your project. After the colourising process
finishes, you’ll be able to navigate into TRIMBLE Scan Explorer
interface in colour.

Img. 03.13.TRIMBLE RealColor interface with iSTAR panoramas
imported, two of them are matched.
Img. 03.10.point clouds (*.e57 files) coloured by NCTech ColourCloud
imported into TRIMBLE RealWorks interface.

Img. 03.11.point clouds (*.e57 files) coloured by NCTech ColourCloud
imported into TRIMBLE and previous registration information after
import *.rmx files.

Img. 03.15.TRIMBLE Scan Explorer interface in which navigation in
colour is possible after colourising process.
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04. Results

05. Conclusion

Coloured point clouds are obtained following both workflows. 11 Scan
and iSTAR stations were used to obtain a merged coloured point cloud
of Blackburn Stadium.

Coloured point clouds can be obtained by using iSTAR for image
capture, then following either scan colourisation method as
described. The benefits of working with NCTech solutions combined
with the TX8 for cloud colourisation are:
Only one iSTAR shot is needed to colour the entire scene at each view
instead of multiple shots and images per position. This means less
time on site and also eliminates patchy colourisation experienced
where individual images are optimised for their omnidirectional view,
then combined, which may happen when a single lens camera is
used to colour the whole 360 scene.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and work out the most suitable camera
settings for the full 360 view.
Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, minimal training
is required.
Automatic overlay of iSTAR images to point clouds, avoiding having
to manually define common points, eliminating user error & enabling
batch processing for efficient operation.
High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV range of 27
f-stops.
ColourCloud works with standard format *.e57 files, for easy
connection with any scanner exporting that neutral format.

06. Acknowledgements
NCTech greatly thanks KOREC Group http://www.korecgroup.com/,
especially Richard Shelby, Karen Stone and Anthony Morley for their
collaboration and technical support in this Application Note.

Img. 04.01., Img 04.02. and Img 04.03. Coloured point clouds by NCTech
ColourCloud in TRIMBLE RealWorks interface.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com

Img 04.04. Coloured point cloud by NCTech ColourCloud in TRIMBLE
RealWorks interface.
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[Application note – Glasgow University, Glasgow]

Leica P40 scan colourisation with iSTAR HDR images
Date: 16 June 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Leica Geosystems, Glasgow University
Products used: Leica Cyclone 9.1 with NCTech iSTAR image integration

NCTech iSTAR 360 camera to provide rapid HDR imaging
for Leica P40 point cloud colourisation

The iSTAR 360 degree camera provides rapid,
automatic HDR (High Dynamic Range) 360
imaging and can be used as a standalone device
or for colourisation of point clouds created by
spherical terrestrial scanners. Although Leica’s
P40 scanner can provide internal HDR colour
capture, iSTAR can be used to provide HDR
imagery with more exposure steps and with

reduced capture time. A project was undertaken
to scan and image the Glasgow University
Building, using both technologies, to show
their combined capabilities. The results of the
project showed that iSTAR provides the ability
to efficiently capture HDR colour and accurately
combine this with the scan data for significantly
improved 3D visualisation and time saving.
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The aim if this report is to show the workflow used to achieve quality
coloured point cloud using NCTech iSTAR imaging integrated into Leica
Cyclone 9.1 and its advantages.
01. Software installation.
02. Fieldworks.
03. Office-work.
04. Results.
05. Colourisation using iSTAR data against laser scanner internal camera.
06. Leica TrueView.
07. Conclusion.
08. Acknowledgements.

01. Software installation

NCTech supply adaptor rods with a Tribrach quick release repeatable
connector to accurately and quickly locate iSTAR at the same central
capture position as the scanner. iSTAR has different HDR modes
enabling single exposure, five exposure and nine exposure 360
images to be created. Five exposure HDR imaging was used here and
additional capture time was approximately 30-75s² per scan position.
iSTAR’s on camera interface is designed to be like a regular automatic
digital camera. Knowledge of photographic techniques is not required
with iSTAR which automatically calculates the most suitable exposure
value taking into account the entire 360 scene. Capture time saving
is around 8-10 minutes per station compared to taking images with
laser scanner internal camera. Typical comparative capture times
are 12-14 minutes per station (point cloud scanned + internal camera
images) against 5-6 minutes per station (point cloud scanned + iSTAR
data).

Installing Leica Cyclone:
hds.leica-geosystems.com/en/Support-Downloads-CycloneDownloads_27054.htm

02. Fieldworks
Working with NCTech solutions is the easiest, most accurate and
highest speed method of colouring point clouds with iSTAR images:
02.01. PLANNING SCAN STATIONS no change to standard process for
scanning with or without colour.
02.02. CAPTURING POINT CLOUDS with the Leica P40, select the Laser
Scanner resolution you consider most suitable for the job as in normal
use. NCTech solutions work irrespective of scan resolution.

Img. 02.03. Adaptor rod and Tribrach setting to achieve the right
position for works with Leica P40 laser scanner.

03. Office-work
The whole colourisation workflow is fully integrated inside Leica
Cyclone 9.1.
03.01. OPEN SCAN DATA IN LEICA CYCLONE.

Img. 02.01 and Img. 02.02 LaserScanner and iSTAR station.
02.03. CAPTURE iSTAR IMAGES by replacing the P40 with the iSTAR¹
camera each scan station, and capture 360 images in full colour.

1 - NCTech recommend using its adaptor poles to accurately locate the camera in the correct
position, different adaptors are used for other laser scanning systems (Leica, Faro,Trimble,
Topcon, Surphaser, Z+F, etc).

Img. 03.01 Editing preferences window the first time the user opens
Leica cyclone.
2 - The full iSTAR capture process includes “Analysing time”, “Capturing time” and “Saving time”.
During saving time the “OK to move iSTAR” message will appear on the iSTAR screen, at which
point iSTAR can be moved to the next capture position.. For this reason in this example 30-75s
doesn’t include “Saving time”.
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The first time you run Leica Cyclone, you should turn off Survey
mode since it displays the individuals scans in their own folders.
Edit>Preferences>Scan>Survey Mode: No. Check that level is set to
default.

Now, you can import the scan data to the new database which has
been created before.
File>Import>Import ScanStation Data> Import ScanStation Project to
import scan station data for a new project.

To import raw files from a scanner, you need to first create a Cyclone
database.
Configure> database>add.Add any filename that you choose. Leave
Database Filename field empty (no Cyclone database has been
created yet).

Img. 03.03. Import StationProject in Leica Cyclone 9.1.
When importing scan data into cyclone ensure you have selected
“remove mixed pixels” during data import. This will reduce the
amount of noise.

Img. 03.04. Import StationProject parameters in Leica Cyclone 9.1.

Img. 03.02. Database creation in Leica Cyclone 9.1.
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03.02. REGISTRATION INTO LEICA CYCLONE
Select your project folder under your data base and click
“Create>Registration” Double click on registration icon to open it.

If targets have not been used, as in this case of study, you must
manually identify common points or areas between two scans. You
can do this using the “Cloud Constraint Wizard” by selecting those
point clouds which have common areas (Cloud Constraint> Cloud
Constraint Wizard) or you can do it using “Visual Registration” (Visual
registration>Visual alignment).

Img. 03.08. Cloud Constraint Wizard in Leica Cyclone 9.1.
Img. 03.05. Registration creation in Leica Cyclone 9.1.

Img. 03.06. Registration window in Leica Cyclone 9.1.
Once registration has been created you can add your scans clicking
ScanWorld>Add and selecting all scans you want to register in the
emergent window.

Img. 03.07. Adding scans to the registration in Leica Cyclone 9.1.

Img. 03.09. Visual alignment in Leica Cyclone 9.1.
To calculate the errors, click Registration>Register. You can check the
error results at “Constraint list” tab. Once the error values were ok for
you, click Registration> Create Scanworld/Freeze Registration.

Img. 03.10. “Constraint list” tab in Leica Cyclone 9.1.
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To view the data Registration>Create and Open ModelSpace.

Img. 03.12. Example of partial mismatching between point cloud and
colourisation data in Leica Cyclone 9.1.

Img. 03.10. Registered Point cloud in Leica Cyclone 9.1.

Img. 03.13. Example of general mismatching between point cloud and
colourisation data in Leica Cyclone 9.1.
To colourise your point cloud you need to import the iSTAR raw data
file into Cyclone as Panoramic Image and match each iSTAR image
data with the corresponding scan station. You can then apply the
image to the point cloud.

03.02 COLOURISATION INTO LEICA
CYCLONE USING iSTAR DATA
After registering the point clouds you can then colour them using
iSTAR raw data directly within Leica Cyclone from version 9.1. This
process does not require any pre-processing of images or exporting
of point clouds in *.e57 format. The whole process of colourisation is
done within Leica cyclone 9.1 and is totally integrated.

Firstly, import iSTAR data by using the option corresponding to
panoramic images by clicking the right button mouse >Import
Panoramic Images on the main folder database. An emergent window
will appear in which iSTAR main folder need to be selected.

Before starting the colourisation process, ensure registration is
correct with no duplicates or alignment error, otherwise mismatching

between iSTAR data images and point clouds may occur.
Img. 03.11. Example of partial mismatching between point cloud and
colourisation data in Leica Cyclone 9.1.

Img. 03.14. Import iSTAR image raw data folder in Leica Cyclone 9.1.
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Secondly, the “Match image to Scans” window will appear
automatically where a scan and image data preview are shown.
Match each image data to the corresponding scan station. Lock
each correspondence by clicking on “Lock” button. If “Lock” button is
pressed without any pre-selection image, scan data matching will be
automatically done following the proposed order. Thus, locked pairs
will be moved to the “Locked” tab.

Img. 03.17. Point cloud colourisation by using “Batch Apply
MultiImages” comand in Leica Cyclone 9.1.

04. Results
Coloured point clouds are obtained following described workflow. 18
Scan and iSTAR stations were used to obtain a merged coloured point
cloud of Glasgow University Building. Results are showed in Leica
cyclone 9.1. and also 3rd party software.

Img. 03.15. iSTAR: Leica P40 data matching in Leica Cyclone 9.1.
Once the scan station scan data is matched, click on “OK” to launch
the data alignment process. When complete the “Import Panoramic
Images” window will appear. Select “OK” to import the iSTAR data in
cube format. Finally, just apply the colour to the images by right clicking
on the main project folder and selecting “Batch Apply MultiImages”.

Img. 03.16. Import iSTAR image raw data folder in Leica Cyclone 9.1.
The same workflow for both import data and colourisation can be
applied to a single scan station by right clicking on the scan station
and selecting “Import Panoramic Images” or “Apply MultiImages”.

Img. 04.01. and Img. 04.02. Visualisation of Coloured Point clouds in
ModelSpace of Leica Cyclone 9.1.
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Img. 04.03. Visualisation of coloured point clouds with iSTAR data in 3rd party software. General view.

Img. 04.04. Visualisation of coloured point clouds with iSTAR data in 3rd party software. Detail.
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05. Colourisation using iSTAR data
compared to using internal laser
scanner camera

This allows us to compare the quality provided by each image source
under the same conditions.

As it is shown in the previous section, it can be observed (Img. 04.03
and Img. 04.04) that the representation of the colour in Leica Cyclone
is different compared to visualisation using a 3rd party software.
In this section the difference of colourisation using iSTAR data and
internal laser scanner camera is analysed in both Leica Cyclone and
3rd party software.

Img. 05.04. Visualisation of Point clouds with iSTAR data using NCTech
ColourCloud in 3rd party software.

Img. 05.01. Visualisation of Coloured Point clouds with iSTAR data in
TruView from Leica Cyclone 9.1.

Img. 05.02. Visualisation of Coloured Point clouds with laser scanner
internal camera data in TruView from Leica Cyclone 9.1.

Img. 05.05. Visualisation of Point clouds with iSTAR data using Leica
cyclone to colourisation in 3rd party software.

Looking at Img. 05.01 and Img. 05.02 it can be observed that iSTAR
data coloured point clouds give improved visual resolution for any
occluded area through the interpolate and fill occluded areas function.
This functionality is automatic within cyclone during colourisation,
and corresponds to one of the several options that can be selected in
NCTech ColourCloud.

Img. 05.03. Panorama corresponding to the raw data applied to the
comparison station.
As we can see looking at the Img. 05.03. the representation of colour
corresponding to iSTAR data inside Leica Cyclone looks different to the
processed panorama belonging to the same raw data.
Thus, results obtained following different workflow for the same
station are also compared in 3rd party software. As it is shown at Img
05.04 and Img. 05.05 the representation of colour in this 3rd party
software matches with the corresponding panorama (Img. 05.03).

Img. 05.06. Visualisation of Point clouds with laser scanner internal
camera data using Leica cyclone to colourisation in 3rd part software.
To conclude the comparison, observing the images Img. 05.04.
Img. 05.05 and Img. 05.06 corresponding to the same station and
visualizing in the same 3rd party software it can be noted that the
results obtained from iSTAR data processed in NCTech ColourCloud or
Leica Cyclone 9.1 have little discernible difference, however the using
laser scanner internal camera gives lower visual quality.
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06. Leica TrueView
To view shared data with Microsoft Internet Explorer it is necessary
to install the TrueView plugin for Internet Explorer which can be downloaded from hds.leica-geosystems.com/en/Leica-TruView_63960.htm
To create a TrueView, open the ModelSpace to be shared and position
the model so that all scan positions can be seen, this will be the “Site
Map”. Then, go to File>Publish Site Map, select or create the corresponding folder and the Scan World and a “Site Map Settings” window
will appear.

Img. 06.01. Visualisation of point clouds with laser scanner internal
camera data using Leica cyclone to colourisation in 3rd part software.
Img. 06.03. TrueView Settings window within Leica Cyclone.

Img. 06.04. Color Map Settings window within Leica Cyclone.
Img. 06.02. Site Map Settings window within Leica Cyclone.
From this “Site Map Settings” window you can access to “TrueView
Settings”. Ensure that in “Color Map Settings” your model is set to
“Color from Scanner”.

Img. 06.05. TrueView for Internet Explorer.
Once the TrueView is created, click SiteMap.htm to open the project.
The same exported data can be used within TrueView Global with no
plugin required. For further information about TrueView Global visit
www.leica-geosystems.co.uk/en/Leica-TruView-Global_106856.htm
and truviewglobal.leica-geosystems.com/welcome
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07. Conclusion
Coloured point clouds can be obtained through using iSTAR for
image capture, then following the scan data colourisation method
as described here. In the case described in this Application Note, the
visualisation of coloured data in Cyclone could be improved compared
to 3rd party software.
Despite this, working with NCTech solutions combined with the
Leica P40 Laser Scanner for point cloud colourisation is considered
advantageous to alternative techniques for a number of reasons:
Only one iSTAR shot is needed to colour the entire scene at each view
instead of multiple shots and images per position. This means less
time on site and also eliminates patchy colourisation experienced
where individual images are optimised for their omnidirectional view,
then combined.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and work out the most suitable camera
settings for the full 360 view.

Reduced office time for data processing. iSTAR data from each station
is converted into 6 different images for Cyclone import whereas
the internal laser scanner camera provides 259 images per station
resulting in a longer import time and colourisation process.
Quality of coloured point clouds is improved. iSTAR data produce
improved visual quality compared to the laser scanner internal
camera. Further improvements are gained through additional features
such as “interpolate and fill occluded areas”, automatically applied
when colourisation is processed in Leica Cyclone 9.1 and other options
in NCTech ColourCloud.
Fully integrated workflow. NCTech ColourCloud technology is
integrated within Cyclone from version 9.1 onwards and therefore,
the user benefits from a workflow within his ususal point cloud
software with no need to learn new software or change his workflow.
In addition, benefits from using iSTAR data extends to Leica True
View where data can be used within the same way as internal laser
scanner images.

Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, with minimal
training required.
Automatic overlay of iSTAR images to point clouds, avoiding having to
manually define common points, eliminating user error and enabling
batch processing for efficient operation.
High performance output in difficult lighting conditions. iSTAR
can provide high visual quality images in a wide range of lighting
environments as a result of the automatic HDR settings and EV range
of 27 f-stops.
Reduced fieldwork data capture time. iSTAR can provide high visual
quality images (HDR ON: 5 exposures, HDR PRO: 9 exposures)
in less time than LaserScanner internal camera (HDR images
with 3 exposures). Taking a HDR image with iSTAR takes from
1.50’corresponding to light conditions (4s Analysing + 7s Capturing
+ 1.39’ Saving = 1.50’ Total to 4.50’ corresponding to dark conditions
(1.40’ Analysing + 1.20’ Capturing + 1.90’ Saving = 4.50’ Total)
depending on lighting conditions but it usually takes around 2.00’ on
average in normal light conditions. Nevertheless, taking photos with
internal laser scanner camera increases the capturing time with laser
scanner in 10 minutes on average.

08. Aknowledgements
NCTech greatly thanks Leica Geosystems
www.leica-geosystems.co.uk , especially Gary Kelly and Mark
Benjamin for their collaboration and technical support in this
Application Note.
For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Application note – AMRC Factory 2050, Sheffield]

Surphaser 25HSX scan colourisation with iSTAR HDR images
Date: 25 February 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Surphaser,A3L AMRC with Boeing, University of Sheffield
Products used: SurphExpress Standard v.3.0.16 and PolyWorks 2015 IR6

NCTech iSTAR 360 camera to provide rapid HDR imaging
for Surphaser 25HSX point cloud colouriation

The iSTAR 360 degree camera provides rapid,
automatic HDR (High Dynamic Range) 360
imaging and can be used as a standalone device
or for colourisation of point clouds created by
spherical terrestrial scanners. Surphaser 25HSX
scanner cannot provide internal colour capture,
iSTAR can be used to provide HDR imagery to
improve the point cloud quality. A project was

undertaken to scan and image a Jetstream
fuselage and Rolls-Royce Spey engine at AMRC
Factory 2050, using both technologies, to show
their combined capabilities. The results of the
project showed that iSTAR provides the ability
to efficiently capture HDR colour and accurately
combine this with the scan data for significantly
improved 3D visualisation.
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The aim if this report is to show the workflow used to achieve
high quality coloured point clouds using NCTech iSTAR imaging for
Surphaser 25HSX, and its advantages. Capturing and processing data
was carried out by the AMRC and A3L teams. This report is a result
of their collaboration and also sharing content and knowledge with
NCTech Ltd.
01. Software installation
02. Fieldworks
03. Office-work
04. Results.
05. Conclusion
06. Acknowledgements

01. Software installation

02.03. CAPTURE iSTAR IMAGES by replacing the 25HSX with the iSTAR¹
camera each scan station, and capture 360 images in full colour.
NCTech supply adaptor rods with a Tribrach quick release repeatable
connector to quickly and accurately locate iSTAR at the same central
capture position as the scanner. iSTAR has different HDR modes
enabling single exposure, five exposure and nine exposure 360
images to be created. Five exposure HDR imaging was used here and
additional capture time was approximately 75s per scan position.
iSTAR’s on camera interface is designed to be like a regular automatic
digital camera. Knowledge of photographic techniques is not required
with iSTAR automatically calculating the most suitable exposure value
taking into account the entire 360 scene. Station capturing times were
5 minutes corresponding to scan capture plus 75s for iSTAR capturing.
However, time per station could be considered around 10-15 minutes
adding positions setting and moving equipment.

Installing SurphExpress Standard v.3.0.16:
http://www.surphaser.com/oem-products.html
Installing PolyWorks 2015 IR6:
http://www.innovmetric.com/en/account/login?destination=node/452

02. Fieldworks
Working with the NCTech iSTAR 360 camera is the easiest, most
accurate and time efficient method of colouring point clouds.
02.01. PLANNING SCAN STATIONS no change to standard process for
scanning with or without colour. In this study case, square black and
white cross planar targets printed as A4 size.
02.02. CAPTURING POINT CLOUDS with the Surphaser 25HSX, choose
the Laser Scanner resolution you consider most suitable for the job
as in normal use. In this study case scan settings were 40 lines per
degree (LPD) horizontally and 40 points per degree (PPD) vertically.
NCTech solutions work properly irrespective of scan resolution. The
higher the resolution and accuracy of point cloud the better the
quality visualisation will be achieved.

Img. 02.04. Adaptor rod and Tribrach setting to achieve the right
position for use with Surphaser 25HSX laser scanner.

“The iSTAR took approximately 15s for the actual capture
time and then around 60s to write the file. Under time
constrained projects we use this 60s to start moving
equipment to the next location”
[Thomas Hodgson, AMRC Metrology Engineer]

03. Office works
The whole workflow was carried using SurphExpress Standard and
PolyWorks with total integration.
03.01. PRE-ALIGN AND COLOURISATION INTO SURPHEXPRESS STANDARD.
SurphExpress Standard v.3.0.16 was used to pre-align point clouds
based on the square black and white crossed planar targets.

Img. 02.01 and Img. 02.02. Surphaser LaserScanner and iSTAR station.

Img. 03.01. Planar view of one scan location in SurphExpress Standard
v.3.0.16 interface.
Img. 02.03. Square black and white crosses planar targets used with
Surphaser 25HSX laser scanner.

1 - NCTech recommend using its adaptor poles to accurately locate the camera to the correct
position, different adaptors are used for other laser scanning systems (Leica, Faro, Topcon,
Trimble etc.).
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NCTech’s ColourCloud point cloud colourisation algorithms are
integrated into SurphExpress software so the colourisation process
is both fully automatic and highly accurate. This integrated approach
also eliminates any need for pre-processing of 360 images, as
the raw files from iSTAR are used directly for colourisation within
SurphExpress Standard software.
Point clouds are exported individually as *.PTX. Thus, colourisation is
performed during the exportation.

“It is a simple case of selecting the relevant *.nctri
file and the colour is added during the export. From a
user’s point of view, it’s incredibly easy”
[Thomas Hodgson, AMRC Metrology Engineer]

Img. 03.04.and Img.03.05. Point cloud coloured, merged and
subsampled at 2.5mm. General view.
Img. 03.02. Export dialog in SurphExpress Standard v.3.0.16.
03.02. REGISTRATION INTO POLYWORKS.
Point clouds were imported as *.PTX where the final cloud to cloud
registration was performed.

Img. 03.03. General view where all scan stations are showed after final
cloud to cloud registration in PolyWorks 2015 IR6.
Finally, the merged point cloud was subsampled to a uniform 2.5 mm
resolution in PolyWorks.

04. Results
Coloured point clouds are obtained following the described workflow.
Ten Surphaser 25HSX and iSTAR stations were captured to obtain a
merged coloured point cloud of the AMRC Factory 2050.
Scanning settings used in this project provided point clouds with
resolution per scan station around 2 mm at 5 m, 4.5 mm at 10 m, 9
mm at 20 m and 13 mm at 30 m with very low noise levels. Results
show the outstanding quality point clouds that can be obtained by
combining the high absolute point accuracy and low noise Surphaser
capabilities with HDR iSTAR images for colourisation. The resulting
point clouds are high geometric definition and resolution with sharp,
clean colourisation.

“Other spherical scanners on the market are not exactly
direct competitors to the Surphaser, instead these are
primarily aimed at the survey and BIM markets. The result
of this is that the data quality captured by the Surphaser
far exceeds any other large volume scanner on the market
both in terms of absolute point accuracy and noise. For
example, in a BIM environment, a 2mm measurement
uncertainty at 10 m may be acceptable whereas it is
probably not for most aerospace applications.”
[Thomas Hodgson, AMRC Metrology Engineer]

Img. 04.01. Surphaser 25HSX scan station point cloud coloured with
iSTAR data. General AMRC full resolution view.
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Img. 04.02. Surphaser 25HSX scan station point cloud coloured with
iSTAR data. Rolls-Royce Spey Engine at AMRC Factory 2050 (full
resolution view).

Img. 04.03. Surphaser 25HSX scan station point cloud coloured with
iSTAR data. Jetstream fuselage at AMRC Factory 2050 (full resolution
view).

Img. 04.04. Surphaser 25HSX scan station point cloud coloured with
iSTAR data. General Jetstream fuselage full resolution view.

Img. 04.05. Surphaser 25HSX scan station point cloud coloured with
iSTAR data. General AMRC full resolution view. Notice the clean and
sharp colour matching from the high accuracy iSTAR capture and
ColourCloud processing, even with very slim elements.
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Img. 04.06. Surphaser 25HSX scan station point cloud coloured with
iSTAR data. General AMRC full resolution view. Notice the bright colour
representation and high resolution HDR iSTAR performance, even when
set against a full height glazed wall on a bright day.

“The biggest advantage of the iSTAR is its speed of
capture, the HDR imaging works very well and I have
been impressed by the results in low light conditions”
[Thomas Hodgson, AMRC Metrology Engineer]

05. Conclusions
Coloured point clouds can be obtained by using iSTAR for image
capture within those laser scanner with no internal cameras and
therefore no colour capabilities, then following scan colourisation
method as described.
Working with NCTech solutions combined with the Surphaser 25HSX
for cloud colourisation is advantageous:
Only one iSTAR shot is needed to colour the entire scene at each view
instead of multiple shots and images per position. This means less
time on site and also eliminates patchy colourisation experienced
where individual images are optimised for their omnidirectional view,
then combined.

High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV range of 27
f-stops.
Time consuming fieldwork is reduced. iSTAR can provide high visual
quality images (HDR ON: 5 exposures, HDR PRO: 9 exposures) in
significantly less time than typical laser scanner internal cameras
(HDR images with 3 exposures). Taking an image in HDR with iSTAR
typically takes from 5s – 20s for the capture phase. Total time,
including writing data (during which time camera can be moved)
ranges from 1.50’ to 4.50’ depending on lightning conditions, but 2.00’
on average in normal light conditions.
Time consumed for office work is reduced. Raw data from iSTAR is
used directly for colourisation proposes so the need to pre-process
data with 3rd party software is eliminated. After capture data is ready
for the automated colourisation step with no time lost.
Quality of coloured point clouds is improved. iSTAR data produces
better results compared to typical laser scanner internal cameras it
is the ideal accesory for those laser scanners which don’t have an
internal camera, such as the Surphaser 25HSX used in this study
case. Furthermore, the general quality of point cloud in terms of
definition is improved since the “interpolate and fill occluded areas”
option within NCTech ColourCloud is automatically applied when
colourisation is processed in SurphExpress Standard.

Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and work out the most suitable camera
settings for the full 360 view.

06. Acknowledgements

Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, minimal training
is required.

NCTech Ltd is greatly appreciative of A3L http://a3l.uk.com and the
AMRC with Boeing, University of Sheffield http://www.amrc.co.uk,
especially Richard James, Tom Hodgson from AMRC and Jim Heley for
making possible this application note by collaboration, data sharing
and technical support in this study case.

Automatic overlay of iSTAR images to point clouds, avoiding the
need to manually define common points, eliminating user error and
enabling batch processing for efficient operation.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Application note - Sta. María de Azogue’s Church in Betanzos, A Coruña]

FARO Focus 3D X130 scan colourisation with iSTAR HDR images
Date: 06 July 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, FARO, GLOBAL Geosystems S.L.
Products used: FARO SCENE 6.0 with NCTech ColourCloud App v.1.0

NCTech iSTAR 360 camera to provide rapid HDR imaging
for FARO Focus 3D point cloud colourisation

The FARO Focus 3D X130 scanner does offer
colour capture but is limited to single exposure,
not HDR. It therefore does not always provide
adequate results in challenging lighting
conditions. NCTech iSTAR cameras can be
used to provide HDR imagery for improved
performance and reduced time on-site. NCTech
ColourCloud technology is integrated within

Faro SCENE from version 6.0 and the NCTech
ColourCloud app can be downloaded free of
charge from FARO 3D App Centre. Using the
ColourCloud app integrated into FARO SCENE
further streamlines user workflow by enabling
automatic point cloud colourisation and import
of iSTAR images without needing to leave the
SCENE workflow environment.
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The aim if this report is to show the workflow used to achieve quality
coloured point cloud using NCTech iSTAR imaging and FARO SCENE 6.0
and its advantages.
01. Software installation
02. Fieldwork
03. Office-work
04. Results
05. Colourisation using iSTAR data against laser scanner internal camera
06. iSTAR data within FARO WebShare
07. Conclusion
08. Acknowledgements

01. Software installation
Installing FARO SCENE
http://www.faro.com/products/faro-software/scene/free-trial
Installing NCTech ColourCloud app:
http://www.faro.com/faro-3d-app-center/scene-plug-in-apps

02. Fieldwork
Working with NCTech solutions is the easiest, most accurate and
highest speed method of colouring point clouds with iSTAR images:
02.01. PLANNING SCAN STATIONS no change to standard process for
scanning with or without colour.

02.04. CAPTURE iSTAR IMAGES by replacing the FARO Focus 3D X130
with the iSTAR¹ camera each scan station, and capture 360 images in
full colour. NCTech supply an adaptor rod for use with the FARO QRS
(Quick Release System) to accurately locate iSTAR at the same central
capture position as the scanner.
Depending on the system used to connect tripod and laser scanner,
NCTech recommend a 40 mm pole to use in combination with scanner
aluminium adaptor and Tribrach connection or a 60 mm adaptor for
FARO quick release system. The 40 mm adaptor rod option was used
in this case although the 60 mm Faro quick release mount is more
advisable for on-site time saving.
iSTAR has different HDR modes enabling single exposure, five
exposure and nine exposure 360 images to be created. Five exposure
HDR imaging (HDR ON) was used here and capture time was typically
10-20s² per scan position in normal lighting, in some very dark areas
this was extended to 75s. iSTAR’s on camera interface is designed to
be very simple to us like a regular automatic digital camera.
Knowledge of photographic techniques is not required with iSTAR,
which automatically calculates the most suitable exposure value
taking into account the entire 360 scene. FARO Focus 3D X130 capture
time including image capture was 12 minutes (medium resolution and
quality scan settings) per scan station.

02.02. SYNCHRONISE LASER SCANNER AND iSTAR TIMES. In order to be
able to use batch processing with automatic scan to image matching,
both time devices must be synchronised due to matching being based
on capture time. Go to the “clock icon” under main settings screen to
set time and date on NCTech iSTAR camera.

Img. 02.02. Adaptor rod (60 mm) quick release mount to achieve the
right position for use with FARO Focus 3D X130.

Img. 02.01. NCTech iSTAR interface where date and time can be set.
02.03. CAPTURING POINT CLOUDS with the FARO Focus 3D, select the
laser scanner resolution you consider most suitable for the job as in
normal use. NCTech solutions work irrespective of scan resolution.
FARO Focus 3D X130 capture time was 12 minutes (medium resolution
and quality scan settings) per scan station and 17 scan stations were
performed.

1 - NCTech recommend using its adaptor poles to accurately locate the camera in the correct
position, different adaptors are used for other laser scanning systems (Leica, Faro, Topcon,
Surphaser, Trimble, Z+F…).

2 - The full iSTAR capture process includes “Analysing time”, “Capturing time” and “Saving time”.
During saving time the “OK to move iSTAR” message will appear on the iSTAR screen, at which
point iSTAR can be moved to the next capture position.. For this reason in this example quoted
capture time doesn’t include “Saving time”.
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03. Office-work
The entire colourisation workflow is fully integrated inside FARO
SCENE 6.0 onwards.
03.01. OPEN SCAN DATA IN FARO SCENE.
To import scan data into FARO SCENE it is first necessary to create
a new project File>New>Project and then you can import the scan
points File>Import. If “Error Code 18” is seen when importing a scan
then first copy your files to hard-disk before you drag and drop into
FARO SCENE.

Img. 03.03. FARO SCENE loaded scan.
03.03. REGISTER SCANS.
To register scans click right mouse button on “Scans” folder and go to
Operations>Registration>Place Scans. Cloud-to-cloud registration will
be automatically launched.

Img. 03.01. Laser scanner raw files when imported into FARO SCENE.
03.02. LOADING SCANS.
To view and to process, the scan has to be ‘Loaded’. Right click on the
corresponding scan>Loaded. When the scan is loaded a green square
icon appears.

Img. 03.04. Cloud-to-cloud registration within FARO SCENE.
When registration process is finished, a “Scan Fit” is created for each
scan station. Scan manager window will pop-up or can be opened
by clicking Scans>Scan Manager>Properties. In the Scan Manager
Window, scan results can be checked.

Img. 03.02. FARO SCENE scan loading process.

Img. 03.05. Registration scan results within FARO SCENE.
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Scans>View>Correspondence View shows the scan results in a visual
interactive view, instead of only seeing the results in a chart results.

Right click on any scan to colourise it, as in other colourisation
processes available at SCENE. An option “NCTech Colourise” is added
after NCTech ColourCloud installation. A pop up window to select the
corresponding *.nctri iSTAR raw data file will appear after clicking on
“NCTech Colourise” option.
Import data and colourisation process will be done fully automatically
at once. “Abort” option is also available during processing.

Img. 03.06. Registration scan results within FARO SCENE
Correspondence View.
After finishing a cluster registration or the general registration the
Scan Manager can be locked (Scan manager right click> Lock All) so
that the relative position of scans each other will not be changed any
more.
To check the register options go to Tools>Options…, an emergent
window will open, go to Matching>Place scans settings to select the
corresponding “placement mode” (Target Based, Cloud-to-Cloud or
Top View Based) and other settings related with scan placement.
Two interfaces are available in FARO SCENE 6.0. The aforementioned
instructions were based on the ‘old’ interface since the new
interface is designed to lead the user through the common workflow
operations. The user can easily switch between both interfaces.
Img. 03.09. NCTech Colourise option added after NCTech ColourCloud
App installation.

Img. 03.10. “Abort” option available during “Import and Colourisation”
NCTech dialog.
Img. 03.07. FARO SCENE 6.0 new interface.
03.04. NCTECH COLOURCLOUD APP FOR iSTAR DATA COLOURISATION.
NCTech ColourCloud app for ColourCloud integration within FARO
SCENE, from version 6.0. The app is available free of charge from
FARO 3D App Center (http://www.faro.com/faro-3d-app-center/sceneplug-in-apps). It can be installed directly by running the *.fpp file
(FARO SCENE app file format) or from FARO SCENE App Manager.
Once installed, NCTech ColourCloud App icon will appear in the
SCENE interface. Each user may use the SCENE interface they prefer
since the NCTech ColourCloud app works within both. NCTech Colour
settings can be checked by clicking on the app icon.

Img. 03.08. NCTech ColourCloud App icon in FARO SCENE 6.0 interfaces.

Img. 03.11. FARO SCENE“Planar view” corresponding to the scan
station_000 before and after NCTech point cloud colurisation.
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Batch process can be launched by right clicking the “Scans” folder
and select “NCTech colourise” option. Then, select the folder which
contains all the iSTAR files and press “OK”.

04. Results
Coloured point clouds are obtained following described workflow. 17
Scan and iSTAR stations were used to obtain a merged coloured point
cloud of Sta. María de Azogue’s Church.

Img. 03.12. NCTech batch colourisation launching.

Img. 04.01. FARO SCENE“3D view” of registered colourised scans.

Img. 03.13. NCTech image match failure window.
NCTech batch colourisation process will be performed fully
automatically with no need of user intervention. In the case where
a scan can not be matched with an iSTAR image, the user receives a
warning so he can select whether to continue or manually check the
data before launch of the NCTech batch colourisation process. When
the process is finished a pop up “Finished” window will appear.

Img. 03.14. Colourisation finished window.
To launch single scan NCTech colourisation or batch process within
the new FARO SCENE 6.0 interface, select the scan (for single scan
colourisation) or the “Scans” folder (Batch process) and select
“Colourise Scans”. Then, select the corresponding iSTAR*.nctri raw file
(single scan colourisation) or the iSTAR folder (batch process) in the
same way explained for the previous SCENE interface.

Img. 03.15. Launch NCTech colourisation process within new FARO
SCENE 6.0 interface.

Img. 04.02. FARO SCENE“3D View” corresponding to the scan
station_000 after NCTech point cloud colourisation. Indoor general view.

Img. 04.03. FARO SCENE“3D View” corresponding to the scan station_006
after NCTech point cloud colourisation. Indoor apse general view.
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Img. 04.04. FARO SCENE“3D view”. Coloured point cloud corresponding
to scan station_006. Furniture detail.

Img. 05.01. FARO SCENE“3D view”. Grey point cloud corresponding to
scan station_004 before colourisation. Indoor apse.

Img. 04.05. FARO SCENE“3D view”. Coloured point cloud corresponding
to scan station_019. Saint detail.

05. Colourisation using iSTAR data
compared to using internal laser
scanner camera

Img. 05.02. FARO SCENE“3D view”. Coloured point cloud corresponding
to scan station_004. Internal camera colourisation.

As previously noted, FARO Focus 3D internal camera doesn’t provide
HDR imaging capability. The results obtained using NCTech iSTAR
external camera are compared here to the FARO FOCUS X130 internal
camera.
Generally speaking, when using the FARO FOCUS X130 internal camera
for colour capture, the overall capture operation time increases
by around 2 minutes (120 s) on average in order to obtain single
exposure colour image results.
In comparison, NCTech iSTAR captures five exposure HDR images in
approximately 10-20s for most normal lighting conditions, and up to
75s in this example where light levels were very low. In other words,
iSTAR takes less time to capture and produces better colour quality
results.
Difference in colour quality becomes more apparent in high contrast
and low light environments, where HDR capabilities are needed, as in
the interior of the Romanesque church presented in this Application
Note.
Colour comparison is shown inside FARO SCENE 6.0 and 3rd party
software in order to maintain the colour comparison independent
from software performance (Img. 05.04. and Img.05.05.).

Img. 05.03. FARO SCENE“3D view”. Coloured point cloud corresponding
to scan station_004. NCTech iSTAR colourisation.
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Img. 05.04. Scan section corresponding to the scan station_004 after laser scanner FARO FOCUS X130 internal camera colourisation.
3rd party software.

Img. 05.05. Scan section corresponding to the scan station_004 after iSTAR colourisation by using NCTech ColourCloud App for FARO SCENE 6.0.
3rd party software.
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Note that while capturing colour data by using laser scanner internal
camera it was quite frequent to receive the following message from
FARO Focus X130 due to low light conditions:

Img. 05.06. FARO Focus 3D X130 interface. Warning given when colour
capturing with laser scanner internal camera in low light conditions.
Laser scanner set to Spanish. Translation from Spanish to English:
“1650: Environment light too low”

Img. 06.03. WebShare Cloud Export window. Common for both FARO
SCENE 6.0 interfaces.
After the WebShare data is created it can be transferred (WebShare2Go)
or uploaded to the cloud (WebShare Cloud).

“It is possible the scanner is not able to determine the correct camera
configuration and image quality could be affected. The environment
light could be too low or the exposure measurement mode may not
be appropriate for the currently light conditions…”
Img. 06.04. WebShare Data transfer within original FARO SCENE 6.0
interface.

06. iSTAR data within FARO WebShare
Once NCTech iSTAR colourisation has been applied within FARO SCENE,
the workflow to publish your project to WebShare does not differ from
when using the laser scanner internal images:
Whether using WebShare Cloud or Webshare2Go, the first step is to
create “WebShare Data”.

Img. 06.05. WebShare Data transfer within new FARO SCENE 6.0
interface.

Img. 06.01. WebShare Data creation within original FARO SCENE 6.0
interface.

Img. 06.06. WebShare Data upload within original FARO SCENE 6.0
interface.

Img. 06.02. WebShare Data creation within new FARO SCENE 6.0
interface.

Img. 06.07. WebShare Data upload within new FARO SCENE 6.0
interface.
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Although WebShare Cloud offers more functionality than WebShare2Go,
there is no difference from a visualisation viewpoint so WebShare2Go
was used in this case. Click at *.bat file to open the project.

Img. 06.11. WebShare2Go viewer. Panorama Image Resolution settings.
Img. 06.08. WebShare2Go viewer. Overview map.

For further information about FARO WebShare Cloud visit
www.faro.com/products/faro-software/scene-webshare-cloud/
overview or www.faro.com/faro-3d-app-center/scene-plug-in-apps/
scene-webshare-2-go for WebShare2Go.

07. Conclusion
Img. 06.09. WebShare2Go viewer. Scan station 019.
Note there are four options for panorama resolution display: ‘Low’
(0.52MP), ‘Medium’ (2.1MP), ‘High’ (8.4MP) corresponding to ‘Standard’
size, and ‘Very High’ (34 MP) corresponding to HD in the WebShare
Data creation dialog.
The Panorama image view in WebShare corresponds to the Planar
View within FARO SCENE, and therefore the maximum resolution
exported during WebShare Data creation depends on the scanner
point cloud resolution and WebShare Cloud Export Data settings.
Thus, the resolution of the images exported to WebShare may be less
than those of standard iSTAR images. However, note that the benefits
of iSTAR HDR still remain despite a deduced resolution, and the 360
environment is displayed with correct exposure.

Coloured point clouds can be obtained through using iSTAR for image
capture, then following the NCTech ColourCloud colourisation process,
fully integrated within FARO SCENE 6.0 as described here.
In the case described in this Application Note the importance and
benefit of HDR capabilities in low light and high contrast environments
can be clearly observed. Furthermore, working with NCTech solutions
combined with the FARO Focus 3D X130 Laser Scanner for point cloud
colourisation is advantageous to alternative techniques for a number
of reasons:
Only one iSTAR shot is needed to colour the entire scene at each
view instead of multiple shots and images per position. This means
less time capturing on site and also eliminates patchy colourisation
experienced where individual images are optimised for their
unidirectional view, then combined.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene to calculate the most suitable camera
settings for the full 360 view.
Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, with minimal
training required.
NCTech ColourCloud App free of charge. NCTech ColourCloud
technology is fully integrated within FARO SCENE from version 6.0 and
the corresponding App can be obtained from FARO 3D App Centre free
of charge www.faro.com/faro-3d-app-center/scene-plug-in-apps
Automatic overlay of iSTAR images to point clouds, avoiding
requirement to manually define common points, eliminating user
error and enabling batch processing for efficient operation.

Img. 06.10. WebShare2Go viewer. Scan View settings.

High performance output in difficult lighting conditions. iSTAR
can provide high visual quality images in a wide range of lighting
environments as a result of the automatic HDR settings and EV range
up to 27 f-stops.
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Reduced fieldwork data capture time. iSTAR can provide high visual
quality images (HDR ON: 5 exposures, HDR PRO: 9 exposures), often
in significantly less time compared to the laser scanner internal
camera. The HDR imaging process with iSTAR typically takes 1.50’ to
fully complete (including data save during which time the camera can
be moved), depending on lighting conditions. In good to moderately
low lighting this will break down to: 4s Analysing + 7s Capturing +
1.39’ Saving = 1.50’ total. In HDR Pro mode for maximum 9 exposure
dynamic range in very low light this may be 4.50’ total: 1.40’ Analysing
+ 1.20’ Capturing + 1.90’ Saving. Furthermore, visual quality results are
significantly improved.
Automatic batch process. NCTech ColourCloud offers fully automatic
batch process colourisation process with no need for operator manual
intervention, office work time is therefore reduced and an entire
project can be automatically coloured in just one click.
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For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com

Improved quality of coloured point clouds. iSTAR data produces
improved visual quality compared to the laser scanner internal
camera. Further improvements are gained through additional features
such as “interpolate and fill occluded areas”, automatically applied
in FARO SCENE 6.0 onwards using NCTech ColourCloud App and other
NCTech ColourCloud options.
Fully integrated workflow. NCTech ColourCloud technology is
integrated within FARO SCENE from version 6.0 onwards within
NCTech ColourCloud App (free of charge) and therefore, the user
benefits from a workflow within his ususal point cloud software with
no need to learn new software or change his workflow. In addition,
benefits from using iSTAR data extends to FARO WebShare where data
can be used within the same way as internal laser scanner images.
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[Application note - iSTAR & HDR, multiple locations]

Low Light Conditions
Date: 17 December 2015
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech
Products used: NCTech ImmersiveStudio and iSTAR

NCTech iSTAR advanced HDR capability
challenging lighting conditions

The iSTAR 360 panoramic camera provides
rapid, automatic High Dynamic Range (HDR)
imaging in challenging lighting conditions,
whether in environments with high contrasts
of dark and shadow, or low levels of ambient
light. The NCTech iSTAR camera can be set to
capture a single exposure (HDR OFF), five
(HDR ON) or up to nine exposures (HDR PRO)
automatically with an equivalent range of

up to 27 f-stops. The whole 360 scene is
automatically analysed to establish the most
suitable exposure values (EV) and bracketing
to cover the scene’s dynamic range. In this
example images were taken with and without
using HDR to show several challenging light
environments in which iSTAR HDR capabilities
make a significant difference in image capture
quality.
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There are a wide range of lighting conditions and environments which
are potentially challenging to achieving the level of image quality
satisfactory for working requirements. The capabilities of the NCTech
iSTAR camera and Immersive Studio software make achieving good
results in such conditions significantly easier.
01. Software installation
02. Low Light Conditions.
03. High Dynamic Range (HDR)
04. NCTech iSTAR HDR images
05. NCTech iSTAR & ImmersiveStudio (NCTech HDR Workflow)
06. Applications
07. Conclusion

Img. 02.03. Greyfriars graveyard, Edinburgh City. iSTAR HDR image
sunset lighting.

01. Software installation
Installing NCTech ImmersiveStudio:
https://www.nctechimaging.com/immersive-studio

02. Low Light Conditions
Low light conditions cover a wide range of possibilities but here we
classify into “Daylight”, “Low Light” and “Dark”.
Daylight: Shadows are unavoidable in most imaging scenarios:
behind buildings, between narrow streets, under bridges, tunnels
or enclosures etc. It is therefore critical that any imaging system has
the ability to cope with shadowing challenges and still provide good
results.

Img. 02.01. Queensferry Road Bridge, Edinburgh City. iSTAR HDR image
under bridge.

Img. 02.04. St John’s Church, Edinburgh City. iSTAR HDR image indoors,
bright highlights with reflections and large stained-glass windows.
Dark: At night, inside caves, underground tunnels, inside pipes
or confined spaces where auxiliary light equipment is needed for
visibility.

Img. 02.05. Maria Pita Square, A Coruña city. iSTAR HDR image outdoors
night conditions with contrast lighting.

Low Light: Indoors with poor ambient light, during sunrise or sunset
where light is sufficient to see but challenging for digital sensors.

Img. 02.02. Vaults links, Glasgow University. iSTAR HDR image indoors,
very challenging conditions.

Img. 02.06. Sta Maria del Campo Church, A Coruña City. iSTAR HDR
image outdoors night conditions with poor lighting.
Visit http://www.istarshare.com/tour/4047 to see 360° HDR iSTAR
immersive views of Blair Street underground vaults with different
illumination and photo settings. This site is well-known to have very
challenging low light conditions, with zero natural light auxiliary
equipment is needed to see, as can be observed in the images. 360°
HDR iSTAR immersive views full of colour lights from Las Vegas night
landscape can be seen at http://www.istarshare.com/tour/3962
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03. High Dynamic Range (HDR)

Img. 03.01. Queensferry Road Bridge, Edinburgh City. iSTAR HDR source images under bridge.

Img. 03.02. St John’s Church, Edinburgh City. iSTAR HDR image indoors bright highlights with reflections and large decorated windows.

Img. 03.03. Calton Hill, Edinburgh City. iSTAR HDR source images sunny lighting conditions.

Img. 03.04. Maria Pita Square, A Coruña city. iSTAR HDR source images outdoors night conditions with contrast lighting.
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Img. 03.05. iSTAR HDR panorama source images. Notice the difference with the previous Img. 03.01., Img. 03.02., Img.03.03., and Img.03.04.
03.01. WHAT IS HDR AND WHAT IS USED FOR?
High Dynamic Range imaging (HDR or HDRI) can be achieved by
using multiple images, each with different exposure values, to
capture a greater dynamic range of light than using one standard
single exposure image, or by using HDR camera sensors which
have an extended dynamic range. A HDR photo has much more
information about luminosity than a Low Dynamic Range (LDR)
image. Because the human eye has a greater dynamic range than
typical digital sensors, the requirement for using HDR techniques is
to make images look more natural and closer what we are used to
experiencing.
The number of images needed to achieve good results depends on
the exposure value (EV) needed to cover the actual dynamic range
(difference between the lightest light and the darkest dark) and the
spacing between shots of the sequence used. This will naturally vary
from scene to scene, but in general, should cover as much luminosity
as possible. Most common steps in HDR photography are 1.0, 1.5 or
2.0 EV.
Img. 03.01., Img. 03.02, Img. 03.03. and Img. 03.04. show how images
with different exposures are used to cover the whole dynamic range
of the scene. Notice that each single exposure image covers a portion
of the scene dynamic range. Thus, Img.03.01. shows the exposure
steps used for NCTech iSTAR to obtain an image full of details at
the bridge and its entrance, the panorama (Img.02.01.) shows the
continuity of bridge vault texture details. In a similar way, it is used
at Img. 03.02. to reproduce in the same image indoors building and
window details, which is a very common challenge in architectural
photography (Img.02.04. corresponds to the full panorama).

images, in fact, we talk about a LDR obtained from HDR resulting
image, which is only really an approximation of the true HDR image.
Alternatively, HDR results within a low dynamic range image can be
directly obtained from source images by using Exposure Fusion. It is
this method that is used by Immersive Studio.
03.02. EXPOSURE FUSION VS TONE MAPPING:
The common technique to obtain an HDR image is via tone mapping.
However, tone mapped images often looks unreal or shows a
“different” interpretation of reality. Thus, when the purpose is to
show an image of a wide dynamic range scene with high contracts
light levels preserving details in shadows and bright areas but in
a realistic way, nearly as human eye can see the scene, exposure
fusion is the best option.
Using the exposure fusion method, an HDR image is gained pixel by
pixel from the source exposures. Each output image pixel is selected
from the source images based on the most appropriate values
established by software algorithms. Thus, the exposure method
process assigns weights to the source images pixels corresponding
to luminosity, saturation and contrast and smartly balances them to
build a single image. Compared to tone mapping, exposure fusion
doesn’t require a tone mapping stage since the resulting image is a
low dynamic range image. Therefore, the resulting image looks more
realistic than the ones gained from tone mapping. The shadows
remain with some amount of shadow and the bright areas also
remain brighter, considering the general scene, keeping the tonalities
truer to the scene being captured. Furthermore, exposure fusion
provides results with less noise, against tone mapping with amplifies
the noise, with a more natural looking appearance.

Looking at Img. 03.03. you can observe how well iSTAR HDR
images reproduce all the details a human eye can see (Img. 02.03.
corresponds to the full panorama) through capturing the texture
richness of the whole scene (shadows details, texture of stone
facades, sun position and reflections between tree branches...).
The last example corresponds to a night scene with illuminated
old buildings, in which exposure steps (Img.03.05.) allow the
reproduction of the rich facade, the colour of the building roof, the
cobble stones of the square (Img. 02.05. is the full panorama) and the
lights of that Old Town urban scene.
The HDR results of all aforementioned scenes are shown in Img.03.05.
in which the increase of the dynamic range covered and therefore,
the increase of detail level is quite obvious.
After blending the source images into one HDR image, electronic
displays struggle to show these to full effect. Thus, in order to be able
to display them, HDR images must be processed using a technique
called tone mapping.
This process converts “the real” High Dynamic Range (HDR) image
into a Low Dynamic Range (LDR) or Standard Dynamic Range
(SDR) image such that can be displayed on standard screens and
projectors. It should therefore be noted that when we talk about HDR

Img. 03.05. HDR results comparison tone mapping vs exposure fusion.
Note the noise differences even when tone mapping noise reduction
settings were selected.
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The same source images were used to obtain the above HDR images.
On the right obtained by exposure fusion method within Immersive
Studio (fully automatic) whereas the one corresponding to tone
mapping within Photomatix (default settings + noise reduction) is
on the left. Different tone mapping settings produce different colour
results so colour differences are not going to be commented although
they can be noticed. However, noise differences can be observed with
independence of tone mapping setting selected.
03.03. COMMON PROBLEMS USING HDR:
Noise. Noise in HDR images can be produced during tone mapping,
after blending source images with different exposures, in which the
amplification of underexposed pixels leads to noise in dark areas
of the scene. Furthermore, any noise in the source images will be
amplified further in the resulting HDR image. It is therefore good
practice to avoid noise in single exposure images where possible.
Noise always results in loss of detail and texture so is problematic in
these applications.
Misalignment. Misalignment between the source images occurs
because of movement between shots of the bracketed sequence. The
movement could be produced by the user, but also may be due to
external issues which are more difficult to control, for instance, the
wind. The user should also take appropriate measures to eliminate
chances of camera movement during capture, such as a robust tripod.
Ghosting. This is also a form of misalignment but, in this case, the
misalignment is localised to a specific part of the image and caused
by the movement of objects within the scene (trees moving in the
wind, people walking, cars in motion). Unfortunately, in general and
especially while outdoors, it is often not possible to control these
factors to completely avoid ghosting during capture.
Halo artefacts. Halo artefacts, along with ghosting are the two most
common issues related to HDR imaging. These normally appear on
the boundaries between two regions or areas of the image with very
different brightness or high contrast.

not introduced into the resulting image. Furthermore, iSTAR helps
to prevent some potential causes of misalignment due to camera
movement by its requirement for a countdown or remote triggering
of the capture process. The camera should therefore not experience
user caused ‘shake’ when positioned on a suitable stable tripod.
Compared with NCTech iSTAR, cameras without HDR capabilities and
limited exposure range produce images with significantly lower levels
of detail in areas of highlight and shadow. Without HDR, an image that
is correctly exposed for a reduced area of the scene can be obtained
but, correct exposure across the whole image cannot be obtained.
Furthermore, iSTAR creates HDR images fully automatically with its
analysis of the entire 360° scene to set the best EV capture range.
Thus, with single exposure camera we would obtain images like the
ones with 0 exposure value, or -/+ in some cases, corresponding to
Img. 03.01., Img. 03.02, Img. 03.03. and Img. 03.04. but never images
as Img.03.05., which NCTech iSTAR can provide fully automatically.

05. NCTech iSTAR & ImmersiveStudio
(HDR Workflow)
Working with NCTech solutions is the easiest available method to
automatically achieve high detail 360° HDR images, thanks to NCTech
iSTAR and Immersive Studio’s user-friendly interface and automatic
processes, fully integrated into the 360° image stitching workflow.
01. NCTech iSTAR Photo Capture. Place NCTech iSTAR in any challenging
low light environment and set HDR iSTAR mode (HDR ON for 5
exposure levels and HDR PRO for up to 9 exposures levels) to take
your images. For further information about how to use iSTAR, please
visit www.nctechimaging.com/istar).

Noise and misalignment are issues that can be prevented during
capturing but in order to correct or eliminate ghost or halo artefacts,
image post-processing is needed, which is not covered in this
Application Note.

04. iSTAR HDR images
NCTech iSTAR can provide HDR images by using two different capture
modes. HDR ON (HDR output based on 5 images) and HDR PRO (HDR
output based on up to 9 images).
As previously stated, the number of images needed depends on
the exposure value (EV) required to cover the dynamic range of the
scene, and spacing between shots of the sequence, which should
cover as much luminosity as possible. iSTAR analyses the whole
dynamic range of the scene and establishes the most suitable
exposure values and steps in each case (Notice that Img. 03.01.,
Img. 03.02, Img. 03.03. and Img. 03.04. shows exposure time values
corresponding to each image source). The end results are full detail
360° images wherewith all areas within the image, whether bright
areas or dark shadows, appear correctly exposed.
HDR PRO provides additional capture capability in very high contrast
scenes. Some examples are, extreme sunsets and sunrises, forest
with strong shadows and highlights, interior of buildings with large
glazed areas.
Where there is no visual difference or improvement resulting from
using HDR PRO compared to HDR ON, then it can be concluded that
HDR ON (with five exposure capture) is sufficient to cover the whole
dynamic range of the scene, rather than the automatic HDR PRO with
its up to nine exposures.
In general, the iSTAR camera helps the inexperienced user to avoid
some common HDR problems (See 03.01. COMMON PROBLEMS
USING HDR). The iSTAR HDR image creation process only uses
correctly exposed pixels, so noise seen in underexposed pixels is

Img. 05.01. Queensferry Road Bridge, Edinburgh City. iSTAR placement.
Note the quality difference between this image taken with a single
exposure camera and Img.02.01. and Img.03.05. corresponding to iSTAR
HDR images.
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In general, HDR ON should be more than enough for most scenes
since it uses 5 exposure levels but, for those situations in which the
dynamic range of the scene is more extreme, then HDR PRO should
be used (See 04. iSTAR HDR images).
02. NCTech Immersive Studio. To process iSTAR raw data in Immersive
Studio just drag and drop the corresponding folders from each image
on to the Immersive Studio window or, select the corresponding
directory. Both options lead to the same result.
By default, the output directory is the same as input directory but this
can be easily changed by clicking on the dotted button.
For further information about Immersive Studio, please visit our website
at www.nctechimaging.com/immersive-studio and choose the option
“Process HDR” (on by default). HDR and stitching are processed at the
same time within the user-friendly NCTech Immersive Studio interface.

06. Applications
Following are some typically challenging areas in general
photography where HDR can provide benefit:
High-contrast situations, very dark scene with bright artificial light
and natural darkness or backlit scenes.
Sunrise or sunset in which details of dark shadow areas are as
important as details on the sky, or simply, the aim of the work is to
reproduce the scene as is perceived by human eye. Furthermore, it
must be considered that available light will change quickly so nonsynchronised 360 systems may perform poorly.
Flash use is not possible. Flash is a standard solution to take photos
in low light conditions but sometimes is prohibited (for instance, in
order to not damage art works, inside art galleries, documenting
paintings on Heritage like frescoes or stone polychrome...etc.), or
where its effect is not beneficial since it can compress the depth of
the images.
Capture of detail. A possible solution to take photos in low light
conditions could be by increasing sensitivity light or camera sensor
by choosing a higher ISO value. However, this will increase the noise
of the photo, decreasing the definition of detail. Furthermore, setting
a higher ISO value can help in low light conditions but won’t deal with
wider dynamic range scenes, even more, setting a higher ISO value
will reduce the dynamic range of the scene in single exposure images.
Indoors with limited ambient light or with windows. Single exposure
captures in these scenarios will typically produce dark / dull images,
or images with strong glare surrounding lighting or window areas.
iSTAR HDR provides very good results in these situations.
Taking pictures from positions of shade. Capturing a scene from
within an area of dark shade is does not provide suitable lighting
conditions and image noise will likely increase. Increasing the capture
speed could be a solution but the light might not be sufficient to
achieve good results.
Dark conditions. At night or very low light conditions in which
you don’t have enough light and using flash is not an option, long
exposures can be used to maximise available light, or simple
continuous illumination can be used.
All aforementioned points relate to general photography, but
iSTAR’s capabilities in these areas also improve its use in other nonphotography application areas:

•
•

•
•

360° immersive environments full of details that can be
observed by human eye in reality, but that cannot be captured
in a single exposure panorama.
Point cloud building based on image-matching methods, such
as Structure from Motion (SfM) perform better. The possibility
of getting holes in reconstructed models produced by pixels
with no useful information (extreme black or white areas
produced by light effects) is reduced.
Colourisation of laser scanner point clouds is improved with
better and more complete colour detail. Capture time is also
reduced due to automated synchronised 360° imaging.
High quality textures for mesh mapping, since iSTAR analyses
the whole 360° scenes and establishes the most suitable
exposure value and steps.

Img. 05.02. NCTech ImmersiveStudio interface. “Process HDR” option
can be seen at the bottom.
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07. Conclusion
HDR images full of rich detail are rapidly and automatically obtained
by using NCTech iSTAR camera in challenging low light conditions:
Only one iSTAR shoot is needed to get an HDR 360 image with five or
up to nine exposure levels.

In conclusion, iSTAR provides quality HDR imaging which is highly
suitable for photogrammetry purposes, mesh mapping, realistic
immersive views and laser scanner point cloud colourisation. It
provides particularly strong benefits in low light or high contrast
environments, indoors and where there is complex architecture.

Deep knowledge in photography is not needed since iSTAR analyses
the whole scene to calculate out the most suitable EV capture range,
taking into account the whole landscape condition.
Extra training is not required. Anyone can use iSTAR and NCTech
software with minimal training & experience thanks user friendly
software and device interfaces.
Automatically HDR stitched images are provided. Instead of requiring
separate 3rd party software the user extracts HDR images directly
from NCTech Immersive Studio (NCTech stitching solution) with no
additional steps in his standard workflow.
Robust performance even in changeable lighting conditions.
iSTAR can provide rich colour images in wide range of lightning
environments thanks to HDR settings and EV range of 27 f-stops.
Misalignment prevention. iSTAR helps users to prevent misalignments
produced by camera shake from the user through countdown timer
or remote triggering.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Application note - World wide locations]

NCTech 360 & Virtual Tour
Date: 04 March 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech
Products used: iSTAR, iris360, Immersive Studio, Google Street View App, PanoTour Pro, Pano2VR plus
other web-sharing providers for 360° content.

NCTech to provide rapid HDR imaging for
virtual tour deliverables

The NCTech 360 degree cameras provide rapid,
automatic High Dynamic Range (HDR) 360 imaging
and can be used as automated devices or for
‘virtual tour’ or other virtual site-documentation
applications. NCTech products provide advanced
capabilities to make the work easier, faster and
more enjoyable for their users.
NCTech is a pioneer in 360° imaging and its iris360
has the prestigious position of being the first
automatic 360° camera approved by Google for
use by their Street View | Trusted photographers.
iris360 can also be used by anyone to instantly

publish panoramic images to the Street View
platform through its direct integration with
Google’s Street View app.
Both iris360 and iSTAR can also be used for
other non-Google imaging applications, most
commonly for virtual tours, site documentation
or asset management.
Both NCTech imaging devices rapidly and
automatically provide standard format image
output, fully compatible with all standard 3rd
party software for virtual tour creation and
customisation.
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The aim of this report is to show how NCTech products improve the
task of virtual tour creation by making it simpler and faster so anyone
can achieve good results with no need of advanced photographic
knowledge.
01. Software installation
02. What is a Virtual Tour?
03. Virtual Tour image format
04. NCTech 360 imaging to virtual tour creation
05. Creating a Virtual Tour
06. Results
07. Web-sharing for 360° content.
08. Applications
09. Conclusion
10. Acknowledgements

For further information about how to use Kolor AutoPano Giga or
PTGui for stitching, visit the NCTech Vimeo channel: vimeo.com/nctech
Here you can see an iSTAR image in equirectangular projection view:

Img. 03.01. Equirectangular projection image. NCTech iSTAR image.
Calton Hill (Edinburgh, United Kingdom). Notice the unwrapped sphere
effect, elements that are supposed to be straight appear curved.

01. Software installation
Installing NCTech Immersive Studio:
https://www.nctechimaging.com/downloads/
Installing Google Street View mobile app:
iOS - https://itunes.apple.com/es/app/photo-sphere-camera/
id904418768?mt=8
Android - https://play.google.com/store/apps/details?id=com.google.
android.street
Installing iris360 App:
iOS - https://itunes.apple.com/gb/app/iris360/id1094740699?mt=8
Android -https://play.google.com/store/search?q=iris360&hl=en_GB
Installing Kolor PanoTour:
http://www.kolor.com/panotour/download/
Installing Garden Gnome Pano2VR:
http://ggnome.com/pano2vr

02. What is a Virtual Tour?
A virtual tour or a virtual visit is a series of 360 degrees panoramas¹
which are displayed interactively on a screen device. It can be run
locally or online and may contain other multimedia data such as
videos, still images, text, linked documents, sounds and graphics.
When viewing a virtual tour, the user can interact with the panorama
not only from in the forward facing view, but also by rotating in all
directions as a completely immersive environment.

Img. 03.02. Welcome screen from Immersive Studio in which images
from iSTAR and iris360 can be processed.
To stitch images within Immersive Studio, simply drag and drop
your iSTAR or iris360’s output image folders to the Immersive Studio
window, select the operation you want to perform (e.g. Stitch images)
and click “Process”. By default, Immersive Studio saves the images in
the same folder as the images being processed, but you can choose
the folder you want.

As an example virtual tour containing most of these type of media
files, see the “Inside Abbey Road” virtual tour presented by Google
here: https://insideabbeyroad.withgoogle.com/en

03. Virtual Tour image format
iSTAR and iris360 provide spherical panoramic images (360° x 137.5°
+/- 5°). One of the most common formats to present this kind of image
is the equirectangular spherical projection (which corresponds to an
unwrapped sphere).
The (*.jpg) equirectangular projection is the image format gained
directly from the stitching process, whether using Immersive Studio,
3rd party software and even from the iris360 on-camera stitching
process.

Img. 03.03. Immersive Studio image process interface in which to drag
and drop raw image data for processing.

1 - A Virtual tour can be build with spherical images (complete panorama), Cylindrical images
(vertical panorama field of view) or partial horizontal panoramas. NCTech iSTAR and iris360
provide spherical images.
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Once the images are stitched, you can launch the Immersive Viewer
to view the stitched images in an interactive viewer.

Simply workflow. iSTAR and iris360 with Immersive Studio simplify all
the tasks needed to obtain in one shot HDR spherical panoramas for
virtual tour creation.
Stitching in 3rd party software. iSTAR and iris360 images can be
stitched directly in 3rd party stitching software, such as PTGui or
AutoPano Giga after exporting *.jpeg source fisheye images from
Immersive Studio.
Automatic nadir options. Covering the nadir area takes time on site
and requires post-processing. NCTech offers several automatic nadir
fill options: blank area, add NCTech or your own logo, mirror ball with
or without logo for units prior to upgrade and pinch option for units
post upgrade.

Img. 03.05. NCTech Immersive Viewer. Notice the source image is
the same showed at Img.02.01. Here, Arthur’s Seat from National
Monument of Scotland, Edinburgh (United Kingdom).
Images from iSTAR and iris360 are fully compatible with any virtual
tour creation/editing software that works work with spherical
images (*.jpeg), such as PanoTour Pro from Kolor or Garden Gnome’s
Pano2VR.

04. NCTech 360 imaging to virtual tour
creation
In the previous section it has been detailed how iSTAR and iris360
output *.jpeg images are fully compatible with all virtual tour creation
software that can work with spherical images. NCTech reality imaging
products for virtual tour creation provide many other advantages to
make the workflow simpler, easier and faster than using a standard
camera:
Automatic analysis of the entire light scene. Determining which
exposure setting represents the best balance is not needed. iSTAR
and iris360 analyse the whole scene to work out the optimal
exposure settings which best suit the scene.
HDR processing with no user operation. iSTAR and iris360 provide
high quality exposure fused “HDR” results automatically. HDR images
can be obtained from Immersive Studio, 3rd party software or directly
on board (only available for iris360).
Immersive Studio “Auto Level Image” option can fix any level
deviation. This option can be applied during on board stitching (only
available for iris360) or by activating the corresponding option when
processing the images in Immersive Studio (either iSTAR or iris360).
Special panoramic head is not required. Any standard tripod head
is suitable for using NCTech cameras, although a ball-head is
recommended for easy levelling.
The whole 360° scene is captured in one shot, allowing the capture of
fast moving scenes without missing any of the action.
On board stitching. With iris360 the user can choose between
stitching panoramas on board with no computer requirement, or to
use the Immersive Studio software application (free of charge).
Knowledge of photography is not required since iSTAR and iris360
automatically calculate the most suitable exposure values to take into
account the whole scene.
Manual setting available. iSTAR and iris360 analyse the whole scene
to calculate the best average settings however a “manual mode” is
also available for those who have prior photographic knowledge.
Pre-processing and/or post-processing is not needed. Pre-processing
images before the stitching to correct lens distortions, colour
harmonizing to avoid vignette effects or other image corrections are
not needed. Spherical panoramas are obtained automatically onboard (iris360 only) or from Immersive Studio to use directly within
the virtual tour creation software.

Camera operator exclusion from the scene. iSTAR and iris360 offer 3
different capture modes to avoid capturing the camera operator on
the scene: remote control function from tablet or smart phone, count
down timer and walk-around mode.
Automatic stitch process. Use either the on-board stitching option
(only available for iris360), or Immersive Studio to benefit from
NCTech’s patented camera calibration processes for automatic and
accurate stitching.
Time saving. iSTAR and iris360 capture the whole scene in HDR in
seconds, which means considerable time saved compared to taking
several images with a standard DSLR camera. Furthermore, NCTech
iris360 makes possible publication directly in Google Street View by
using the on board stitching on iris360 and the Google Street View
app, without the need to use a computer. For further information
about iris360 visit https://www.nctechimaging.com/iris360/ and
https://www.nctechimaging.com/istar/ for iSTAR.

05. Creating a virtual tour
Although each software has its own workflow process, most of them
fit the following general steps, namely:
1. Select the panoramas you want to use in the virtual tour or
virtual visit.
2. Establish the initial view setting of each panorama (point of
view, range zoom in/out, default angle).
3. Create hotspots (photos, panoramas, sound, html files,
videos…)
4. Personalization of the virtual tour: buttons, sounds, icons,
floor-plans and or maps.
5. Choose output settings. In general, HTML5 is the most
advisable format to choose since it is compatible with all devices.
AutoPano Giga by Kolor and Pano2VR by Garden Gnome are two of
the most well known software solutions for virtual tour creation with
which iSTAR and iris360 images are 100% compatible.
However, there are other 3rd party software solutions enabling
virtual tour creation from NCTech 360 images among other
capabilities, most of them focused on virtual tour creation plus
broader visual content management for specific markets.
Generally speaking, workflow for virtual tour creation using iSTAR
and iris360 cameras within these applications does not substantially
differ from the standard since they still use spherical images in *.jpeg
format.
In some specific cases a conversion file is needed but this is usually
supplied with the virtual tour software. Further to the standard
software applications available on the market, NCTech has developed
a ‘Measurement Module’, which allows point-to-point measurements
to be made directly from within an immersive view environment.
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For information about NCTech Measurement Module check
nctechimaging.com//downloads-files MeasurementModule.pdf
and
nctechimaging.com/downloads-files/Veesus-iSTAR.pdf
for its integration within Veesus DataStudio or
nctechimaging.com/downloads-files/SphereVisioniSTAR.pdf
for its integration within Arithmetica SphereVision.
Virtual tour creation for Google Street View deserves a special
mention since the iris360 was the first automatic spherical
camera approved by Google for use by their Street View | Trusted
photographers.
Furthermore, it is one of the few spherical cameras integrated to the
Street View mobile app, which enables anyone to instantly publish
360 image content to Street View, for private or public viewing.

Img. 06.01. Train station immersive views during AEC survey
operations.

The NCTech iris360 Open Spherical Camera (OSC) – Google API. (Not
suitable for iSTAR) enables integration of 360 image capture from
iris360 directly in 3rd party software and web platforms, enabling
camera control in a similar way to the Google Street View mobile app.
Output 360 images are then handled directly within that 3rd party
system with no manual data transfer needed. For further information
and/or joint to the NCTech iris360 INTEGRATED network visit:
http://www.nctechimaging.com/iris360-osc

Img. 06.02. Event venue virtual tour captured in 35 minutes.

06. Results
Virtual Tour results can be displayed in different screen devices
from computer, tablets or smartphones through immersive digital
environment domes, 360 screen, CAVE environment to virtual reality
headsets or glasses.
The user experience is like virtually being in the place where the
images have been taken (immersive virtual reality) but depending on
user immersive level provided:
Non-immersive systems: The virtual environment is viewed through a
window on a screen device (computer, tablet or smart phone) and the
user can interact by using conventional elements like the mouse or
keyboard and viewers like the NCTech Immersive Viewer, the Google
Street View web interface or other 3rd party viewers.

Img. 06.03. Murder crime scene virtual re-visit.

Semi-immersive systems: the display environment increases the
feeling of immersion by using large screen monitors as curved 360
monitor, dome projectors or CAVE virtual environments (room- size
cube). Device projection geometries need to be considered for these
systems to avoid distortions and preserve image quality.
Immersive systems: The user feels as though they are in the virtual
environment by using virtual reality headsets or glasses, generally
known as head mounted displays (HMD). The graphics displays a
stereo pair view (slightly different left and right images) so that
the scene is perceived by the human brain as a 3D image. The user
interacts with a 360 field of view by moving his head or body.
Img. 06.04. Travelling visit to Algarve, Portugal (EU)
Some examples from iris360 within Google Street View
google.com/maps/contrib/112214911896929544998/photos/
or iris360 showcase gallery
https://www.nctechimaging.com/showcase/

Img. 06.05. City visit during ILMF2015 in Denver, Colorado (USA)
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07. Web-sharing platforms for 360° content.
The standard output that can be obtained directly from iSTAR and
iris360 are spherical images.
The 360° content can be opened as a standard image displayed
in ‘equirectangular’ format. Alternatively, the same image can be
displayed within an interactive immersive view. Dedicated platforms
for 360° content usually display in immersive view and can
provide additional capabilities for further enhancing the immersive
experience, such as: linking 360° images (virtual tour creation),
sound, text, links, calls, 3D objects, 2D images, branding logo,
geolocation, social sharing etc.
There are many different platform options available with different
prices and capabilities. The following section is an overview of some
of the immersive platforms specifically designed for web-sharing (as
opposed to private or offline hosting).
07.01. 360CITIES. www.360cities.net
360cities is a web collection of geo-referenced panoramas from
all around the world, where all images are reviewed before being
published. Options for 360° video has also been added recently.
It’s focus is on sharing still panoramas (and not for virtual tour
creation) but within a panorama immersive view, the user can jump
to other nearby locations created by the same user or others.

and Android). Offline space viewing is available with the Pro Account.
Private settings (unlisted spaces) are available only for Pro Accounts,
otherwise all other content is publicly available. Even with the free
account, the user has unlimited storage with Amazon S3 services, full
customisation (sounds up to 5MB, maps, welcome screens…) and will
have his own profile. However, upload and size limitations depend
on each account type: Free: up to 10.000 px limited to 15 uploads/
week Pro: up to 65.000 px with unlimited uploads Additional services
can be purchased within any available account (Free or Pro): White
label embedded for branding purposes ($15/space), Extended privacy
settings including password protection ($10/space) or Custom maps
(coming soon).
07.05. HOLOBUILDER. landing.holobuilder.com/construction
HoloBuilder is a Web-based virtual tour creator and sharing. Different
account types: Starter (free), Premium (Pro $7.99, Business $19.99and
Business+ $34.99) Even free account users can upload unlimited
projects with floor plans and many customisation options including
the ability of adding 3D objects to your tour. Projects are public by
default and can be copied by other user unless you have an upgraded
account. Protection from copy and edition is also available for
Premium account onwards.

Free options

Different account types are available: Basic (free), Plus (49€/year), Pro
(179€/year) and Company (360€/year). 360cities can be explored from
the website or by using their App (iOS, Android, Windows 8 Phone)
Even when using a basic free account, uploading is unlimited with no
sizes restrictions and each user has his own portfolio. Additionally,
panoramas can be licensed via 360cities.net in partnership with
GettyImages. Furthermore, spherical images from 360cities can be
included in the default Photos layer in Google Earth as long as they
are suitable http://www.360cities.net/help/google-earth .

Virtual Tour

360cities

Seekbeak

Spinattic

Roundme

Holobuilder

√

√

√

√

√

$

√

√

√

√

√

Geolocation

√

√

√

VR Mode

√

√

√

√

AR Options
Own Profile

√

Embed Code

√

07.02. SEEKBEAK. seekbeak.com

Social Sharing

√

SeekBeak is an online platform to share panoramic images (‘Snaps’).
Interactive / linked 360° content (virtual tour creation) is available
only with the paid account. The content is private by default unless a
custom URL is published. Different account types are available: Free
($0), Basic ($14), Plus ($49), Premium ($199) with discounts if billed
annually. It has multiple customizable hotspots options (call, buy now,
3rd party content, sound…). The number of snaps, storage and traffic
are limited within a monthly basis and depends on account type,
ranging from the free option enabling 3 snaps, 500MB storage (up to
10 MB per image) and 10.000 views limit/month, up to Premium level
with 250 snaps, 50GB storage (up to 50 MB per image) and 1.000.000
views limit/month.

Unlimited
Uploads

√

Unlimited
Sizes

√

Files Review

√

07.03. SPINATTIC. www.spinattic.com
Spinattic (still in Beta version) is a platform for geo-located virtual
tour creation and sharing with interfaces that can be easily
customised by the author. Different account levels are available: Free,
Advanced ($150/year), Pro (coming soon), Company (coming soon).
Even when using a free account, the user can set different private
settings (public, private, not listed) and authors profile. The number
of panoramas and tours that can be upload is unlimited although
the file size and with limited and linked to each account type: Free:
25MB max file size and 30.000 px max width size Advanced: 50MB
max file size and 50.000 px max width size Customisation options
are available by using different plugins packs. Note this platform is
still under development (Beta) and some options are announced as
coming soon.
07.04. ROUNDME. roundme.com
Roundme is a community service dedicated to VR photography for
geolocated virtual tour and panorama (space) sharing. Different
account types are available: Free ($0) and Pro ($8.25/month).
Roundme can be explored from the website or by using the App (iOS

√

√

√
√

Hotspots
Business
Branding

$

√

√

√

Back up

$

√

√

√

√

$

√

Coming soon

Floorplans
Private
Settings

√

Coming soon

√

$

$

$

$

$

The list is growing fast and as such it is not the aim of this document
to provide a comprehensive review of all options.
However, other services should be considered like WalkInto walkinto.
in which allows the user to create and customise a virtual tour by
using images from Google Street View for free (no data hosting); Sky
Easypano http://sky.easypano.com, a social network for free virtual
tour and panorama sharing which works with credits (the user gets
credits in exchange for shared material); viewAt www.viewat.org
where panoramas need to be converted to cube maps before being
uploaded (free options available) or Lapentor lapentor.com with a
cost of $15/monthly or $150/year and trial available offers password
protections, floor plan, own branding, unlimited Amazon S3 storage
and different customization possibilities with themes and plugins.
For further information about different account types, training videos
and additional help contact each service provider website. Note some
prices were included in this section as general reference but will no
doubt change in the near future, we therefore encourage you to check
current prices directly with each supplier.

NCTech Ltd 1 Boroughloch Square, Edinburgh, EH8 9NJ, UK
T: +44 131 202 6258 - www.nctechimaging.com

57

08. Applications

09. Conclusion

Virtual tour deliverables have multiple applications since they are
customisable and can be displayed on different types of device. Some
example applications:

The advantages for virtual tour deliverable creation using iSTAR and
iris360 along with NCTech’s software have been outlined in this
document. As a summary, NCTech makes the task of capturing high
quality image assets for virtual tours and other visual documentation
needs both easier and faster, whether for Google Street View, public
display, commercial website or any other virtual viewing, hosting or
sharing platform.

Sales and Marketing. Virtually show your services or products in a
simulated real environment. Websites and multimedia presentations.
Property management. Virtual property visit & walk through
experience prior to live viewing.
Tourism. Pre-visit planning in advance, providing information about
position and characteristics of the main points of interest. Or simply
enabling a virtual visit for people without time, ability or finances to
visit in person. Also providing a view of inaccessible locations such
as tombs, temples, caves, or other historical or natural environments
which could be in danger in case of mass tourism.
Corporate. Branding tours to show facilities, company work space,
schools and university virtual facility experiences.
Museums. Considered both education and tourism, nowadays it is
becoming more common to find museums offering virtual ‘walkthrough’ visits with information about the artwork they show, and
even interactive 3D models embedded within the virtual tours.
Training. For visual merchandising teams of chain brands to capture
or implement the displays of flagship stores. Assisting the technical
preparation for future situation management. Simulated operational
environments or landscapes to train for required skill before entering
the real live situation.
Manage and service. Cinema or theatre virtual seat selection, virtual
promotion for restaurants, sport centres, gyms, swimming pools,
accommodation. Virtual tours for accommodation searches at
universities, hotels and holiday apartments.
Entertainment. Interactive movies, full dome theatres and
planetariums.
Events and exhibitions. Virtual experiences to explore and visit
expositions and exhibitions online.
Social sharing. Sharing the experience that involves that specific
scene with other people not present, to share the experience
‘virtually’.
Historic archive. Recording and monitoring change, enabling a virtual
timeline, re-live the changes in an immersive environment.
Documentary. Adding additional dimensions to a documentary
experience: multimedia data such as audio, text, video, still images or
graphics.
Asset documentation & management. Immersive information to
contextually represent industrial or AEC environment, potentially
adding embedded documents or further data for reference.

“There is no doubt in my mind that NCTech is offering
a simple solution to a previously complex series of
tasks. That simplicity opens the door for exponentially
increasing camera users and will accelerate the
implementation of the new “Street View” project.
The competitive price in combination with the improve
easier workflow make iris360 ideal not only for Google
Street View but also any other imaging application,
either professional or personal.”
[Robert Hewitt - MPA Nationally Accredited Master Photographer]

NCTech 360 cameras comparison:

iris360

iSTAR

NCTech Immersive Studio (free of charge)

√

√

Google Street View compatibility

√

√

Google Street View App

√

Google Street View | Trusted photographers

√

OSC-Google API/INTEGRATED network

√

PTGui stitching (3rd party)

√

√

Kolor AutoPano Giga (3rd party)

√

√

Kolor PanoTour Pro (3rd party)

√

√

Garden Gnome Pano2VR (3rd party)

√

√

On board stitching

√

HDR capabilities

√

√

Walkaround mode

√

√

Remote Control

√

√*

Medical. Immersive interactive environments to treat and study
behaviour patterns related with physical and mental health problems
in both medical care and research.

IR conditions

√

NCTech Measurement Module

√

Educational. Although is not the aim of this app note, Google
Expeditions Pioneer Program must be named in this section as a
virtual reality platform built for the classroom (go.co.expeditions)

360° Web-sharing platforms

√

√

* iSTAR Remote Control only available for HDR OFF and HDR 3

The list is endless…
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[Application note – NCTech Measurement, Edinburgh]

NCTech Measurement Module
Date: 11 March 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech
Products used: NCTech iSTAR, Immersive Studio and NCTech Measurement Module

Accuracy testing of the NCTech iSTAR
Measurement Module

The iSTAR 360° camera in combination with
the iSTAR Measurement Module provides a
solution for rapid and intuitive point-to-point
measurement based on photogrammetric
techniques using pairs of panoramas with a
known offset, directly within the immersive
workspace. iSTAR can rapidly provide HDR 360°

images automatically in just one shot and can
be set to capture a single exposure, five or up
to nine exposures automatically. A project was
undertaken to establish the optimal workflow
and to evaluate the level of accuracy that can be
expected at different measurement distances
and orientations.

NCTech Ltd 1 Boroughloch Square, Edinburgh, EH8 9NJ, UK
T: +44 131 202 6258 - www.nctechimaging.com

59

The NCTech iSTAR camera combined with the NCTech Measurement
Module provides the possibility of measuring directly within an
immersive panorama workspace. This capability to rapidly capture
the environment and then measure later is ideally suited to situations
requiring rapid measurement, while avoiding the need to remember
all the desired measurements when on site.
01. Software installation
02. NCTech iSTAR data capture
03. Office work
04. Results
05. Evaluation of accuracy
06. Conclusion
07. Acknowledgements
08. References

01. Software installation
Installing NCTech ImmersiveStudio:
https://www.nctechimaging.com/immersive-studio/

Img. 02.01. Lower position iSTAR pair station. Tripod levelled.

Installing NCTech Measurement Module:
Supplied in a SDK form for 3rd party developers to integrate in their
own platforms

02. NCTech iSTAR data capture
02.01. PLANNING CAPTURE STATIONS.
Very little planning of capture strategy is required other than taking
into account the position of the camera in relation to the features
to be measured to ensure they appear in the images clearly. To
achieve the best results you should consider the following general
recommendations:

•
•
•

Measurements taken in the same plane as the image will
generally be better than in an orthogonal direction to it.
The closer the camera is to the object, the clearer the image
and the higher the number of pixels representing the object,
therefore accuracy is generally increased.
Avoid taking measure points in positions or views that are
unclear otherwise accuracy will likely be reduced.

02.01. CAMERA SETTINGS.
There are no special image capture considerations when using the
NCTech Measurement Module, simply use iSTAR as normal with the
most suitable settings taking into account scene light conditions.
However, notice that HDR is likely to be the best option in most cases
since you only will be able to measure what you are able to see.

Img. 02.02. Upper position iSTAR pair station. Tripod levelled. 60 cm
between camera positions.

02.01. PHOTO CAPTURE.
The NCTech Measurement Module is based on photogrammetry pairs.
A known vertically offset pair of images is therefore needed from
each station. The measurement computation expects an exact known
offset so it is critical this is set as accurately as possible. In order to
maximise offset accuracy a tripod with precision pole has been used.
General workflow per pair station:
1. Level the tripod with iSTAR in the ‘down’ position and capture.
2. Raise iSTAR up to the pre-established offset ‘up’ position
without moving the tripod horizontally, then capture.
Furthermore, ensure that iSTAR does not rotate between
upper and lower capture positions due to any pole rotation.

Img. 02.03. Tripod precision pole set up to 60 cm.
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03. Office-work

04. Evaluation of accuracy

03.01. PROCESSING iSTAR DATA IN NCTECH IMMERSIVE STUDIO.
Firstly, it is necessary to process iSTAR data using NCTech Immersive
Studio to produce the required stitched panoramas. Each camera
has been carefully calibrated in highly controlled conditions during
manufacture by NCTech, and each camera has its own calibration file.
NCTech Immersive Studio uses the iSTAR lens deformation parameters
from the calibration file to assist accurate stitching. Processing
images in NCTech Immersive Studio therefore means the user
benefits from this precision calibration when iSTAR images are used
for any precision applications or processes. Stitching is possible in 3rd
party software however we strongly recommend use of Immersive
Studio for the above reason.

Several measurement pairs corresponding to the same scene in
different positions and distances were performed in order to evaluate
the level of accuracy that could be achieved by using iSTAR and the
NCTech Measurement Module.

Img. 03.01. NCTech Immersive Studio interface.
To process iSTAR raw data in Immersive Studio, just drag and drop the
corresponding folders for each capture on to the Immersive Studio
window or, browse to the corresponding Input Directory. As default,
the Output Directory is set the same as the selected Input Directory,
but can be easily changed by clicking on dots button. For further
information about Immersive Studio visit https://www.nctechimaging.
com/immersive-studio/

Firstly, two scenes were captured using several pair stations at two
different distances. In the analysis, “FAR” is used for those pairs
which are placed furthest and “CLOSE” for those which are closer.
Each pair formed with two images is named with a number (01, 02...).
The first scene corresponds to a door church; which provides the
opportunity of evaluate different planes of orientation.

Img. 04.01. Immersive view with measurement lines in the NCTech
Measurement Module corresponding to “Measurement pair 01” in the
“ChurchCLOSE” scene.
In the second scene we can analyse the comparative accuracy
depending on camera position in relation to the building facade we
want to measure.

03.02. ACCESSING MEASUREMENT INFORMATION FROM iSTAR STEREO
PANO IMAGE DATA.
The iSTAR Measurement Module itself is supplied in a SDK form for
3rd party software developers to integrate into their own platforms,
thereby giving their users access to taking measurements with
iSTAR. Although NCTech has a test platform which was used to extract
measurement information for the purpose of this accuracy analysis
(and shown in the screen capture images in this Application Note), it
does not issue a generally available measurement application. The
iSTAR Measurement Module functionality is therefore only accessible
through integrated 3rd party software.
The specific user interface and operator workflow is not pre-defined
in the Measurement Module SDK. These elements are therefore
unique to each 3rd party integrator as they are developed according
to their own preference.
Further Application Notes will be released outlining the workflow and
user function for each Measurement Module integrated partner.
The basic operation of taking measurements from stereo-pano
images, however, has some standard steps which are outlined here:
• Select stereo pano images (‘up’ and ‘down’ image from same
x,y location, no rotation)
• Input camera offset between the ‘up’ and ‘down’ images
• Pick the start and end point of the desired length
measurement in pano 1
• Pick the start and end point of the same desired length
measurement in pano 2
Length computation is essentially instant and can be reported back to
the operator as defined within the 3rd party UI.

Img. 04.02. Immersive view with measurements in the NCTech
Measurement Module corresponding to “Measurement pair 01” in
“StreetCLOSE” scene.
The same measurement lines were taken in all pairs in the NCTech
Measurement Module and compared with real-world measurements
taken in-situ using a tape measure (named as “True Measurements”).
Measurement pairs are shown in the pictures. Note that each pair
is represented in the following images with only one photo since
measurement lines are the same in both images of the same pair.
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ChurchCLOSE Pair01

ChurchFAR Pair01

StreetCLOSE Pair01

StreetFAR Pair01

ChurchCLOSE Pair02

ChurchFAR Pair02

StreetCLOSE Pair02

StreetFAR Pair02

ChurchCLOSE Pair03

ChurchFAR Pair03

StreetCLOSE Pair03

StreetFAR Pair03

ChurchCLOSE Pair04

ChurchFAR Pair04

StreetCLOSE Pair04

StreetFAR Pair04

StreetCLOSE Pair05

StreetFAR Pair05

Img. 04.03. and Img. 05.04. Measurement scenes in the NCTech
Measurement Module corresponding to the “Measurement pairs”
tested for ChurchCLOSE/FAR.

Thus, “ChurchCLOSE” scene images are taken from aprox 4.50 m
distance whereas it increases up to aprox 8.00 m for “Church FAR”.
Aprox distances corresponsding to “StreetCLOSE” and “StreetFAR”
are 4.00 and 12.00 m. These two scenes allow us to test and explain
certain variables which can affect the final measurement accuracy
results:

Img. 04.04. and Img. 05.04.Measurement scenes in the NCTech
Measurement Module corresponding to the “Measurement pairs”
tested for StreetCLOSE/FAR.

04.01. RELATIONSHIP OF DISTANCE - ACCURACY

04.02. USER MANUAL POINT SELECTION

Considering the results in the scene named as “Church CLOSE” an
accuracy with error from 0.10 to 1.18% on average was achieved. The
majority of error results ranged from 0 to 0.5 cm, with two cases with
errors of 0.9 and 0.7 cm. Note that some pair stations had errors over
1.1 cm, “Pair Station 02” for “82 true measured value” had an error of
1.2 cm or “Pair Station 03” for “51 true measured value” had a 1.4 cm
error, with the exception of “226 true measured value” which had
errors over 1.1 in almost all pair stations.

Nevertheless, some higher errors have been obtained and must be
considered. Although measurements corresponding to “226 true
measured value” remain with errors around 0.60 % in both distances
(ChurchCLOSE/FAR scenes), the error values are over the common
ones (0.10-1.1%, 0-0.9 cm). In this case, the step border is not clearly
defined so it is difficult to select the exact same point in the pair of
images. This is apparent from the higher errors on this measured
point in all pair stations, where as the other stair step (192.5 true
measured value) doesn’t show the same issue.

As shown in the “Church FAR” scene data error values range from
0.16 to 1.1 % on average, except for a 2.04% value where increase was
given by just one station and a 4.58% which has higher error values
in all pair stations. In general, most values fit into the error range
0-0.5 cm, with three exceptions of 0.6, 0.7 and 0.8 cm. One higher
error of 2 cm for “38 true measured value” in “Pair Station 04” which
can be discarded from our average since it’s just produced in one
station. Error values corresponding to “51 true measure” and “226
true measure” are also over 1.1 cm.
As observed, the average % error (0.10-1.1%) and the general error
values (0-0.9 cm) largely remain in the same ranges, which means
that distance only has a small affect on the system, however it is
known that at further the distance fewer pixels define the same
length, and therefore the higher the possibility of making mistakes
in picking measure points.

Thus, the accuracy potential of the system is highly sensitive to
accurate selection of the same point in both pair images by the user,
which also explains the aforementioned error for isolated pair
stations.
If results corresponding to “51 true measured value” are checked, it
can be noted that they are in-line with the general range values in the
CLOSE scene, although the measurement plane was approximately
90 degrees to the view of the camera.
Thus, orientation itself can be discarded as the main reason for
causing errors in FAR scene, and, as it was explained in the previous
section, distance does not have significant impact on error. However,
a combination of distance and orientation make selecting the same
point in both pair difficult and therefore the error values increase.
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Results obtained from StreetCLOSE/FAR scenes match the
error ranges and explanations given in 05.01 RELATION
DISTANCEACCURACY and 05.02. USER MANUAL POINT SELECTION.

Img. 04.05. Measured error corresponding to
“ChurchCLOSE” and “ChurchFAR” scenes.

Img. 04.06. Measured error corresponding to
“StreetCLOSE” and “StreetFAR” scenes

In addition, two more scenes were analysed to further test the
application under different orientation requirements and around the
10 m distance limit.
One scene to compare measurements perpendicular to the camera
plane with measurements in a parallel plane related to camera view
line, and the other to check the range of error that can be obtained
if we work around the limit of 10.00 m. Furthermore, in the scene
which was used to compare parallel/perpendicular measurements,
measurements were taken at two different ranges of distances to
evaluate that difference in “CLOSE/FAR” conditions.

PerpendicularCLOSE Pair01

PerpendicularFAR Pair01

PerpendicularCLOSE Pair02

PerpendicularFAR Pair02

Limit 10m Pair01

Limit 10m Pair03

PerpendicularCLOSEPair03

PerpendicularFAR Pair03

Limit 10m Pair02

Limit 10m Pair04

Img. 04.07. Immersive view in NCTech Measurement Module
corresponding to the “Measurement pairs” to compare perpendicular/
parallel measurements.

Img. 04.08. Immersive view in NCTech Measurement Module
corresponding to the “Measurement pairs” to check the range of error
obtained working around the limit of 10.00 m.
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In the scene “Limit 10 m” all measures were taken in the same plane
of the wall. This wall is placed nearly 10.00 from the camera.
Based on “Parallel CLOSE/FAR” and “Limit 10m” variables which can
affect the final measurement accuracy results can be added:

Img. 04.09. Measured error corresponding to “PerpendicularCLOSE/FAR” scenes.

Img. 04.10. Measured error corresponding to “Limit10m” scene.
Note that in the scenes “PerpendicularCLOSE” and “PerpendicularFAR”
are not only perpendicular measurements related to the camera view
but also parallel measurements taken to compare them in the same
range of distance.
04.03. ERROR RANGE RELATED WITH THE iSTAR VISUAL DIRECTION.
Considering the results in the scene named as “PerpendicularCLOSE”
an accuracy with error from 0.16 to 0.50% on average was achieved
for parallel measures whereas an error from 0.44 to 0.78% on
average was achieved for perpendicular measurements. All show
error values in the 0-0.5 cm range, which matches the previously
mentioned range and common values (0.10-1.1%, 0-0.9 cm).
If the distance camera-measurement plane rises (“PerpendicularFAR”
scene) results also fits the aforemention error range values (0.101.1%, 0-0.9 cm). Therefore, the results confirm the system is not
highly dependant on iSTAR visual direction. However, the true
measurements of 180 cm and 89.5 “89.5 cm (second ocurrence in
the table) resulted in higher error values, one within perpendicular
view and the other within parallel view, which are a contrast to the
generally level good level of accuracy obtained. Thus, those errors
seem more related with the difficulty for the user to select the same
point in both pair images rather than related to camera orientation.
04.04. ACCURACY AT 10 M DISTANCE.
As shown in the “Limit 10 m” scene data, the average error range is
similar to the common error range values (0.1-1.1%, 0-0.9 cm), with just
one deviation in pair station 03. This evidences that the system is
quite robust to distance of measurement.

05. Conclusion
Rapid HDR immersive views with measurements are obtained by
using the NCTech iSTAR Measurement Module.

Knowledge of photogrammetry techniques is not needed since the
pair distance/camera offset and workflow do not change depending
on scene conditions or distance to the object.
Automatic HDR stitched images are provided. Instead having to use
several software applications or tedious workflow, the user receives
HDR images directly from NCTech ImmersiveStudio (NCTech stitching
solution) with no additional steps in their standard workflow.
High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV equivalent
range of up to 27 f-stops.
Immersive view rapid measurement method. NCTech iSTAR in
combination with the NCTech Measurement Module provides the
opportunity to gain rapid measurements within a whole immersive
view 360° scene using only two images. Measurements on site are
not required.
Typical accuracy¹. Common accuracy range values of 0.1 – 1.1 %
working with NCTech iSTAR Measurement Module have been obtained
with common error values which range from 0 to 0.5 cm, most
commonly under 1 cm. Nevertheless, the system is highly dependant
on the manual selection of the same points in both pair images
by the user. Therefore, any circumstance that affects the correct
selection of the measurement point by the user will increase the
error. On the other hand, the system itself is not highly dependant
on the surface orientation or distance to the object. General speaking
accuracy results obtained are quite competitive and should provide a
compelling solution in certain applications.
For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com

Only one iSTAR shoot is needed to get an HDR 360°image with five
(HDR ON) or up to nine (HDR PRO) exposure levels. Single exposure
can also be set.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and works out the most suitable camera
settings for the full 360° view.
1 - Noticed the range of errors are based only on the test which are shown in this Application
Notes, which means that could be situations in which the range of error presented doesn’t fit.
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[Application note – Church of Santiago in Betanzos, A Coruña]

iSTAR & Pix4Dmapper
Date: 9 September 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Pix4D
Products used: NCTech Immersive Studio, iSTAR and Pix4Dmapper 3.0

Point clouds from NCTech iSTAR 360 HDR images

The iSTAR 360° camera provides rapid,
automatic High Dynamic Range (HDR) 360
degree imaging and can be used as a
standalone device to create point clouds,
especially indoors, for complex architecture or
challenging light condition environments. iSTAR
can be used to provide HDR imagery with more
exposure steps and also reduced processing

and capture time compared to standard frame
cameras. The aim of this report is to briefly test
the general Pix4D workflow using iSTAR images
to create 3D point clouds and/or Digital Surface
Model (DSM). The results of the project showed
that iSTAR provides the ability to efficiently
capture HDR images for point cloud creation,
even in complex indoor locations.
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The aim of this report is to show the workflow used to achieve quality
coloured point cloud using NCTech iSTAR imaging within Pix4Dmapper.
01. Software installation.
02. NCTech iSTAR features.
03. Photo Capture.
04. General Workflow.
05. Results.
06. Conclusion.
07. Acknowledgements.

03.01 PLANNING STATIONS
Careful advanced planning of capture strategy is critical as it affects
the quality of results. The following recommendations should be
considered:

•
•

01. Software installation
Installing NCTech ImmersiveStudio
https://www.nctechimaging.com/immersive-studio/

•
•

Installing Pix4Dmapper
https://pix4d.com/

02. NCTech iSTAR features
HDR capabilities: iSTAR HDR capabilities (HDR ON and HDR PRO) enable
capture of high resolution quality images within low light and high
contrast environments, where details of shadows and bright areas
are also captured. This capability means tie points can be matched
and extracted from shadows and bright areas, meaning the overall
number of tie points is higher compared to single exposure images
which typically provide fewer or no tie points in high contrast areas.
Fisheye lenses: iSTAR is mounted with 4 fisheye lenses to enable
capture of larger areas from the same position in each shot
compared with a standard lens. As a result, the number of images
needed is reduced, saving time on site and at the processing stage.
Furthermore, with fewer images required the computer resource
needed is also reduced.
360° images: iSTAR captures 360° spherical images (360° x
137.5° +/- 5°) which covers the whole scene view in each position,
therefore, problems related with ‘pattern’ are less likely to affect our
reconstruction. In addition, 360° images provide greater coverage per
capture than regular frames therefore are more efficient in both time
on site and data processing.
GPS connection: iSTAR can be connected with external devices for
geo-location and therefore coordinates will appear automatically
within EXIF data after image processing within ImmersiveStudio with
no need of post-processing for image-location data synchronisation.
In addition, the user can select the most suitable geo-location device
for the project.

Ensure the number of images provide enough coverage to
avoid blind zones. To reconstruct an area, it is necessary for it
to be visible in at least two images.
Generally speaking, image overlap should be 75-85%,
and even as high as 90% for challenging projects. Check
the Pix4Dmapper manual for further information on what
circumstances are considered challenging and therefore
require higher overlap. https://support.pix4d.com/hc/en-us/
articles/204272989-Offline-Getting-Started-and-Manual-pdf#gsc.tab=0
The object is being reconstructed should take up the
maximum area of the photograph.
Adjust the capture strategy considering the type of object
(linear acquisition, indoors, urban outdoor…) and the project
purpose and/or requirements.

03.02 CAMERA SETTINGS
ISO value: generally speaking, ISO should be set to the lowest value
possible to minimise noise in the image. Nevertheless, depending on
the lighting conditions, a lower ISO value may significantly increase
exposure time so it could be advisable under such circumstances to
increase the ISO value.
HDR value: iSTAR can be set as HDR OFF (Single exposure), HDR ON (5
exposure levels), HDR PRO (9 exposure levels). Generally speaking,
HDR ON is sufficient for indoor capture. However, where there are
landscapes, scenes or rooms with higher light contrast, therefore
requiring a wider range of exposure values, HDR PRO will provide
better results for building point clouds.
“Capture with current analysis” iSTAR mode: This is a default iSTAR
setting which activates automatically after taking the first photo.
When the iSTAR camera takes an image, it first analyses the whole
scene to establish the appropriate exposure value averaged across
the 360° degree view. These settings are then saved by default,
meaning analysis time can be saved between multiple captures
within similar conditions. However, for scenes with very changeable
light conditions between shots, the function should be cancelled by
pressing the green arrow on the top left corner, the new scene is
then analysed during the next capture.

Accurate calibration: each iSTAR is precision engineered to 0.002
mm and calibrated at a manufacture stage using over 800 survey
targets in 360 degrees. The user therefore benefits from this accurate
calibration when working with iSTAR data for point cloud creation
from image based techniques.
In comparison with standard cameras used for close-range
photogrammetry, the combination of iSTAR capabilities make it easier
to virtualise indoor environments, locations where high contrast is
likely and spaces tend to be small or reduced.

03. Photo Capture
Before loading photos in Pix4Dmapper it is needed to capture them
and select the most suitable for model reconstruction. Note that a
good dataset is required in order to automatically produce results
with high quality and accuracy. Considering general environments
requirements for Pix4Dmapper performance:

•
•
•
•

Avoid un-textured, shiny, mirrored or transparent objects.
Avoid unwanted foregrounds.
Avoid moving objects within the scene to be reconstructed
GPS/IMU/Ground Control Points are not required but
recommended.

Img. 03.01. “Capture with current analysis “mode activated.
03.03 IMAGE GEOLOCATION, GROUND CONTROL POINTS AND
CONSTRAINTS
iSTAR images can be geo-referenced by using GPS external devices
connected to the camera and therefore the captured coordinates are
saved as part of the EXIF data with no need for post-processing to
synchronise GPS-Image capture. The user has the freedom of being
able to select the GPS device suitable for the need.

NCTech Ltd 1 Boroughloch Square, Edinburgh, EH8 9NJ, UK
T: +44 131 202 6258 - www.nctechimaging.com

66

Pix4Dmapper reads information from the EXIF data in order to
automatically import the coordinates and geo-locate them into the
software. For further information about how GPS coordinates affects
project accuracy within Pix4Dmapper check
https://support.pix4d.com/hc/en-us/articles/202558909#gsc.tab=0
Note that if selected GPS refresh rate is lower than the image capture
rate, more than one image will have the same GPS position and
the processing may fail or may not correctly calibrate some of the
images.
Alternatively, Ground Control Points (GCPs) can be used to accurately
locate, scale and rotate the model and are highly recommended in
order to improve output accuracy. A minimum number of 3 GCPs is
required to take them into account during reconstruction although,
5 GCPs is the recommended amount and having more than 10 GCPs
does not further contribute significantly to improve the results. If
no GCPs are used, scale (defining by a line connecting 2 vertices,
rayCloud>Create>New Scale Constraint) and orientation contraints
(defining 3 axis, rayCloud>Create>New Scale Constraint ) can be used.

04. General workflow
General iSTAR workflow within Pix4Dmapper doesn’t differ
significantly from standard, which commonly uses frame images
instead of panoramas. The aim of this section is to explain the general
workflow using iSTAR data within Pix4Dmapper.

Img. 04.02. Panorama in *.jpg equirectangular format, after processing
in NCTech ImmersiveStudio.
04.02. NEW PROJECT WIZARD
When iSTAR raw data processing is finished, *jpg panoramas need
to be imported into Pix4Dmapper. After creating a new project
(Project>New Project…) the New Project wizard opens to set
the project folder file location and guide you through the project
creation process, adding images included. Once the images have
been selected, click “Next” to pass to the following screen wizard
corresponding to “Image Properties” wizard window.
Image properties window can also be checked by going to
Project>Image Properties Editor…

04.01. PROCESSING PANORAMAS INTO NCTECH IMMERSIVE STUDIO
Firstly, it is necessary to process iSTAR raw data using NCTech
Immersive Studio. Each iSTAR camera is carefully calibrated in highly
controlled conditions during manufacture by NCTech and has its own
calibration file. Processing images within Immersive Studio therefore
means the user gains the advantage of this precise calibration,
thus, the error is generally reduced compared to stitching in other
software. Kolor Autopano Giga can also work with iSTAR data but
we nevertheless recommend to use ImmersiveStudio, which is
continuously being improved by the NCTech development team.
NCTech Immersive Studio can set the output image resolution
automatically or it can be selected from several pre-set options (2K,
4K or 16 Mpixel). Resolution is known to be directly related to accuracy
so, it is advised to select the 10K highest resolution option (Auto).
NCTech ImmersiveStudio has a simple and user-friendly interface. To
process iSTAR raw data into Immersive Studio just drag and drop the
corresponding folders of each image on the Immersive Studio window
or, select the corresponding directory. Both options lead to the same
result. As default, output directory is the same as input directory but it
can be changed easily by clicking on dotted button.
For further information about how to use ImmersiveStudio visit
https://www.nctechimaging.com/immersive-studio/

Img. 04.03. Image Properties Editor within Pix4Dmapper. Note that in
this case shown, images have been captured without geolocation data.
Images Properties window is divided into three sections:
Image geolocation which sets the coordinate systems corresponding
to the images and the accuracy of image geolocation and therefore
depending on the accuracy selected, geolocation data will have
different weight on the reconstruction process. If GPS has been used
with iSTAR when data capture, images geolocation position has been
saved within the EXIF data and therefore is loaded automatically by
Pix4Dmapper.

Img. 04.01. NCTech ImmersiveStudio interface.
After processing iSTAR raw data into NCTech Immersive Studio,
panoramas will appear into an “Output folder” in *.jpg format.

Img. 04.04. Pop-up window warning displayed within Pix4Dmapper.
Note this warning will appear if the 80% of image coordinates are the
same, which also happens when there are no coordinates.
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Note that Step.1 Initial Processing is faster with geolocation and in
cases without sufficient overlap between images, geolocation helps
calibrate the images.
Selected camera model which sets and configures the camera model
corresponding to the used images. Note the iSTAR camera model is
included within Pix4Dmapper database and therefore no additional
steps are required.
Image table which displays images with the corresponding properties
(enabled for consideration during the process, position accuracy,
coordinates and group).
Finally, select the desired template which best suits the project type
and purpose in the “Processing Options Template” wizard window
which can be modified before processing and Finish the New Project
wizard.
Img. 04.07. Results after 1.Initial Processing. The 8 images used
for reconstruction and tie points are displayed at rayCloud within
Pix4Dmapper.
2. Point Cloud and Mesh: This step builds a point cloud based on the
matched points from Step.1 and also a mesh based on the point cloud
gained within this Step.2.
Image Scale:1/2(Half image size) with Multiscale activated is
recommended for point cloud densification in order to have the best
average combination of quality results and time taken. Selecting
1(Original image size) slows down the process but provides better
results. The minimum number of matches shouldn’t be lower than
3 since 2 can lead to non satisfactory results. Point density should
be selected between Low, Optimal or High depending on the project
requirements although Optimal represents the best option for an
average combination of quality results and time taken.
Img. 04.05. Image processing templates at New Project wizard within
Pix4Dmapper.
04.03. PROCESSING: CAMERA CALIBRATION, POINT CLOUD BUILDING
AND TEXTURED MESHING
Once the project is created, the “Map View” is displayed by default.
Processing options corresponding to the previous selected template
in the “New Project” wizard can now be changed, Process>Processing
Options or by clicking on the corresponding icon at the left lower
screen corner. Thus, the main basics steps containing several image
processing options (which can be processed separately or altogether
at once) to get a reconstruction with Pix4Dmapper are:
1. Initial Processing. During this step, common points between
images are found and matched and therefore images are calibrated
and located in their position. Custom: 1(Original image size) are the
recommended settings corresponding to General: Keypoints Image
Scale section.

Img. 04.08. Image processing options for 2.PointCloud and Mesh: Point
Cloud within Pix4Dmapper.

Img. 04.06. Image processing options for
1.Initial Processing within Pix4Dmapper.

Img. 04.09. Results after 2.Point Cloud and Mesh. Point Cloud is
displayed at rayCloud within Pix4Dmapper.
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Regarding to the textured mesh, Medium resolution is the best
combination of quality to time taken. However, lower or higher
resolution settings may be selected depending on the project
requirements.
Note these recommendations are given for a general / standard
project but different setting may be more suitable for special and/or
complex cases.
Once the most suitable settings have been selected, considering the
project type, purpose and requirement, processing can be launched
by pressing “Start” at the “Processing bar” where one or more steps
can be selected.

Coloured point clouds, meshes or intermediate output of the process
can be obtained using the described workflow in Pix4Dmapper. The
results showed in this section can be achieved using NCTech iSTAR
camera with Pix4Dmapper and are automatically saved at directory in
project folder once processing steps are finished. The project selected
for this purpose required 8 panoramas in order to reconstruct an
indoor church apse.

06. Conclusion
Point clouds obtained using iSTAR data for image matching techniques
adds new advantages compared to data obtained from standard
frame cameras commonly used for the same purpose:
Only one iSTAR shot is needed to cover a 360 degree environment
surface, which means saving time against taking a larger number of
images to cover the same area with a non-360 degree camera.
Larger surface covered per lens. iSTAR fisheye lens permits not only
covering a 360 view but also a larger area per lens and therefore, the
number of images needed is reduced.
The number of images needed to accomplish a virtualisation is
reduced, especially for objects within enclosed spaces, complex
shapes and/or several surface angles. The number of images also
decreases where there are challenging lightning conditions because
of iSTAR’s automatic HDR capabilities.
Time saving on-site and processing. By decreasing the number
of images needed to virtualise a scene the time consumed on site
is reduced as also is the time and resource needed to process the
captured data.

Img. 04.10. Image processing options for 2.PointCloud and Mesh: 3D
Textured Mesh within Pix4Dmapper.

05. Results

Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and works out the most suitable camera
settings for the full 360 view.
Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, minimal training
is required.
High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV range up to
27 f-stops.
Texture quality. iSTAR whole scene analysis in combination with HDR
provides models with high quality textures.
Adding extra value. Additional deliverables such as virtual tours can
be produced form the same source iSTAR images without increasing
time on site.

Img. 05.01. Point Cloud reconstruction using 8 iSTAR images within
Pix4Dmapper. Settings for Image Scale: 1 (Original image size).

Straightforward Pix4Dmapper workflow. Coloured point cloud, mesh
and/or textured mesh can be automatically obtained following a
simple straightforward workflow within Pix4Dmapper. iSTAR camera
model is included within Pix4Dmapper database and therefore no
additional steps are required.
To conclude, iSTAR capabilities are worth considering it for
photogrammetry purposes. Especially in low light condition
environments, indoors, and some complex architecture where iSTAR
benefits make a difference. The 360° FOV in combination with HDR
capabilities and highly accurate factory calibration improves the
workflow and results by reducing capture and process time and
increasing the tie points detection within challenging light conditions.

07. Acknowledgements
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collaboration and technical support in this Application Note.

Img. 05.02. 3D textured mesh gained from 8 iSTAR images within
Pix4Dmapper. Texture settings: Medium.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Application note – Morningside Church, Edinburgh]

iSTAR & PointCab
Date: 29 August 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, PointCab
Products used: NCTech iSTAR and PointCab 3.5

NCTech iSTAR 360 camera to provide rapid HDR imaging
for pointcloud colourisation within PointCab

The iSTAR 360 degree camera provides rapid,
automatic HDR (High Dynamic Range) 360
imaging and can be used as a standalone
device or for colourisation of point clouds
created by spherical terrestrial scanners within
PointCab software to improve the point cloud
quality and therefore, documentation output
gained from PointCab (floorplans, sections,
sketches…). A project was undertaken to scan

and image Morningside church using LeicaP40
and iSTAR, to show their combined capabilities
and colourisation workflow using NCTech
ColourCloud fully integrated within PointCab
software. The results of the project showed that
iSTAR provides the ability to efficiently capture
HDR colour and accurately combine this with
the scan data for significantly improved 3D
visualisation within PointCab.
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The aim if this report is to show the workflow used to achieve
high quality coloured pointclouds using NCTech iSTAR imaging and
ColourCloud fully integrated within PointCab, and its advantages.
01. Software installation.
02. Fieldwork.
03. Office-work.
04. Results.
05. Conclusion.
06. Acknowledgements.

03. Office works
The whole workflow was carried out using PointCab with NCTech
ColourCloud fully integrated.
03.01. OPEN POINT CLOUDS DATA WITHIN POINTCAB.
Point cloud data opening requires the user to create a new project by
clicking on “New” icon or going to File>New and “Create new PointCab
project” window will appear.

01. Software installation
Installing PointCab:
http://www.pointcab-software.com/en/downloads/

02. Fieldwork
Working with the NCTech iSTAR 360 camera is the easiest, most
accurate and time efficient method of colouring point clouds.
02.01. PLANNING SCAN STATIONS no change is required to the
standard process for scanning with or without colour.
02.02. CAPTURING POINT CLOUDS, select the laser scanner resolution
most suitable for the job, as in normal use. NCTech solutions work
properly irrespective of scan resolution. The higher the resolution
and accuracy of point cloud the better the quality visualization will be
achieved.

Img. 03.01. Create a new project within PointCab interface.
Select the option “Terrestial scanning project” and press “Open scan
data” to select the point clouds to import: Leica (*.ptx, *.ptg), FARO
(*.fws, *.lsproj, *.fls), Z+F (*.zfs, *.zfprj), Riegl (*.rsp), E57 (*.e57)…
Finally, save the project within PointCab format (*.pcp) and import will
start.
In case point clouds were not added during project creation process,
or more point clouds are needed, the user can add them directly by
going to “Advance importer” within the top bar tools.
03.02. REGISTRATION.
Imported point clouds can be pre-registered or unregistered: the user
will be asked before proceeding to import.

Img. 02.01 and Img. 02.02. Leica P40 laser scanner and iSTAR station.
02.03. CAPTURE iSTAR IMAGES by replacing the laser scanner with
the iSTAR¹camera in each scan station, and capture 360 images in
full colour. NCTech supply adaptor rods with a Tribrach quick release
repeatable connector to quickly and accurately locate iSTAR at the
same central capture position as the scanner.
iSTAR has different HDR modes enabling single exposure, five
exposure and nine exposure 360 images to be created. Five exposure
HDR imaging was used here and additional capture time was
approximately 75s per scan position.
iSTAR’s on camera interface is designed to be like a regular automatic
digital camera. Knowledge of photographic techniques is not required
with iSTAR automatically calculating the most suitable exposure value
taking into account the entire 360 scene. Station capturing times were
5 minutes corresponding to scan capture plus 75 seconds for iSTAR,
however, iSTAR can be moved after the capture phase competes
which is typically 15-20 seconds.

Img. 03.02. Pop-up window within PointCab to indicate if the scans are
already registered or not.
In case point clouds were directly imported with no previous
registration, PointCab provides target-based registration which is
manufacturer independent, target-less registration is also possible
by selecting naturally corresponding points plus a detailed PDF
registration report. A coordinates file can also be added.
For further information about registration processes with PointCab
visit: http://www.pointcab-software.com/en/modules/registration/

¹NCTech recommend using its adaptor poles to accurately locate the camera to the correct
position, different adaptors are used for other laser scanning systems (Leica, Faro, Topcon,
Trimble etc.) .
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Img. 03.05. Colourisation job process in “Job editor” and “Job list”
within PointCab interface. Note iSTAR data preview appears at “Job
editor”.

Img. 03.03. Point cloud registration module within PointCab.

Once colourisation process has finished, the corresponding preview
of each scan in the “Advanced importer” appears with colour, also the
panorama view or planar view used within registration tool.

03.03. POINT CLOUD COLOURISATION WITHIN POINTCAB.
In order to colourise point clouds taking advantage of NCTech
ColourCloud technology within PointCab: Open “Advanced Importer”,
right mouse click plus “colorize scan” to select the corresponding
iSTAR raw data file (*.nctri). You can select/link each scan station and
then, press “Start import” in order to import all iSTAR data at once.

Img. 03.06. Colourisation job process in progress in “Job list” within
PointCab interface.

Img. 03.04. iSTAR image selection corresponding to selected scan
position within Advanced Importer.
When import task finishes, colourisation jobs corresponding to each
scan station will appear in the “Job list” window. By selecting one by
one, users can change the image linked to each scan and/or check
the corresponding preview at “Job editor” window. Then process one
or multiple jobs to colourise only selected point clouds or “process all
jobs” in order to launch batch colourisation.
After colourisation is performed, colourisation can easily be edited
or overwritten by selecting the corresponding job at “Job list”, right
mouse button and “Edit”. Therefore, colourisation data could be previsualized and swap at “Job editor”.

Img. 03.07. Point clouds previews within “Advanced Importer”. Note
some scans have already been colourised.
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Img. 03.10. PointCab Layout/Section colour settings.
Img. 03.08. Point cloud colourised with NCTech ColourCloud within
PointCab.
03.04. POINT CLOUD COLOUR VISUALISATION SETTINGS.
As default, colourisation visualisation appears deactivated or in grey
mode within PointCab. In order to change this, either change the
project settings at File>Settings within Layouts/Section tab: Color (It
will affect all project and apply all new projects onwards) or edit the
corresponding views at “Job List” and edit it at “Job editor” within
“processing” section: Color (It will affect only the edited view). Thus,
Color set at 0% means point cloud will look as grey whereas if it is set
at 100% the point cloud will appear full colour.

Img. 03.11. Colour visualisation within PointCab interface.

04. Results
Coloured point clouds are obtained following the described workflow.
22 Leica P40 and iSTAR stations were captured to obtain a merged
coloured point cloud of the Morningside church.

Img. 03.09. PointCab project colour settings.

Results show the improved quality point clouds that can be obtained
by combining LeicaP40 laser scanner with HDR iSTAR images
for colourisation within PointCab. Apart from point cloud colour
visualisation, PointCab offers several output data possibilities:

Img. 03.12. PointCab WebExport results: Panoramas obtained from point cloud corresponding to scan stations plus coloured point cloud.
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Panorama Module: additional panorama views different from the
ones corresponding to each scan position can be created. Resolution
and covered degrees can be adjusted.
Merger: content to compose plans from various views (layout/
section). Information is scaled and within a coordinate file. It can be
generated within several images and CAD formats.
WebExport: allow to share the project within *.html. Panoramas and
selected view (layout/section) are exported to WebExport project to
be display within an interactive and immersive environment.

05. Conclusion
Coloured point clouds can be obtained by using iSTAR for image
capture within laser scanner for improved visualisation and time
saving with NCTech ColourCloud integrated within PointCab following
method as described for the following advantages:
Only one iSTAR shot is needed to colour the entire scene at each scan
position instead of multiple shots and images per scan. This means
less time on site and also eliminates patchy colourisation experienced
where individual images are optimised for their omnidirectional view,
then combined.

High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV range of 27
f-stops.
Time consuming fieldwork is reduced. iSTAR can provide high visual
quality images (HDR ON: 5 exposures, HDR PRO: 9 exposures) in
significantly less time than typical laser scanner internal cameras
(HDR images with 3 exposures). Taking an image in HDR with iSTAR
typically takes from 5s – 20s for the capture phase. Total time,
including writing data (during which time camera can be moved)
ranges from 1.50’ to 4.50’ depending on lightning conditions, but 2.00’
on average in normal light conditions.
Time consumed for office work is reduced. Raw data from iSTAR is
used directly for colourisation proposes so the need to pre-process
data with 3rd party software is eliminated. After capture data is ready
for the automated colourisation step with no time lost.
Quality of coloured point clouds is improved. iSTAR data produces
better results compared to typical laser scanner internal cameras it
is the ideal accessory for laser scanners without an internal camera.
Furthermore, the general quality of point cloud in terms of definition
is improved since the “interpolate and fill occluded areas” option
within NCTech ColourCloud is automatically applied when colourisation
is processed in PointCab.

Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and work out the most suitable camera
settings for the full 360 view.

06. Acknowledgements

Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, minimal training
is required.

NCTech Ltd is greatly appreciative of PointCab (http://www.pointcabsoftware.com/en/), especially Richard Steffen for his collaboration and
technical support in this Application Note but also Leica Geosystems
http://www.leica-geosystems.co.uk, especially Gary Kelly for his
valuable help and support while data capturing.

Automatic overlay of iSTAR images to point clouds, avoiding the
need to manually define common points, eliminating user error and
enabling batch processing for efficient operation.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Application note – NCTech iSTAR & SphereVision Project]

iSTAR & SphereVision
Date: 18 August 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Arithmetica
Products used: NCTech iSTAR, Measurement Module, ImmersiveStudio and SphereVision Project.

NCTech iSTAR camera for immersive media and point-topoint measurements in SphereVision Project

The iSTAR 360 degree HDR camera used in
combination with the NCTech Measurement
Module provides a solution for rapid and intuitive
measurement based on photogrammetric
techniques using panoramas directly within
an immersive workspace. Furthermore, the
NCTech Measurement Module integration
within Arithmetica SphereVision enables the

user to combine different NCTech 360° media
(still panoramas, measurement pairs and/
or videos from time-lapse) with maps, plans
and layout for a complete overview including
measurements. In addition, SphereVision Viewer
(free) allows users to share the projects with
other stakeholders, taking advantage of
SphereVision’s user-friendly interface.

NCTech Ltd 1 Boroughloch Square, Edinburgh, EH8 9NJ, UK
T: +44 131 202 6258 - www.nctechimaging.com

75

The majority of site measuring equipment either takes specific point
measurements, or are mass capture devices such as laser scanners,
collecting millions of measure points at incredibly high speed. The
former requires a knowledge or decision of all measure points needed
while on-site, the latter provides the ability to capture everything
and measure later, but equipment is high cost, more complex to use,
creates vast quantities of data requiring processing and storage,
plus where high fidelity imaging is required can take a long time to
capture.
The NCTech iSTAR camera combined with the NCTech Measurement
Module provides a hybrid approach: the ability to rapidly capture a full
360° view of an environment for taking measurements later, with the
simplicity of operation, reduced data volumes and high visual clarity
of photography. NCTech Measurement Module functions are available
at zero cost for easy integration by third parties through the NCTech
SDK. Arithmetica have integrated these functions into SphereVision
Project and therefore the aim of this report is to show how these
functions work within this software application.
01. Software installation.
02. NCTech iSTAR data capture.
03. NCTech 360° media within Arithmetica SphereVision Project.
04. NCTech Measurement Module within Arithmetica SphereVision
Project.
05. Results.
06. Measurement Accuracy.
07. Conclusion.
08. Acknowledgements.

Planning Capture Stations. Very little planning of capture strategy
is required other than taking into account the line of sight’ position
of the camera in relation to the features to be measured, to ensure
a clear view of the subject areas. To achieve the best results users
should consider the following general recommendations:

•
•
•

Measurements taken in the same plane as the image will
generally be better than in an orthogonal direction to it.
The closer the camera is to the object, the clearer the image
and the higher the number of pixels representing the object,
therefore accuracy is generally increased.
Avoid taking measure points in positions or views that are
unclear otherwise accuracy will likely be reduced.

Camera Offset: The NCTech Measurement Module is based on
photogrammetry pairs. A known vertical offset between images is
therefore needed at each station.
The measurement computation expects an exact known offset so it is
critical that the desired tripod column offset is set accurately.
It is also critical to ensure that the actual capture offset used matches
precisely to the settings selected on the iSTAR camera. In order to
maximise offset accuracy a tripod with fixed head and precision pole
feature is required. Camera offset setting must be indicated in cm.

01. Software installation
Installing Arithmetica SphereVision Project:
http://www.spherevision.com/downloads/
Installing NCTech ImmersiveStudio (free):
https://www.nctechimaging.com/immersive-studio/
Img. 02.01. Setting camera offset for measurement pair capture mode.

02. NCTech iSTAR data capture
General workflow per pair station:
Different types of immersive media can be obtained from iSTAR
depending on the capture mode and/or the raw data processing.
Mainly, panoramic images (timer or/and walk-around capture modes),
measurement pairs (measurement module capture mode) and video
gained from images (time-lapse capture mode):

1. Set the camera offset distance, level the tripod with iSTAR in the
“down” position and capture the down image. While down image is
being saved, the camera can be raised to the “up” position.

02.01.TIMER.
With a minimum setting of 5 seconds, this is the simplest iSTAR
capture mode. The user input is simply to select the exposure,
ISO and suitable HDR mode, considering the environment lighting
conditions plus timer settings.
02.02. WALKAROUND.
This mode replaces the timer with the ability to take the whole 360°
environment in two steps: half of the scene in the first step and the
other half in the second step. The user selects the exposure, ISO and
suitable HDR mode considering the environment lighting conditions
plus which side of the scene is capture in each step by touching the
corresponding iSTAR screen corner.
02.03. MEASUREMENT MODULE.
This mode guides the capture of two images within a known
vertical camera offset. The input from the user consists of selecting
the exposure, ISO, timer and suitable HDR mode considering the
environment lighting conditions plus the known camera offset
between captures. iSTAR screen wizard will guide the user during
the capture. Compared to other capture modes some additional
factors must be taken into account, since the obtained measurement
accuracy is highly dependant on how the images are taken on-site:

Img. 02.02. iSTAR screen on measurement capture mode before
capturing the down image.
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02.04. TIME-LAPSE: This mode capture one image every 5 minutes
or more. The input from the user consists of selecting the exposure,
ISO and suitable HDR mode considering the environment lighting
conditions plus defining the time-lapse between captures.
Data output from this capture mode is not only single panoramic
images captured but these can also be processed to a video file
within NCTech ImmersiveStudio.

03. NCTech 360° media within
Arithmetica SphereVision Project
Img. 02.03. iSTAR down position for measurement pair capture.
2. Raise iSTAR up to the pre-defined offset up position without moving
the tripod horizontally, then capture. Furthermore, ensure that iSTAR
does not rotate between upper and lower capture positions due to
any pole rotation and that the offset previously set on the camera
corresponds with the actual distance the tripod has been risen. While
up image is being saved, iSTAR can be moved to the next station
Generally speaking, 60 cm is the recommended offset in order to get
optimal results. However, a different offset could be used in some
environments (for instance, indoors with limited height ceilings or
where the user is restricted to use a tripod with a different offset
range). The camera offset distance can then be set specific to the
needs and requirements.

03.01. CREATE A PROJECT AND SET A LOCATION.
To create a new project, press “Create a New Project…” within
activities list on Start tab or File>New>Project.

Img. 03.01. SphereVision Project start tab.
The first step after creating and naming a new project is to add a
location (image file). The location is the element to which everything
else relates and could be a map, floor plan or any other photograph.

Img. 02.04. iSTAR measurement capture mode screen, before capturing
the up image.
Pair measurement station will be saved as *.nctrm raw data and all the
files related with each pair will appear within a 20160101-090000-M
folder so “-M” will be added to indicate “Measurements”.

Img. 02.05. iSTAR in up position for measurement pair capture.

Img. 03.02. New Project dialog for naming and adding a location.
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03.02. ADD MEDIA FILES.
After the location has been set, Media Files and Makers (clickable
items which link to a media file, other location or pop up) can be
attached to the map.
Media Files can be added within the New Project dialog or by using
the Media tab on the right end bottom corner.

03.03. ADD HOTSPOT AND CUSTOMISE.
In order to place imported media on the location (map, aerial photo,
floor plan...) go to Hotspots>Link to Media, select the media you want
to link and double click on the map to place the corresponding icon.
Size can be varied within properties panel area. The icon can be
re-located as many times as you want by double clicking on the map
until deselecting by mouse right click on the icon>deselect HotSpot.

Img. 03.04. Deselect HotSpot.

Img. 03.03. New Project dialog for adding media files.
Different types of media files based on native iSTAR data formats can
be added:
iSTAR Still (*.nctri): iSTAR single panorama in proprietary
raw format. Mainly captured with Timer or Walkaround
mode. Allows to user to import data directly from the
iSTAR SD card after capture.
iSTAR MeasurementPair (*.nctrm): iSTAR measurement
pair saved in proprietary raw format from iSTAR
Measurement Capture mode. Allows to user to import
data directly from the iSTAR SD card after capture.

For further information about all possibilities available to customise
your project within Arithmetica SphereVision Project by using markers
check SphereVision user manual http://www.spherevision.com/
download/project/spherevisionproject-userguide.pdf

04. NCTech Measurement Module within
Arithmetica SphereVision Project
If a measurement pair (*.nctrm or *.nctmd) has been added,
measurements within an immersive view can be taken. In order to
obtain measurements:
1. Select an iSTAR measurement pair on the location (map, floor plan
etc…), on the Media tab or on the Object list. An immersive view of the
pair is displayed in the Media Player which you can extend by
pressing the full screen view icon.

iSTAR Container (*.nctmd): iSTAR measurement data pair
in which up and down image have been already stitched.
Note that the main advantage of this format (*.nctmd)
against the previous (*.nctrm) is the time saving when
importing the data since it is already stitched, particularly
useful for data sharing.
Furthermore, additional iSTAR or iris360 processed data in non-native
formats can be added, as can data from other non-NCTech spherical
capture devices. Formats gained from NCTech ImmersiveStudio are
considered:
Spherical Still (*.jpg): iSTAR or iris360 single panorama in
equirectangular format, mainly captured with Timer or
Walkaround mode. Using *.jpg from NCTech
ImmersiveStudio takes advantage of all NCTech
processing options as “Auto-Level”, different image
resolution or activate/deactivate HDR but it requires a
pre-processing within NCTech ImmersiveStudio and
therefore the benefit of using NCTech raw data directly
from the SD card is omitted.

Img. 04.01. Location with a selected measurement pair within
SphereVision.

Spherical Video (*.avi): spherical video gained from iSTAR
images mainly captured by time-lapse capture mode and
processed by NCTech ImmersiveStudio.

Img. 03.03. Import Media dialog for adding media files. Note stitching
will occur while importing.

Img. 04.02. Measurement Module within SphereVision. Sync Views
mode activated.
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2. Press the NCTech Measurement Module icon on the right end top
button of Media Player to launch Measurement Module. Visualisation
default mode will sync both up and down images (Sync Views mode).
3. Press “Add Measurement” icon to launch point-to-point
measurement.
4. Mark point1 and point2 (left click mouse) within left image to
place the corresponding measurement line and therefore, a second
measurement line will appear within right image.

05. Results
An interactive map with different media linked results is the
process output. If iSTAR measurements pairs have been added,
measurements can be checked within SphereVision Project Immersive
environment. In order to check how resulting interactive map looks,
“Viewer Mode” should be activated.
Each measurement pair can be exported as a panorama in
equirectangular format with overlaid measurements, or the
project can be exported for sharing with other stakeholders within
SphereVision Viewer (free):
Export measurements: one of the measurement pair images can be
exported with measurement lines overlaid by clicking on “Export”
button within Measurement Module mode. Image Type and naming
need to be added within the emergent dialog.

Img. 04.03. Measurement Module within SphereVision. Marking points
within the left image.

Img. 05.01. Export Measurements dialog.

Img. 04.04. Measurement Module within SphereVision. Marking points
within the right image.

Img. 05.02. Panoramic image with measurement lines overlaid.

5. Place the second measurement line in the correct position by
dragging the points of the measurement line.

Share the project: the project can be shared by exporting within a
compressed bundle (*.svbun) at File>Export File.

A measurement box corresponding to each measure will appear on
the left where the name, colour and display of the measurement line
can be customised. The cross on the right end top corner can be used
to delete the corresponding measurement line.

Then, the exported project can be imported within Sphere Vision
Viewer (free) to display the interactive map and check (but not edit)
the measurements within an immersive view at File>Import project or
at the Start tab.

Img. 04.05. Measurement Module within SphereVision. Measurements
within the immersive Sync View.

Img. 05.03. Measurements within an Immersive View. Sphere Vision
Project Viewer.
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06. Measurement Accuracy
In order to maximise achieved accuracy, correlating the camera offset
settings with the accurate value of offset pole is crucial. In addition, a
tripod with precision pole and fixed head is imperative.
It is not only the system setup and capture conditions that affect the
accuracy, the system is also sensitive to how accurately the user
selects corresponding measurement lines points: selecting the exact
match point within both the up and down images will provide the
best possible accuracy of measured point compared to the real-world
value.
For further details about accuracy related with NCTech Measurement
Module review the Measurement Module Application Note.
Accuracy figures achieved in this Application Note are representative
of the specific conditions, environment and setup used at the time. It
is good practice for users to always test real achievable performance,
particular where any change in set-up is applied.

07. Conclusion
Interactive maps with linked iSTAR 360 degrees media are obtained
from SphereVision (single panoramas, measurement pairs, timelapse video).
NCTech Measurement Module integrated with Arithmetica
SphereVision Project enables measurements to be made ‘post
capture’ within an interactive and immersive user interface.
This combined capability is valuable for many applications as it
eliminates the need for site re-visit.
Only one iSTAR shot is needed to get a single HDR 360 image with five
(HDR ON) or nine (HDR PRO) exposure levels. Single exposure can also
be set.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and calculates the most suitable camera
settings for the full 360 view.

High performance output in difficult lighting conditions. iSTAR
can provide high visual quality images in a wide range of lighting
environments thanks to automatic HDR settings and EV range of 27
f-stops.
Knowledge of photogrammetry techniques is not needed since the
pair distance/camera offset and workflow won’t change depending on
scene conditions or distance to the object.
Offset flexibility. Camera offset can be established by the user
increasing performance flexibility since the user can set the most
suitable offset setting for each equipment or environment.
Automatically stitched HDR images are provided. Instead of
needing several separate software applications meaning a tedious
workflow, the user gets HDR 360 images directly within Arithmetica
SphereVision with no additional steps.
Immersive view rapid measurement method. NCTech iSTAR in
combination with Measurement Module provides the opportunity to
rapidly capture of a whole immersive view 360 scene using only two
images. Taking the actual measurements on site is not required.
Shareable measurements results, each measurement pair can be
exported with measurements overlaid and displayed on any device
with (*.png, *.jpeg…) image viewing capability.
Shareable project. All interactive maps & plans can be exported
to be checked by other project stakeholders for free when using
Arithmetica SphereVision Viewer (free) for Windows platform.

08. Acknowledgements
NCTech greatly thanks the Arithmetica Team http://www.
spherevision.com/ especially Mark Senior and Jonathan Bolton for
their collaboration and technical support in this Application Note.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Application note – NCTech iSTAR & VPC Creator and Arena4D]

iSTAR & Veesus
Date: 15 August 2016
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, Veesus
Products used: NCTech iSTAR, Measurement Module, ColourCloud, Arena4D Data Studio and VPC Creator.

NCTech iSTAR 360° camera for immersive point-to-point
measurements and point cloud colourisation

The iSTAR 360 degree camera in combination
with the NCTech Measurement Module
provides a solution for rapid and intuitive
measurement based on photogrammetric
techniques using panoramas, directly within
an immersive workspace.
Furthermore, iSTAR can rapidly provide 360

degree HDR images for automatic point cloud
colourisation in just one shot, and can be
set to capture a single exposure, five or nine
exposure HDR.
Both NCTech ColourCloud and Measurement
Module technologies are integrated within
Veesus Arena4D Data Studio and VPC Creator.
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The majority of site measuring equipment either takes specific point
measurements, or are mass capture devices such as laser scanners,
collecting millions of measure points at incredibly high speed.
The former requires a knowledge or decision of all measure points
needed while on-site, the latter provides the ability to capture
everything and measure later, but equipment is high cost, more
complex to use, creates vast quantities of data requiring processing
and storage, and where high fidelity imaging is required can take a
long time to capture.
The NCTech iSTAR camera combined with the NCTech Measurement
Module provides a hybrid approach: the ability to rapidly capture a full
360° view of an environment for taking measurements later, with the
simplicity of operation, reduced data volumes and high visual clarity
of photography. In addition, the same iSTAR camera can be used
for automated colourisation of point clouds gained from spherical
terrestrial scanners, by using the NCTech ColourCloud technology, for
significant time saving and improved HDR visual quality.

Img. 02.01. Setting camera offset for measurement pair capture mode.

Both the ColourCloud and Measurement Module functions are
available at zero cost for easy integration by third parties through
the NCTech SDK. Veesus have integrated both these functions
into Arena4D Data Studio (Measurement Module) and VPC Creator
(ColourCloud) and therefore the aim of this report is to show how
these functions work within this software application.
01. Software installation.
02. NCTech iSTAR Measurement Module data capture.
03. NCTech Measurement Module within Veesus Arena4D.
04. Measurement Accuracy.
05. NCTech iSTAR ColourCloud data capture.
06. NCTech ColourCloud within Veesus VPC Creator.
05. Conclusion.
06. Acknowledgements.

Img. 02.02. Measurement pair capturing indoors.
General workflow per pair station:

01. Software installation
Installing Veesus Arena4D DataStudio and VPC Creator:
http://www.veesus.com/veesus/index.php/downloads

1. Level the tripod with iSTAR in the “down” position, set the camera
offset distance and capture the down image. While down image is
being saved, the camera can be risen to the “up” position.

02. NCTech iSTAR Measurement Module
data capture.
02.01. PLANNING CAPTURE STATIONS. Very little planning of capture
strategy is required other than taking into account the line of sight’
position of the camera in relation to the features to be measured, to
ensure they appear in the images clearly.
To achieve the best results you should consider the following general
recommendations:

•
•
•

Measurements taken in the same plane as the image will
generally be better than at an orthogonal direction to it.
The closer the camera is to the object, the clearer the image
and the higher the number of pixels representing the object,
therefore accuracy is generally increased.
Avoid taking measure points in positions or views that are
unclear otherwise accuracy will likely be reduced.

02.01. MEASUREMENT PHOTO CAPTURE: The NCTech Measurement
Module is based on photogrammetry pairs. A known vertical offset
between images is therefore needed at each station.
The measurement computation expects an exact known offset so it is
critical that the desired offset is set accurately on the tripod.
It is also critical to ensure that the actual capture offset used matches
precisely to the settings selected on the iSTAR camera. In order to
maximise offset accuracy a tripod with fixed head and precision pole
feature is required. Camera offset setting must be indicated in cm.

Img. 02.03. iSTAR screen on measurement capture mode before
capturing the down image.
2. Raise iSTAR up to the pre-defined offset up position without moving
the tripod horizontally, then capture. Furthermore, ensure that iSTAR
does not rotate between upper and lower capture positions due to
any pole rotation and the offset previously indicated on the camera
correspond with the actual distance the tripod has been raised.
While the up image is being saved, iSTAR can be moved to the next
station. General speaking, 60 cm is the recommended offset in order
to get optimal results. However, a different offset could be used in
some environments (for instance, indoors with limited height ceilings
or where the user is restricted to use a tripod with different offset
range).
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The camera offset distance can then be set specific on the specific to
the needs and requirements.

iSTAR Measurement Pairs are represented by a sphere with an NCTech
Measurement Module icon. Immersive view will be opened by clicking
on the sphere (it will then become yellow).

Img. 03.03. Measurement pair representation within Veesus Arena4D
before (on the left in green) and after (on the right in yellow) selection.
03.01. TAKING IMMERSIVE MEASUREMENTS
To activate a measurement line click on the NCTech Measurement
Module icon at the bottom of the screen. The cursor will change to
measure mode. To take a measurement:
Img. 02.04. iSTAR screen on measurement capture mode before
capturing the up image.
The measurement station image pair will be saved as *.nctrm
proprietary raw data and all the files related with each pair will
appear within a 20160101-090000-M folder so “-M” will be added to
indicate “Measurements”.

03. NCTech Measurement Module within
Veesus Arena4D Data Studio
The measurement pair raw file (*.nctrm) can be opened directly in
Veesus Arena4D by selecting Open file>NCTech or by clicking right
mouse button>Add>NCTech. Image stitching will occur automatically.
In addition, previously stitched measurement pair files (*.nctrmd) can
be also opened, in this case the stitch process will not automatically
launch after opening the data.

Img. 03.04. Measurement Module cursor mode within Veesus Arena4D.
1. Double click on the point 1 within down image and press enter
key once you are happy with selected point. Up image will appear
automatically.
2. Double click on the point 1 within the up image and press enter key
once you are happy with selected point. Down image will appear.

Img. 03.01. Open NCTech iSTAR data within Veesus Arena 4D.

Img. 03.05. Measurement Module cursor mode after selecting point1 of
measurement line in both up and down image within Veesus Arena4D.
3. Repeat steps 1 and 2 for the corresponding point 2 on the
measurement line.

Img. 03.02. Stitching process. Note there is a yellow bar at the bottom
to indicate the process.

Img. 03.06. Measurement Module cursor mode selecting point2 of
measurement line within Veesus Arena4D.
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4. Measurement line will be placed.

Img. 03.07. Measurement line placed within Veesus Arena4D.

05. NCTech iSTAR ColourCloud data capture
Not only the NCTech Measurement Module is integrated within Veesus
Arena4D but also the NCTech ColourCloud point cloud colourisation
function. Users should, however, note that the iSTAR data capture
and processing differs depending on the intended application of
the acquired data, whether immersive measurements or point
cloud colourisation. The iSTAR data capture workflow for point cloud
colourisation is simply to capture an iSTAR 360 degree image at
each scan position after point cloud capture. NCTech supply adaptor
options to accurately and quickly locate iSTAR at the same central
capture position as the scanner. Note the suitable rod will vary
depending on the scanner type.

To delete measurement lines from the image pair, go to properties
pair and “clear measurements”. All measurements of the selected pair
will be deleted.

Img. 03.08. Measurement pair properties within Veesus Arena4D.
Use the scroll/mouse wheel to navigate through the immersive view
and Ctrl+keyboard for further navigation options within Veesus Arena
4D interface.
Img. 05.01. Leica P40 scanning station.

Img. 03.09. iSTAR image view within Veesus Arena4D.

04. Measurement Accuracy
In order to maximise achieved accuracy, correlating the camera offset
settings with the accurate value of offset pole is crucial. In addition, a
tripod with precision pole and fixed head is imperative.
It is not only the system setup and capture conditions that affect the
accuracy, the system is also sensitive to how accurately the user
selects corresponding measurement lines points: selecting the exact
match point within both the up and down images will provide the
best possible accuracy of measured point compared to the real-world
value.
For further details about accuracy related with NCTech Measurement
Module check the corresponding Measurement Module Application
Note. Accuracy figures achieved in this Application Note are
representative of the specific conditions, environment and setup used
at the time. It is good practice for users to always test real achievable
performance, particular where any change in set-up is applied.

Img. 05.02. iSTAR placement on same scanning station setup as Img. 05.01.

06. NCTech ColourCloud within Veesus
VPC Creator
Arena4D software requires point clouds to be in its own native *.vpc
format. The VPC Creator supports LAS 1.0 ~1.2 (and LAZ), ASCII (txt,
xyz, pts), e57 format, Dot Product (dp), Riegl (rds,rsp) and Faro (fls,
fws, lsproj) and doesn’t require a license. The creator intelligently
analyses the input files to create the best performing output file(s) to
use within Arena 4D Data Studio (*.vpc) and provides the ability to use
NCTech ColourCloud technology during point cloud import process.
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Img. 05.03. Veesus VPC Creator interface. “File Open” button in yellow.

Img. 05.06. Veesus VPC Creator interface. NCTech tab with “Use
ColourCloud” option enabled.

05.01. OPENING FILES

Once desired options have been selected press “Process” button
(in green) to launch VPC conversion. The user is asked to indicate
the *.nctri file corresponding to the point cloud you are about to
convert into Arena4D own format (*.vpc) and destination folder where
converted point cloud will be placed.

Go to “File Open” icon, select the corresponding point cloud in your
directory within the emergent window and click “Open”.

Img. 05.04. Point cloud file selection.
Process button will appear as available (green) and also an estimated
time required for conversion.

Img. 05.07. iSTAR (*.nctri) raw data selection for point cloud
colourisation within Veesus VPC Creator.
After selecting “Open” the conversion process to *.vpc Arena4D
format using the embedded NCTech ColourCloud technology will be
launched. Note that during conversion a yellow bar will appear at the
bottom of the screen. Check window besides for more details about
conversion process.

Img. 05.05. Veesus VPC Creator interface. “Process” button in green.
05.02. NCTECH COLOURCLOUD SETTINGS
In order to launch ColourCloud technology during import process,
you should enable the option “Use ColourCloud” at NCTech tab. There
are also other available options in this tab which allow the user save
several image data (intensity, range, iSTAR results) with the same
folder as the *.nctri used during colourisation process.

Img. 05.08. VPC conversion process with NCTech ColourCloud
technology embedded.
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05.03. COLOURED POINT CLOUD WITHIN ARENA 4D
Once the VPC conversion process is finished, coloured point clouds
can be used directly within Arena4D Data Studio . Go to Open
file>Point Cloud in order to import point cloud within *.vpc format into
Arena4D.

07. Conclusion
Rapid HDR immersive views with measurement capability are
obtained by using NCTech iSTAR Measurement Module within Veesus
Arena4D. Furthermore, iSTAR data can be use within Veesus VPC
Creator for point cloud colourisation during conversion process.
Only one iSTAR shot is needed to get a single HDR 360 image with five
(HDR ON) or nine (HDR PRO) exposure levels. Single exposure can also
be set.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene and works out the most suitable camera
settings for the full 360 view.
High performance output in difficult lighting conditions. iSTAR can
provide high visual quality images in a wide range of lightning
environments thanks to automatic HDR settings and EV range of 27
f-stops.
Knowledge of photogrammetry techniques is not needed since the
pair distance/camera offset and workflow won’t change depending on
scene conditions or distance to the object.
Offset flexibility: camera offset can be established by the user
increasing performance flexibility since the user can set the most
suitable offset setting for each equipment or environment.
Automatically stitched HDR images are provided. Instead of needing
several separate software applications meaning a tedious workflow,
the user gets HDR 360 images directly within Veesus Arena4D with no
additional steps.

Img. 05.09. Point cloud import/open process within Arena 4D.
Point clouds will appear coloured by intensity as default. In order to
display colour gained from iSTAR data and ColourCloud, you should
open point cloud properties and change the “colour” field from
“intensity” to “colour”.

Immersive view rapid measurement method. NCTech iSTAR in
combination with Measurement Module provides the opportunity to
rapidly capture of a whole immersive view 360 scene using only two
images. Taking the actual measurements on site are not required.
Automatic overlay of iSTAR images to point clouds, avoiding having
to manually define common points, eliminating user error for efficient
operation.
Quality of coloured point clouds is improved. iSTAR data gives
improved visual quality compared to the single exposure laser
scanner internal camera with additional time savings.

08. Acknowledgements

Img. 05.10. Point cloud in *.vpc format opened in Arena4D. Colour
properties field set as “intensity”.

NCTech greatly thanks the Veesus Team www.veesus.com/veesus,
specially Mark Estcourt, Mark Christy and Matthew Ransom for their
collaboration and technical support in this Application Note, also Leica
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For further information about iSTAR or NCTech software visit
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Img. 05.11. Point cloud in *.vpc format opened in Arena4D. Colour
properties field set as “colour”.
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[Application note – Eaton Experience Centre Houston, USA]

iSTAR & LFM Server
Date: 10 May 2017
Author: Araceli Perez Ramos, Application Assistant
Organisations involved: NCTech, LFM Software Ltd, Point3D
Products used: Z+F 5010X laser scanner, NCTech iSTAR, LFM Server 4.4.1.3 with NCTech ColourCloud integration

NCTech iSTAR 360° camera to provide rapid HDR imaging
for Z+F 5010X 3D point cloud colourisation

The iSTAR 360 degree camera provides rapid,
automatic High Dynamic Range (HDR) 360°
imaging and can be used as a standalone device
or for colourisation of point clouds created by
spherical terrestrial scanners. Although the
Z+F scanner can provide internal HDR colour
capture, iSTAR can be used to provide HDR
imagery with reduced capture time. A project
was undertaken to partially scan and image
the Eaton Experience Centre (Houston), using

both technologies, to show their combined
capabilities. Additionally, iSTAR images with
no scan data paired were captured in order to
enrich documentation data for potential digital
asset management purposes. The results of the
project carried out using LFM Software showed
that iSTAR provides the ability to efficiently
capture HDR colour and accurately combine this
with the scan data for significantly improved
3D visualisation and time saving.
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The aim of this report is to show the workflow used to achieve
a quality, coloured point cloud using an NCTech iSTAR imaging
device and a Z+F 5010X scanner within LFM Server 4.4.1.3, and its
advantages. Data capture was carried out by Point3D.
01. Software installation.
02. Fieldwork.
03. Office-work.
04. Import still iSTAR images.
05. Results.
06. LFM Server dataset generation.
07. HyperBubble.
08. Conclusion.
09. Acknowledgements.

01. Software installation
Installing LFM Server 4.4.1.3¹²:
http://web.lfm-software.com/en/About-LFM/Product-Downloads.aspx

Img. 02.01. Laser scanning with Z+F 5010X at the
Eaton Experience Centre.

Installing NCTech Immersive Studio:
https://www.nctechimaging.com/downloads/

02. Fieldwork
Working with NCTech solutions is the easiest and most accurate
method of colouring point clouds with iSTAR images:
02.01. PLANNING SCAN STATIONS requires no change to standard
processes for scanning with or without colour.
02.02. CAPTURING POINT CLOUDS with the Z+F 5010X. Select the laser
scanner resolution you consider most suitable for the job as in normal
use. NCTech solutions work irrespective of scan resolution. Four scan
stations were performed for testing purposes (41.000.000 points/scan
position approx.)

Img. 02.02. Z+F 5010X scanner and iSTAR station schema .
Image courtesy of http://www.laserscanning-europe.com

02.03. CAPTURE iSTAR IMAGES by replacing the Z+F 5010X with the
iSTAR³ camera at each scan station, and capturing 360° images in full
colour. NCTech supply adaptor rods for the Z+F 5010X to accurately
locate the iSTAR camera at the same central capture position as
the scanner. The suitable adaptor depends on the system used to
connect tripod and laser scanner.
NCTech recommend a 167.8 mm pole (150-265 mm) to use in
combination with Tribrach connection, both available at the NCTech
e-commerce store https://www.nctechimaging.com/shop/
The iSTAR has different HDR modes enabling single exposure (HDR
OFF), five exposure (HDR ON) and nine exposure (HDR PRO) 360°
images to be created. Five exposure HDR imaging (HDR ON) was used
here and capture time was typically 30s4 per scan position.
iSTAR’s on camera interface is designed to be very simple to use
like a regular automatic digital camera. Knowledge of photographic
techniques is not required with the iSTAR, which automatically
calculates the most suitable exposure value, taking into account the
entire 360° scene. On the other hand, the Z+F 5010X imaging capture
time was 3 m 30s (only imaging) per scan station.

Img. 02.03. Adaptor rod in combination with Tribach connection to
achieve the correct position for use with the Z+F 5010X laser scanner.

1 The LFM Server Installation Guide can be downloaded here
https://lfmproducts.blob.core.windows.net/lfm-technical-portal/technical-resources/LFM_
TR_004_01%20%5BLFM%20Server%20Software%20Installation%20Guide%5D.pdf

3 NCTech recommend using its adaptor poles to accurately locate the camera in the correct
position, different adaptors are used depending on the laser scanning systems (Leica, Faro,
Topcon, Surphaser, Trimble, Z+F…).

2 Recommended Machine Specification to cover typical uses of LFM can be downloaded here
https://lfmproducts.blob.core.windows.net/lfm-technical-portal/technical-resources/LFM_
TR_006_01_DOC_R2.1%20%5BLFM_Machine_Specification_2017%5D.pdf

4 The full iSTAR capture process includes “Analysing time”, “Capturing time” and “Saving time”.
During saving time the “OK to move iSTAR” message will appear on the iSTAR screen, at which
point iSTAR can be moved to the next capture position.. For this reason in this example quoted
capture time doesn’t include “Saving time”.
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03. Office-work
03.01. GATEWAY MODE.
Unless otherwise instructed, LFM Server within Gateway mode will be
used during the office-work. In order to change the mode, click on the
small LFM icon placed on the left of the title bar and select “Gateway”.

Img. 03.01. Setting Gateway mode within LFM Server 4.4.1.3.
Once LFM has been opened, an “Untitled” project is created by default.
In order to change “Untitled” to our project name, the project must
be saved (by clicking on the large LFM Server logo in the top left and
selecting Save) with the *.lfm file format in the selected location.
03.02. DEAD ANGLE.
In order to adjust the FOV of the laser scanning to the FOV of iSTAR,
adjust the “Dead Angle” option from the “Options > Project” tab . The
“Dead Angle” refers to the cut-off zone in the base of the scan. The
default setting for this value is 24° but in order to match the iSTAR FOV,
this value should be set at 45°.

Img. 03.02. Dead Angle of 45°set within LFM Server 4.4.1.3.

Img. 03.03. Visualisation of the same scan station with a Dead Angle set
at 24° (upper image) and 45° (lower image) within LFM Server 4.4.1.3.
03.03. IMPORT SCAN DATA IN LFM SERVER.
To import scan data into LFM Server, right click on the project in the
“Registration” tab and select the option “Import to this project”. Select
the scans you want to work with by navigating to and selecting them
in the browser. In our case this is data from a Z+F 5010X but it is
important to highlight the fact that LFM Server can work with many
other point cloud formats: *.fls (FARO Scan), *.fws (FARO Project File)
*.3dd (Riegl Scan), *rxp (Riegl Vline Scan), *.rsp (Riegl Project File),
*.ptx (Leica PTX Scan), *.ptz (Leica PTZ Scan), *.prj (Leica P-Series
Scan), *.tzf (Trimble Scan), *.pts, *.e57, *.las, *.laz (Unstructured Scans)
and *.dp (unstructured scans)…

Img. 03.04. Importing data to LFM Server 4.4.1.3.
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03.04. CONVERSION OPTIONS AND COLOURISATION.

03.05. VIEW AND PROCESS COLOURED SCAN DATA.

Once the scans we are going to work with have been selected, the
“Conversion options” window will pop-up. Among other settings like
range and intensity clipping, you’ll find a tick-box for “Colourise scans
from iSTAR images”. Tick it and click on “Choose colourisation files…”
in order to open the corresponding dialog where a table with all the
scans will be shown. Double click in each row of the Colourisation
file name column and then click on the dot button to locate the
corresponding *.nctri file. Repeat the same process for all scan files
and press “OK”.

To view and to process scan data, scans have to be ‘Loaded’. Right
click on the corresponding scan > Load points.

Img. 03.07. Load points in the 3D View within LFM Server 4.4.1.3

Img. 03.08. Loaded points in the 3D View within LFM Server 4.4.1.3
In this project, registration was carried out based on targets but a
survey was not available and therefore “Perform Bundle Adjust” in the
Options > Project tab needed to be set to “Yes”.
Img. 03.05. Conversion options and *.nctri file selection for
colourisation with LFM Server 4.4.1.3
The conversion state will be reflected in a progress bar placed beside
each scan station name. Once one of them has been 100% converted
it can used, meanwhile, the conversion of the remaining scan file
occurs in the background. Note the conversion includes, among
others, NCTech ColourCloud colourisation.
Img. 03.09. Perform Bundle Adjust value within LFM Server 4.4.1.3
Targets can be marked within the 3D View or the BubbleView (right
click on the scan position to be opened > Show BubbleView or
alternatively, drag and drop the scan onto the 3D View tab.

Img. 03.06. Conversion progress bars including NCTech ColourCloud
colourisation corresponding to each scan station within LFM Server
4.4.1.3

Img. 03.10. BubbleView within LFM Server 4.4.1.3
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In order to mark targets, click on the “Pick Targets” button on the
Tools toolbar and click on the target centre. A small augmentation
window will pop up where the center can be marked more precisely.
Toggle between different types of targets (checkerboard, spherical
or free pick) by rolling the mouse wheel. Once the target center has
been selected, the “Identify Target” window will be opened to name
the target.

Img. 04.01. Import still iSTAR images into LFM Server 4.4.1.3

Img. 03.11. Target identification within LFM Server 4.4.1.3
To register the scans, right click on the scan group and select
“Register All and Bundle Adjust”.
For further information about registration, including target prediction
and improving the accuracy of poorly fitting targets check, the “LFM
Server Gateway Mode – Data Preparation and Registration” user
manual.
Once registration is finished, it can be useful to update the scan file
headers. This will store the position, the rotation and the targets in
the *.zfc files instead of just within the project file and therefore scans
can be added to another project in the correct position.
To update the scan headers right click on a scan group and select
Scan Headers > Update Scan Headers.

Img. 04.02. Progress bar corresponding to an still iSTAR image into LFM
Server 4.4.1.3
Once the progress bar disappears, a BubbleView can be opened by
right clicking on the image within the “Registration” tab and selecting
“Show BubbleView”. A new tab named after the image will be created.
Alternatively, the image can be dropped into the 3D View tab or
selected in the 3D View and open the BubbleView by right click > Show
BubbleView. Note the BubbleView functions are limited to visualisation
if there is no 3D point cloud data linked.

Img. 04.03. Open BubbleView within LFM Server 4.4.1.3
05.01. EDIT IMAGE POSITION.
Img. 03.12. Registered point cloud within LFM Server 4.4.1.3
Note that if scans are registered locally to each other, it is possible
that the master scan (the one to which others are registered to) could
be classed as unregistered. Unregistered scans are not included
within the LFM Server dataset generation so in order to ensure
this scan is included, right click on it and select the option “Force to
Registered”.

04. Import still iSTAR images
To import still iSTAR images, right click on the name of the project
in the “Registration” tab and go to “Import to this project” which
will open a window browser to search for your files. LFM Server:
Gateway Mode accepts images in *.png, *.jpg and *.nctri formats
so the user can directly import the *.nctri file or a *.jpg gained
from NCTech Immersive Studio. In this case, *.nctri was the chosen
format. Once the images have been selected, a “Conversion options”
window will pop-up where, among other features, an image preview
is displayed. A progress bar will appear beside the image name.

Imported still images (with no point cloud data linked) are placed at
0,0,0 position by default but they can be relocated by:
Editing Coordinates: To edit coordinates, select the image in the
“Registration” tab and in the Attributes Window select the x/y/z with
left mouse click. Double click on the appropriate field so it can be
edited. Enter the desired coordinates and press Enter.
Visual positioning: Right click on the image in the “Registration” tab
and select “Manipulate”. A red/green/blue coordinate frame will be
shown with the “3D View” tab.
The image can be moved by clicking and dragging the appropriate
arrow. Once the image has been moved, right click on one of the
arrows to accept the new position or press Escape to cancel and
recover the original position.
Any iSTAR still image present in the project at the point of dataset
(*.lfd) generation will be carried through to the LFM Server dataset for
viewing by engineering users.
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05. Results
A dataset from Eaton Experience Centre was obtained following the
described workflow. The dataset combines point clouds coloured
using iSTAR data along with NCTech ColourCloud integrated within LFM
Server 4.4.1.3 and 54 still iSTAR images.

Img. 05.04. Data navigation within BubbleView in LFM Server 4.4.1.3.
A virtual tour generated with the 54 still STAR images within a 3rd
party software (courtesy of Point3D) can be explored here:
http://www.point3d360.com/360sites/eaton/tour.html

Img. 05.01. Registered point clouds coloured using NCTech ColourCloud
integrated with LFM Server 4.4.1.3. 3D View within LFM Server (default
point size)

06. LFM Server Dataset Generation
06.01. LFM Server Deliverable (*.lfd) Creation.
Once the scans in the project have been registered, an LFM Server
Deliverable (*.lfd) can be created. LFM Server dataset compilation is
available in LFM Server: Gateway Mode (Advance Mode required) and
an LFM Generator license must be available in order to generate the
dataset.

Img. 05.02. Registered point clouds coloured using NCTech ColourCloud
integrated with LFM Server 4.4.1.3. 3D View within 3rd party software.
Note the only visual difference between Img.05.01 and Img 05.02 is
default point size within LFM Server and therefore how dense the
point cloud looks but the colour representation in both software is
quite close to reality, providing a good solution for iSTAR colour quality
representation.
Coloured point clouds and still iSTAR images can be navigated within
the 3D View or BubbleView where scan positions are represented
by a scan 3D icon and iSTAR images within *.nctri file format are
represented with an iSTAR 3D icon. By right mouse clicking on any of
those icons the user can “Manipulate” (move) the corresponding data
or “Show BubbleView” (open a BubbleView in a new tab) from both 3D
View and BubbleView.

Img. 06.01. Generation settings in LFM Server 4.4.1.3.
Right click on the corresponding scan group and select the option
“Generation settings” so that a new “Generation” tab will appear
where the following settings and locations need to be selected:

Location for Destination file: select the folder where the LFM Server
dataset will be created.
Intermediate Points Locations: select the folder where the
intermediate files will be created. Note it is advisable to create a new
empty folder before adding it.

Img. 05.03. Data navigation within 3D View in LFM Server 4.4.1.3.

Final Points Location: this section creates an automatic folder called
“points” within the folder specified by user as “Location for destination
file”.
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Volume clipping: define the volume to be considered for the *.lfd
creation between “Unlimited” (include all scans of the group), “Current
Volume” (generate only points within the selected volume) and “Min/
Max” (generate points within the minimum and maximum corners of
a volume).
Density: choose between “Full”, “Half” or “Quarter” resolution.
Incorporate Colour Information: Tick the box to apply colour to the
scans points.
Once all information has been provided, click on the “Dataset” button
on the “Generation” Toolbar. A pop up window will inform you about
the spaced required on the hard disk and after accepting it, a second
window will appear to give a time estimation for data creation.

07. HyperBubble
The HyperBubble is an immersive advance rendering of laser scan
data that delivers photorealistic visualisation with the ability to freely
navigate a project. HyperBubble is available in LFM Server: Server
Mode and an LFM Generator license must be available in order to
publish the data (Advanced Mode required).
07.01. HYPERBUBBLE DATA PUBLISHING WORKFLOW.
Once the LFM Server Deliverable (*.lfd) has been created, HyperBubble
data can be created by simply right clicking on the LFM Server dataset
and selecting “Publish… > LFM HyperBubble Resources”.

Img 06.02. Incorporate colour information within LFM Server
Deliverable (Generation settings).
During dataset generation process a progress bar will be displayed at
the bottom right corner.
In the case that the LFM Server dataset folder is the only one
delivered, the BubbleView files (*.int) files need to be copied into the
“pngs” folder where *.lfd file is created.

Img. 07.01. HyperBubble data publishing in LFM Server 4.4.1.3.
A pop up window will inform you about the spaced required on the
hard disk. After accepting it, a browser will appear where you must
locate the .zfc files (by default they are within the project folder). A
message will pop up when complete but meanwhile a progress bar
will be displayed on the bottom right corner.
07.02. HYPERBUBBLE DATA VIEW.
Click on the “HyperBubble” button placed on the View toolbar. The
HyperBubble data will be displayed in the “3D View” tab. Toggle
between “HyperBubble” button and “Park” button (which displays the
closest available parked HyperBubble with the “3D View” tab) placed
on the Control toolbar depending on your visualisation need.

Img. 07.02. HyperBubble data in LFM Server 4.4.1.3.
Note the visualisation quality changes between photographic
HyperBubble display (Img. 07.02) and plain coloured point cloud (Img.
05.01).
Within the HyperBubble, use the left button in combination with
mouse movement in order to fly and the right button to move the
viewpoint along the Z axis.
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08. Conclusion

09. Acknowledgements

HDR 360° images can be obtained using iSTAR for image capture, then
these images can be used to add HDR colour to point clouds by using
NCTech ColourCloud fully integrated within LFM Server or as still 360°
images to enrich data visualisation as described here.

NCTech greatly thanks LFM Software Ltd http://web.lfm-software.
com/, Jenni Copple, Claire Pulella and Ryan Kilmurray for their help
and technical support and Point3D https://www.point3d.us.com/
especially Gregory B. Lawes, Julie Schmitt and Andrew Mangini for
their collaboration and data capturing.

Furthermore, working with NCTech solutions combined with LFM
Server for point cloud colourisation and still HDR image for digital
asset management is advantageous to alternative techniques for a
number of reasons:

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com

Only one iSTAR shot is needed to colour the entire scene at each
view instead of multiple shots and images per position. This means
less time capturing on site and also eliminates patchy colourisation
experienced where individual images are optimised for their
unidirectional view, then combined.
Knowledge of photography techniques is not needed since iSTAR
analyses the whole scene to calculate the most suitable camera
settings for the full 360 view.
Simple use, minimal training. iSTAR and NCTech software are
designed to be highly automated and user friendly, with minimal
training required.
Automatic overlay of iSTAR images to point clouds, avoiding the
requirement to manually define common points, eliminating user
error and enabling batch processing for efficient operation.
High performance output in difficult lighting conditions. iSTAR
can provide high visual quality images in a wide range of lighting
environments as a result of the automatic HDR settings and EV range
up to 27 f-stops.
Reduced fieldwork data capture time. iSTAR can provide high visual
quality images (HDR ON: 5 exposures, HDR PRO: 9 exposures), often
in significantly less time compared to the laser scanners internal
camera. The HDR imaging process with iSTAR typically takes 1.50’ to
fully complete (including data save during which time the camera can
be moved), depending on lighting conditions. In good to moderately
low lighting this will break down to: 4s Analysing + 7s Capturing +
1.39’ Saving = 1.50’ total. In HDR Pro mode for maximum 9 exposure
dynamic range in very low light this may be 4.50’ total: 1.40’ Analysing
+ 1.20’ Capturing + 1.90’ Saving.
Fully integrated workflow. NCTech ColourCloud technology is
integrated within LFM Server from version 4.4.1.3. onwards and
therefore, the user benefits from a workflow within their usual point
cloud software with no need to learn new software or change their
workflow. In addition, benefits from using iSTAR data extends to the
HyperBubble which delivers high quality photorealistic visualisation
for coloured scan data.
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[Case Study – St Paul Cathedral / St Mary Magdalene Church]

3D Documentation - Survey Operations
Author: Dave Birchal, CAD Room Manager at Survey Operations
Organisations involved: Survey Operations
Products used: NCTech iSTAR and ColourCloud

“Getting jobs done quickly and effectively is our priority.
We have 212 surveys on our system at present and
we are using iSTAR every week”
[Dave Birchal. CAD Room Manager]

Survey Operations is one of the UK’s leading
survey companies, with over 80 surveying
personnel in 20 surveying teams covering the
whole of the country. The company comprises

land, building, utilities, engineering and inshore/
inland hydrographic surveying departments
geared to meet the needs of design consultants
and construction professionals.
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Profile
Initial information on iSTAR was gleaned from a laser scanning forum
and, based on this, an approach was made to NCTech to provide a
demonstration of the system’s capabilities at Survey Operations’
offices in Lancashire.
Dave Birchall, CAD Room Manager at Survey Operations, comments:
“Basically, we bought an iSTAR camera on the strength of the demo.
The speed of using it on site was very impressive, as was the speed
of the processing. And it’s easy to use; you can train anyone to use it
within about two minutes.”

for a client to understand – and much easier for us to explain - what
they have got. A client may look at a point cloud and find it difficult to
understand it - and where the value of the survey is - but once you
start to add the photographic colours to it, it makes everyone’s lives
easier, the client’s and ours.”
“Getting jobs done quickly and effectively is our priority - we put
pressure on ourselves to get jobs done. We have 212 surveys on our
system at present and we are using iSTAR every week.”

“Our initial approach was to use iSTAR as a stand-alone asset without
using a laser scanner, but we have progressed to use the iSTAR and
ColourCloud, NCTech’s automatic HDR point cloud colourisation, in
conjunction with laser scanners.The outputs are superb.”
“We’ve used iSTAR a lot more than I thought we would. We do a huge
amount of historic buildings surveys and rather than spend a large
amount of time drawing every little bit of the building for clients,
costing them significant sums of money, we’ve been taking out the
images from the laser scan on the point cloud, then colouring these
using iSTAR photography and the ColourCloud software and producing
images of the historic buildings.This is much quicker for us and we
can do more jobs in the same amount of time, thereby increasing our
overall revenue.
“Happy individual clients - they’re paying less and getting the results
quicker - and increased overall turnover for us.”
“We go out to each location and laser scan internally and externally,
then we use the iSTAR imagery and import the colour from that image
on to our laser scan point cloud using ColourCloud.”

Building surveys using iSTAR
“We are doing on-going surveys at St Paul’s Cathedral and we are
using iSTAR here to help us produce full CAD drawings of parts of the
Cathedral. iSTAR is small and it’s light to carry. It’s a tricky building
to manoeuvre around and we also have to be aware of times when
people are worshipping or praying there, so making minimum
disruption is important.”
“Recently, at the Town Hall in St Albans we did laser scanning
and photography. We were on-site for about a week, but this has
produced enough output for about a month’s worth of work for four
CAD operators, producing between 40 and 50 drawings.”
“We have also been working at St Mary Magdalene Church in
Paddington, London, which is used for a lot of TV filming. They are
going to do some restoration work on the church and need to raise
funding. In order to prepare a brief of what is required we had to do
the surveying up front and then have to produce drawings in a year
or two’s time. They also wanted images out and iSTAR was brilliant
for this. Instead of drawing elevations and sections, we survey it and
extract that information for the point cloud. The images go into CAD
drawings and then the architects can draw up a brief of what they
would like to do, work out how much it is going to cost and that way
they can approach the fund raising required.”

Adding value
“iSTAR adds value into what we do on site and it is a very robust
piece of kit and it’s a lot cheaper than a laser scanner. It is also really
easy to use iSTAR and ColourCloud, and another beauty of iSTAR is
that you can use it on its own - if it’s something photographic you
need, it’s perfect. Not every job needs laser scanning. For example,
if you need to give a client a record of what they have in a building,
its condition, what’s in the individual rooms, then using the iSTAR for
360° photography is a very helpful output.”
The most useful function for us is the 360° photography and its ability
to go into ColourCloud.”
“Another positive is the support from NCTech - when we have needed
it has been very good.”

Quick capture
“You can go on site, do a quick capture with the iSTAR and then show
the client where issues lie and, when appropriate, this helps explain
the need to do a full scan survey. Then, when we do the laser scan
and use the iSTAR image and ColourCloud, it makes it much easier

Virtual Tours
“We have found it to be particularly impressive in producing virtual
tours. It’s like Google Street View but we are doing it inside buildings.
We create a map of the building and then link all the 360° images to it
and this gives a guided tour round the premises. We did not anticipate
this use when we bought the iSTAR, but we have done quite a few of
these. It originated when a client did not want to pay for a full survey
but wanted a record of his factory building, allowing it to be looked at
remotely.”
“We have since found other clients who did not want a full survey
using laser scans, CAD drawings etc. but really value the guided tour.”

NCTech greatly thanks Survey Operations www.survops.co.uk,
especially Dave Birchall for his collaboration in this Study Case.
For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – RRS Discovery / Gibraltar cave]

3D Documentation - Digital Surveys
Author: Ben Bennet, CTO Digital Surveys
Organisations involved: Digital Surveys
Products used: NCTech iSTAR and ColourCloud

“We have three different scanners each of which is
fitted with a bracket on to which we mount the
iSTAR and it works well with all of them.”
[Ben Bennet, CTO Digital Surveys]

Based in Newcastle in the UK, Digital Surveys
is a company which, over the last six years,
has transformed itself from a traditional
survey organisation into a specialist 3D laser
scanning bureau. It operates in several sectors

including oil & gas, architectural, heritage
and processing/manufacturing. The company
is 100% focused on 3D laser scanning, 3D
modelling, 3D inspections and, most recently,
visualisation and virtual reality tours.
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Profile
Ben Bennett, CTO, of Digital Surveys, explains his company’s use
of iSTAR:

much better quality results for clients to look at. There is a markedly
improved quality to the data. In the past you’d have a lot of blown out
images, the contrast would be not very good, and the image would
have a mishmash of colours. iSTAR and ColourCloud produce very
nicely balanced colours and nice colour datasets.”

“I was presenting at SPAR International in 2010 and met the NCTech
guys there. We followed them for a while, watching the evolution of
the product as it was something in which we were very interested.
We obtained an iSTAR from NCTech to trial on a couple of projects,
including mapping caves used by Neanderthal Man in Gibraltar, and
as a result of the success of these projects we purchased an iSTAR.
It’s a great addition to our other gear.
“We’ve had good support from NCTech when required. Really, the
only support we have needed was when our guys had the initial
training and, subsequently, for software updates.
“The deciding factor in buying iSTAR was the fact that we’d bought
a Surphaser scanner which has no camera functionality so, knowing
its capability, it was a ‘no-brainer’ to buy the iSTAR to go with it. The
two combine fantastically. The Surphaser is pretty much the best
scan data you can get and combined with iSTAR you get incredible
data.”

Faster workflow and scanner compatibility
“We have three different scanners each of which is fitted with a
bracket on to which we mount the iSTAR and it works well with all of
them. We have a Leica P20, a Faro Focus3D and the Surphaser. The
first two scanners have cameras built in but the quality is pretty poor
and they don’t do high-dynamic range images, and the Surphaser
has no camera. The iSTAR provides a much better quality image - high
dynamic range images - and is much faster in taking images. “Doing
a normal scan takes about five minutes and then taking photos with
an in-built camera takes about another five. If you are using the iSTAR
it takes seconds - it’s a much faster workflow on site - and the size
and portability of iSTAR makes it nice and easy to use. The speed and
ease of use is great and it does what it says - gets really nice images,
really quickly. Using ISTAR we can quote for very cost effective site
work as we are spending less time in the field.”

Automatic batching

In action - Scanning World Heritage Sites
“As one of the trials of iSTAR we scanned caves on Gibraltar as part
of a World Heritage project. Gorham’s Cave complex is one of the last
known remaining habitats of Neanderthal Man and we needed good
quality images in low light. We were about 50 metres into the cave
complex crawling on hands and knees and we just used some small
LED lights and the iSTAR images were really good.”
“We’ve found that in low light situations, where you would not
normally get any images at all with a scanner, iSTAR ones come out
great.”
“On the back of that work we got a second project, to scan the RRS
Discovery, the last traditional wooden three-masted ship to be built
in Britain, which is famous for transporting Robert Falcon Scott and
Ernest Shackleton on their first, successful journey to the Antarctic.
“We were lucky to be able to use iSTAR on two such important and
interesting projects, which really showed its capabilities.”

“iSTAR and ColourCloud are very simple and straightforward to use.
The only issue we have is with some of the different file formats - you
have to export a file in one format and then convert to another to get
it into the right format - but that is more down to the scanners than
the ColourCloud software.”

“We did a laser scan, created a model and then used the images from
the iSTAR to texture the model. We got some fantastic images that
we were able to use to produce virtual tours and panoramic tours of
the sites. We also came up with some innovative ways of using the
images to colour the models rather than a point cloud.”
“In a different sector we’ve recently done a large chemical processing
plant in Billingham.”

“One of the most useful features is the ability to batch everything
up. If you are using ColourCloud you can drop all your scans in one
folder and your images in another and it automatically batches these
up - it’s a very automated process. iSTAR and ColourCloud produce

“There were lots of changes in colour and reflective materials. We got
really nice scan data with our lasers and combined these with the
iSTAR to get a fantastic colour overlay of quite a complicated working
environment. We got a really nice data set at the end.”
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New area developing - 3D visualisation
“Recently, we’ve started building 3D models and putting these into
games engines. We’ve found we can use the iSTAR’s HDR images to
light the environments and it works really, really well. It captures the
existing conditions in ways you could not do normally. Gamification
is a growth area for training and we are producing some impressive
walk-rounds.”
“We are using Unreal Engine 4 and we can light the scenes using the
images from the iSTAR, projecting all the reflections that you would
have in the real environment into the scene. We are developing
models for health and safety training in the oil & gas sector and also
disaster management training in this industry, too, simulating oil rig
environments, for example.”
“Currently, we are developing a workflow where we are taking the
iSTAR images and painting these directly on to a 3D model using
software called MARI. It’s for texturing 3D scenes, producing great
results, and we will be using iSTAR even more in future.”

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – Alexandra Palace / Worthing Pier]

3D Documentation - Maltby Surveys
Author: Andrew. K. Maltby MRICS
Organisations involved: Maltby Surveys
Products used: NCTech iSTAR

“iSTAR was very impressive. It’s size, ease of use,
portability and image quality make it a worthy
companion for our FARO Focus Laser Scanners”
[Andrew Maltby MRICS. Director, Maltby Surveys.]

Maltby Surveys is a multidisciplinary Geomatics
company which has developed over almost 30
years as a result of responding to the spatial
data needs of its Clients. It is a family oriented
business owned and managed by three brothers.
We are Chartered Geomatics Surveyors and
one of the UKs leading companies in our field.
Richard Maltby is on the Council of Management
for the Chartered Institution of Civil Engineering
Surveyors and has been commended for his

valuable work in training and education across
the profession.
Fellow Directors Andrew and Stephen Maltby
have been instrumental in the continual
development of new technologies within the
company.
Andrew works in conjunction with RICS and RIBA
promoting a greater understanding of exactly
what the Geospatial Community can provide to
their many and varied stakeholders.
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Laser scan / iSTAR integration
– On site, HDR colour images are captured with the iSTAR. These
images can be taken before or after the laser scanning operation.
The only requirement is that they are taken from the same general
location as the scans.

– The images are stored on an SD card allowing for quick transfer to
office desktops where they are converted to 360 panoramas using
the Immersive Studio suite provided by NCTech.

– Following scan registration and webshare creation the greyscale
images collected by the scanner are supplemented with colour
iSTAR panoramas. An application developed by NCTech allows for the
seamless integration to Scene Webshare. As well as location, this
includes for re-orientation of the iSTAR images to match the
greyscale images.

Two projects were carried out using the iSTAR, one at the iconic
Alexandra Palace more affectionately known as the “Peoples Palace”
or “Ally Pally”. This was the home of the BBC for many years and is
now the recipient of Heritage Lottery Funding to restore and update
parts of the building.
Maltby Surveys were awarded the measurement contract and saw
this as the perfect opportunity to put iSTAR through its paces. We
were very impressed ! The second project was for Adur / Arun District
and involved the measurement and documentation of the Pavilion at
Worthing Pier.

The iSTAR camera operation and menu navigation were very intuitive
and well thought out. There are a variety of image settings and
means of capture not least to allow the user to be absent from
the capture process. It is possible to operate the latest iSTAR via
a wireless connection although the unit that we tested was not
equipped with this feature.
This would obviously be a useful function and allow for additional
remote operations along with timer and manually controlling which
cameras are in use at any one time. The key benefits for us were
the weight of the camera coming in at 1.4kg it really is truly portable
and with its small footprint it can go anywhere our scanners can
and lots of places it can’t. This will prove extremely useful where we
need access to additional dimensional information. The unit captures
images very rapidly and processes the exposures in real time. As
an average using HDR 3 setting which takes three exposures from
each camera the process takes approximately 20 secs. This is a huge
saving to us when we are capturing colour imagery with the Faro
Scanner as it currently takes about 2 to 3 minutes per setup and
although you can allow for different exposure settings it falls short of
the quality produced by the iSTAR.
The projects at Alexandra Palace and Worthing Pier involved the
complete range of light conditions from bright external conditions to
very dimly lit internal spaces - the resulting images were surprisingly
true to the detail and this was using full automatic settings.
Depending on the requirements of our clients the images can either
be integrated with online webshare data, stitched to the point cloud
or hosted completely independently as a photographic etour. NCTech
allow this to be hosted via their website.

Conclusion
The iSTAR is a highly effective camera, a cube, light weight, highly
portable and has many intuitive features. Maltby Surveys, is a
company at the forefront of measurement technology so any device
that can supplement our workflow and provide added value to our
clients is essential especially in today’s market.

– Webshare is hosted online but now includes high dynamic range
imagery captured with optimum exposure settings. Image overlay to
point cloud data can be achieved by matching common scan data to
iSTAR image data to create true colour mapped point cloud.
This process currently requires manual matching but we understand
developments are underway to automate this process.

With local measurement capability directly from the photography
we are keen to incorporate the iSTAR into our working processes.
For us, we see the iSTAR fitting neatly alongside our portfolio of
measurement devices. The seamless collaboration between iSTAR
and FARO in the onward development of this device is crucial. This
will ensure that we are able to continue to provide our clients with a
range of deliverables both on and off-line for mutual benefit.
For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – Collision investigation]

Law enforcement - Warwickshire Police
Author: Colin Humphreys, Forensic collision investigator
Organisations involved: Warwickshire Police
Products used: NCTech iSTAR Pulsar

“To us iSTAR was a revelation! It has become one of the
first bits of kit that comes out of the car and is
used by every member of the team”
[Colin Humphreys, Forensic collision investigator]

This unit is manned by five police officers who
cover the department 24/7, 365 days a year.
Our role is to investigate fatal, serious and life
changing road traffic collisions.
We have an array of equipment at our disposal,
which enables the unit to operate in a selfsufficient manner when out at an incident.
Unlike many other areas of policing, we only
‘get one go’ at an RTC scene, before it is cleared
up and traffic allowed to flow.
Our core role out in the field, is to gather and

document physical evidence found at the scene.
This is done in a methodical manner and time is
a factor. Road closures cost British Industry a lot
of money.
A motorway closure can cost £1 million an hour.
We are continually under pressure to ‘get in and
out’ in as short a time as possible. In order to
achieve this we use industry standard surveying
equipment, digital cameras, emergency lighting
and we carry two of everything. Space, size and
weight is at a premium.
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iSTAR in the field

3 - Place the ISTAR inside the vehicle and have a drivers view or
capture the interior damage safely.

To us iSTAR was a revelation! It has become one of the first bits of kit
that comes out of the car and is used by every member of the team.
Why? Ease of use. Its small and will fit easily into the car, the unit is
rugged and I can testify that it can be dropped from 3’ onto tarmac,
bounce and still operate flawlessly.
The first thing that strikes users is it’s small form factor but instantly
you can tell it’s a quality product. A huge amount of thought has been
incorporated into the build quality and design. It comes securely
packed in the smallest Peli case.
Not every incident requires a full survey. Sometimes it’s ‘images only’
and although an image is good at depicting a scene, it takes many to
make up a whole picture. In fact the iSTAR can be used anywhere in all
conditions, in all environments, in all light conditions with minimum
user input giving high quality output.

4 - Finally another walk through the scene, this time, clear of other
vehicles and personnel.

When we are faced with that scenario, the iSTAR is generally put to
good use.
Several shots from various positions takes a fraction of the time of a
survey but the detail collected by the unit is extremely valuable. On
average, our data shows that a scanner potentially saves upto an
hour on a detailed survey situation.
iSTAR would take around 15mins to cover the scene, potentially
45mins saved.

Our workflow - Collision investigation
1 - Arrive at the scene, set up a take a series of images progressing
through the scene whilst other services are still present.

Crime scenes
Most people have seen the ‘Estate Agents’ online property views
showing 360 views room by room. Imagine that’s a crime scene, a
burglaryor serious assault. It’s human nature (police and detectives
are no different) to want to have a look. But realistically that’s not
possible or is it? I recently covered an eight room house plus the
outside front & rear in under 40mins for CID.
Give an iSTAR unit to a Scenes of Crime Officer (SOCO) as part of their
kit. One set up in each room or area; one detailed 360 image taken in
seconds. Pass the SD card or USB to someone outside with a laptop
and within minutes important personnel can look around and get
a real feel for the scene. More importantly, directions could then be
given to the SOCO, as to particular areas of interest.
With scenes marked up with SOCO tags and markers a similar
methodology can is followed. The iSTAR is used for a second time,
using a fresh SD card/USB stick to capture the placed indicators,
giving another digital record that can now be cross referenced with
detailed close-up camera stills. Back in the office, the captured iSTAR
data can now be viewed or screen projected to a wider audience for
intelligence or briefing purposes.

2 - Identify marks and features. Use the iSTAR at various levels
including on the road surface.

Conclusion
Fantastic. The iSTAR is a highly original camera, a cube.....packed full
of features, so many in fact you naturally think it will be complicated
but with a little practice it is so simple to use! We could now capture
the scene in detail and have it in full colour. Evidentially, iSTAR can be
the first on the scene. What better evidence to present to Judge and
jury?
I don’t think the iSTAR’s strengths in the forensic field is soley all down
to time saving though. Everyone wants things done in record time,
it is more about the quality of detailed evidence it gathers and it’s
simplicity for the user in the field.
For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – Collision and criminal investigation]

Law enforcement - Derbyshire Police
Author: Paul Moorcroft, Forensinc collision investigator
Organisations involved: Derbyshire Police
Products used: NCTech iSTAR & ColourCloud

“This, for me, is ground-breaking and something we could
never have imagined would make our crime or accident
scene reporting so detailed”
[Paul Moorcroft. Forensic investigator collision]

Derbyshire Police operates a Collision Investigation
Unit with specialist scene investigators and vehicle
examiners who attend the aftermath of serious
and fatal road traffic accidents. The unit comprises
six forensic collision investigators, six detective

constable investigators, three sergeants and two
vehicle examiners. This unit works on a 24 hours,
7 day basis, split into a rotating three shift basis
with five staff members working within unit at any
given time.
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Profile
Paul Moorcroft is one of the forensic collision investigator team
and the officer who makes regular use of iSTAR®, a fully automatic
instant 360 degree panoramic camera which greatly enhances
the work carried out by Collision Investigation team to effect the
comprehensive management of a serious and fatal road traffic
incident scene within constabulary area.

Analysing major incident investigations
In 2013, road casualty figures in Derbyshire accounted for 24 people
killed, 278 people badly hurt and just over 2000 people slightly hurt.,
The Collision Investigation Unit has made extensive use of its iSTAR
360 degree panoramic camera effect to capture the scenes of major
incidents and help the forensic teams analyse and report on every
situation where a detailed examination of the facts leading up to and
following a serious or fatal accident can be scrutinised.
The Collision Investigation Unit took delivery of iSTAR which the
Derbyshire Police Department for Transport purchased along with a
Leica C10 scanner, and these almost immediately transformed the
Collision Investigation Unit’s ability to capture true 360 degree images
of an accident scene.
Paul Moorcroft takes up the story:
“iSTAR has completely transformed our workload. Until we started
using it, we spent time stitching together a significant number of
photos from a road traffic accident scene. We still use traditional
DSLR cameras, but the iSTAR panoramic images give us a whole new
perspective on a scene situation.”
“If we had an iSTAR sooner than we did, there were instances where
we would have been able to detail collisions involving pedestrians in
terms of where blind spot areas on vehicles had a role to play in the
accident. This is not to say it would have done something we couldn’t
already do, but it would have greatly assisted, certainly in terms of
the viewpoints of pedestrians or witnesses.”
“We are now able to locate the iSTAR where people were, or said they
were, and give a view of what they would be able to see.”
“iSTAR is much more effective because you get a full perspective
of where the vehicle would have been and that, to us, is worth its
weight in gold in a lot of situations.”

From road traffic accidents to crime
scene investigations
In addition to capturing images at serious road traffic incidents,
Derbyshire Police forensic collision investigators now take iSTAR into
crime scene investigations.
Derbyshire Police’s senior investigation officers have seen the results
produced by their colleagues in the Collision Investigation Unit using
iSTAR and have now tasked the forensic collision investigator team to
capture images of murder and serious assault criminal investigation
scenes.
Paul Moorcroft again:
“For both serious criminal investigation and road traffic situations,
we are continually thinking on how best to capture these scenes
more effectively. We know we have panoramic capture available and
now with the added enhancement of iSTAR’s ColourCloud point cloud
colourisation software technology, we are able to place the iSTAR
camera under vehicles to capture a scene whereby a collision may
have involved a pedestrian or cyclist being trapped under a vehicle.
iSTAR allows us to fully capture a panoramic image of the under-body
of a vehicle.”

“This, for me, is ground-breaking and something we could never
have imagined would make our crime or accident scene reporting
so detailed. My colleagues and I are just amazed by that and it has
opened up a whole new thought process for us as well.”
“When the unit receive a call to attend a road traffic scene, they
are unhampered by carrying a large scanner and other weighty
equipment to do their imaging work. At the incident, iSTAR is mounted
onto a normal camera or survey tripod. iSTAR is lightweight and after
a couple of minutes of the booting up process, and with a simple
press of button, a full 360 degree is captured in exceptional detail.”
Paul and his team can simply walk the length of an accident scene
and within ten minutes will have the entire scene captured – all from
an easy to handle, robust camera which uses automatic exposure.
Its speed of operation makes the team’s job much easier, delivering
impressive results and a completely realistic simulation of the
incident scene.
He comments:
“Being able to capture images in low light or at night time is, again,
something which we never thought possible and the results are
pretty amazing. Before iSTAR we would use a standard Digital SLR
camera and would be effectively ‘painting the scene’ by using a flash
with long exposure, but we’re simply able to change the settings on
iSTAR and capture the shots we need. The end result provides us with
an image full of colour and captures every detail we need from within
the scene we are faced with. Of all iSTAR’s attributes, this for me is the
most impressive.”

Firearms training officers impressed
with iSTAR
As already stated, Derbyshire Police has used iSTAR in many road
accident and crime scene incidents, and more recently, it was
demonstrated to senior officers involved in a firearms training
exercise. This enabled Paul Moorcroft to show the extent of iSTAR’s
capability when he captured several panoramic images of the
firearms training, stitching them together using a virtual tour
software called Pano2VR and presented the images to senior force
officers.
As he said, they are the decision makers – the officers called upon
to make effective management decisions at the scenes of serious
incidents and they have all been very impressed with the ability of
iSTAR to capture every small detail.
NCTech, as we have seen with the recent integration of the new
ColourCloud point cloud colourisation software, is continually looking
at ways of pushing the technological boundaries of its iSTAR camera.
Research and development sit at the heart of its operation and the
company has listened to its customers about adopting a number of
product enhancements. It has recently specified an LED flashing light
which accompanies the internal audible beep, which alert users when
the camera is in the process of capturing images.
This enhancement will delight Paul who had expressed a wish to see
a flashing LED when iSTAR is taking images. He adds: “iSTAR has only
had the bleep when our team worked at a roadside, which means
you cannot hear this so well when you have so much background
traffic noise to contend with.
This meant that there was often an element of guesswork as to
when the photo capturing was finished. I find it reassuring that, with
this new LED visual element, NCTech listens to its customers and
is happy to take on board suggestions to make iSTAR unrivalled in
helping transform the whole approach to ‘on the ground’ incident
management for Derbyshire Police.”

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – Inspection and Content management]

Visualising Enviroments - Plowman Craven
Author: Marta Wren, Technical Specialist at Plowman Craven
Organisations involved: Plowman Craven
Products used: NCTech iSTAR & SiteSurveyor

“NCTech makes my job easier. It also allows interactions
on site with the device through the Site Surveyor application
which reduces the time needed for presentation preparation”
[Marta Wren, Technical Specialist]

Ph: Plowman Craven

Plowman Craven, in Harpenden, Hertfordshire, is
one of the largest measurement survey companies
in the UK. It specialises in providing laser scanning
and measuring data services to both public and
private sectors. Its operations are worldwide
and has built its significant reputation on a raft of

projects ranging from Middle Eastern palaces to
North African communication schemes and from
some of the UK and Europe’s major re-development
programmes, prestigious property portfolios,
national heritage measurement projects, existing
and new-build shopping centres.
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Profile

Integration a key factor

Marta Wren is a technical specialist at Plowman Craven. Her role
involves the implementation of new projects and workflows, staff
training and research into new, dynamic ways of deploying laser
scanning, photography and photogrammetry techniques.
iSTAR has become an integral part within this workflow activity and
under Marta’s management, it has helped to streamline workflow in
Plowman Craven’s in-field operations.

Marta values iSTAR’s automatic stitching without the need for manual
intervention which integrates with SiteSurveyor and the fact iSTAR
has complete automatic exposure settings with HDR is particularly
impressive to her and her team. She adds:
“All my colleagues who have used iSTAR have found the output quality
excellent for all the work we undertake and moreover, our nontechnical staff are amazed how easy it is to use.“

Real-time demonstration
Marta and her team were initially looking for a solution alternative
to its manual 360 degree panoramic camera system and initially
came across NCTech’s ISTAR 360 degree panoramic camera through
carrying out some intensive research. She was instantly impressed
with the simplicity of use, coupled with its exceptional automation
capability, as she explains:
“Before iSTAR, we would use a manual nodal ninja system and
DSLR camera. Capture would involve manual rotation of the camera
to capture 360 panorama and capturing each of the directions in
multiple exposures. Post-processing would involve stitching of all
photos in one panorama which would be mainly automatic with some
exceptions. One key problem area for us was stitching.”
“The nature of some objects we were capturing, such as featureless,
plain walls did not give us adequate common point detection, but the
automatic stitching process within iSTAR overcomes this.”
“This, and the easiness of implementation amongst many users
across our company due to the simplicity of the device and software,
makes iSTAR an exceptionally good, robust device for us. We have
around 40 surveyors and technicians who use iSTAR and who need
to operate an effective system for 360 photography capture. They all
have varying levels of photographic background and experience, but
it took far less time to train them to use iSTAR and it’s efficient from
the first day of use.”
Plowman Craven is using iSTAR for visualising environments,
inspection, supporting CAD and modelling.
Occasionally, Marta and her team will use iSTAR for point cloud
colouring but to fully implement that across the board, she believes
she will need much smoother workflows via a direct integration with
a destination software for scan data post-processing. She cites ease
of use, quicker capture and an ability to connect to an application
which allows indoor positioning as distinct advantages for her
workflow management using iSTAR.
“NCTech makes my job easier it terms of the time I need to train
staff. Equally, It makes our surveyors job easier by removing time
needed for fixing panoramas which were stitched incorrectly with
the previous systems used. It also allows interactions on site with the
device through the Site Surveyor application which reduces the time
needed for presentation preparation.”

Excellent after sales and technical support
And what of the Edinburgh - based company? Have Plowman Craven
been pleased with the after-sales and technical support?
“We have been delighted with NCTech’s entire approach to working
with us. Their response to any issues we have has been immediate.
We had a small incident with an RTC battery which died and needed
replacing.”
“As we struggled to do it ourselves, we sent the unit back to
Edinburgh and the turnaround time was minimal. We also had a
screen replaced on one of the units but it was done within one day
excluding shipping so the impact on unit productivity was minimal.
It’s a first class technical support service from NCTech.”, says Marta.
Fulsome praise and an honest appraisal which underlines why iSTAR
is best of class in its field.
NCTech greatly thanks Plowman Craven www.plowmancraven.co.uk,
especially Marta Wren for her collaboration in this Study Case.

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com

NCTech Ltd 1 Boroughloch Square, Edinburgh, EH8 9NJ, UK
T: +44 131 202 6258 - www.nctechimaging.com

107

[Case Study – Topcon GLS-2000 scan colourisation]

3D Documentation - TerraDat
Author: Nick Rusill, Co-founder and Managing Director at TerraDat
Organisations involved: TerraDat
Products used: NCTech iSTAR & ColourCloud

“We use the iSTAR every other day - we’ve always got
scanning jobs on - and it always goes out on them…
it’s such a useful and quick tool for getting
a representation of what’s there”
[Nick Rusill, Co-founder and Managing Director at TerraDat]

TerraDat is a specialist geophysical and geomatic
mapping company, established in 1992, which is
based in the UK and has subsidiary offices in Italy
and Australia. The core business is sub-surface
geomapping using non-destructive techniques
(which do not involve cameras) but the company has
expanded significantly into other surveying areas
where high resolution reality capture, including
photographic imagery, is integral.

Examples
are,
BIM
(Building
Information
Management) and terrestrial laser scanning, which
includes forensic work - both training and support on crime scenes and mapping large scale disaster
scenes where rapid collection of accurate datasets
is essential. Other significant activity is structural
monitoring, coastal erosion studies for local
authorities, architectural visualisation work and
digital preservation of heritage structures.
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Profile
Company co-founder Nick Russill first learned about iSTAR from
the Laser Scanning Forum a couple of years ago. He followed the
camera’s development because he considered the optical imaging
ability of many terrestrial scanners was far from optimal, especially
in challenging lighting or busy urban sites.
When NCTech released the ColourCloud software that enables users
to apply the imagery from the iSTAR to any point cloud from a scanner
he decided to purchase one of these cameras.
“We were seeking a unique selling point to enhance our deliverables.
The panoramas and better colouring and automated workflow from
iSTAR were obvious reasons for the purchase.
Another reason was that, with the exception of a couple, much of
the scanning hardware we use does not have very good onboard
cameras. For example, if you are out in the street and the sun is
shining you can have over-exposed highlights and under-exposed
shadows and the overall result is not very satisfactory.”

“The laser scanner we use is a Topcon GLS-2000 and we are the first
company to use this in conjunction with iSTAR. As such, we’ve had
to tread the pioneering ground in terms of the workflow, getting the
compatibility of the scan files to go into the iSTAR software, so it was
a bit of a steep learning curve but now we’ve got it sussed.”
“The better quality imagery means we do not have to consider
reacquiring imagery if it’s below standard. We can work in a greater
range of light - it works better at dusk and in low light conditions than
do scanners where you might well get more ‘noise’ in an onboard
camera.”
“The functionality of the high dynamic range acquisition and the batch
processing of that data is impressive - you can pretty much leave it
and forget about it and then come back and it’s all done. The price is
pretty reasonable, and it does save us money in terms of speeding
up our workflow on site. We can get more scans per hour as a result
of not having to wait for the onboard camera and that means we
can do more jobs over a given period and clients gain as our charges
reflect reduced time on site. Our clients, and my colleagues, have all
been extremely impressed with the iSTAR’s outputs.”

Controlling Imagery Capture
“Furthermore, terrestrial scanners acquire their imagery as part of
an automated acquisition cycle, so you have little control over when
you are capturing the images, and if something happens like a bus
stopping in front of the scanner for 30 seconds, the images will be
useless for colouring the data in that part of the scan. However, with
iSTAR you can choose your moment to rapidly acquire the image
and it gives a much better range and truer representation of what is
actually there.”
“Prior to having iSTAR we did have instances of working on heritage
buildings using laser scanners where the visual imagery of the target
was as important as the point cloud measurements, and if the scan
cameras did not give a good result we had to resort to external
imagery using a digital SLR camera. It means a lot of additional postprocessing work to colour the points from the external imagery.”
“And our final reason for buying iSTAR was to be efficient on a large
project examining the condition of defences against coastal erosion
where our time per station was reduced by around two minutes.”

Working Closely with NCTech
“It’s one thing to design a good a bit of kit in a workshop and try and
cater for all the possible applications but we like to think that the
feedback from dedicated users like ourselves in specific markets is
pretty invaluable. This is something we have been doing with NCTech
and we find they value the feedback and are extremely supportive if
we have any questions that crop up during field use. For example, my
guys on site found that the rubber cover for the door on the memory
card can be pushed in the wrong place which ejects the card.”
“The facility to trigger the camera from a mobile smartphone is very
handy because you can get out of the way and not be in the picture
yourself. You can hide behind a rock when taking shots on a beach,
but the mobile interface is a bit ‘clunky’ and takes a bit longer than
pressing the button manually on the iSTAR. I fed that back to NCTech
and they are working on an App that tells the user more about what
is happening so you don’t waste time waiting to make sure the
camera has finished taking its shot.”
“We are also talking to them about the ability to manually assign
a name of a picture. At present iSTAR uses a date and time stamp
system. Going back to the office with hundreds of scans to match up
with the correct image is challenging - it means your note taking has
to be extremely rigorous.

Using iSTAR with Topcon GLS-2000
“It’s been particularly good on coastal sites which are difficult places
to get accurate exposure settings for a picture to cover the full 360
degrees of the scene using just one exposure. You can have cliffs that
might be a dark coloured rock and perhaps sunny skies which are
very, very bright and everything else in between. Having the iSTAR’s
high dynamic range means we can capture everything - nothing is left
over or underexposed - and the most important feature is the ease
and the ability to integrate the imagery with our point cloud data.”

An option to let us put in ‘Station 1’, or ‘S1’, ‘S2’ etc. as the title of
each image would mean matching it up with the correct scan would
be much simpler. When doing a lot of scans - say, 20 scans in a row
along a beach - we use a USB GPS that NCTech recommended and
this is a very useful backup for determining the position of where the
image was taken.”
“The most obvious advantage of iSTAR compared to the scanners
is the time saved. The onboard cameras in the laser scanners take
between two and six minutes to acquire the imagery, whereas with
iSTAR it’s less than 30 seconds.
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Another advantage is that you can choose when you want to take
the image. It’s robust, no problems, stands up well to the rigors of
fieldwork and is simple to use, although we have been using an
external battery as we are acquiring up to 100 images a day, so we
carry that about with us. We also had to make our own brackets to
get it to be compatible with the laser scanner geometry and sit at the
right height on the same tripod.”

iSTAR Versatility Assists Working In
Different Environments

“The iSTAR imagery can be invaluable for internal work on buildings.
We do a lot of BIM projects. For example, we work with local
authorities on refurbishment of schools and other public buildings,
so the start point for modelling is to have an accurate point cloud of
the structure. To have high definition imagery to go with that is really
important as that has always been a bit of weak link. Using iSTAR has
given us an advantage, both in terms of time and the quality of our
deliverable.”
NCTech greatly thanks TerraDat www.terradat.co.uk, especially Nick
Rusill for his collaboration in this Study Case.

“We work on a wide range of projects all the time in contrasting
settings. For example, we have been involved in an extensive urban
planning project around Cardiff Bay. We have acquired laser scan
data of this area and then supplemented it with the imagery from the
iSTAR. We then went on to prepare a 3D model that can be used as a
basis for future visualisations for proposed and planned buildings.”
“As mentioned, we do a lot of work in coastal environments, including
monitoring the condition of cliffs. It’s one thing having just an
accurate point cloud but to actually have a good quality visual record
of the cliffs at that time can be really useful, both in terms of colouring
the point cloud and also to give our clients that additional deliverable
of the online panorama where they can visually explore the entire
site. It helps give them a context and it helps to understand, for
example, different rock colours which may be due to varying types of
weathering and indicative of potential failure of the rock face.”

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – Real Estate Photography]

Virtual Tours - Jim Sharp Photography
Author: Jim Sharp
Organisations involved: Jim Sharp Photography
Products used: NCTech iris360

“The HDR quality is a pre-requisite for the real estate
sector, so it’s amazing to be able to capture such high
quality images so quickly”
[Jim Sharp, Jim Sharp Photography ]

Jim Sharp Photography is a Florida-based
company, specialising in high-end real estate
photography. Business owner, Jim Sharp, has

earned a reputation for delivering high quality
images of the interiors and exteriors of some of
Florida’s most valuable properties.
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Many real estate firms now view 360-degree images as an important
aspect of their online marketing of properties.
“In recent years I had started to receive a lot of enquiries as to
whether I could also deliver 360 degree panoramic images,” recalls
Sharp. “But I didn’t have the time or resources to be able to take
panoramic images using an SLR set up – especially with all the
stitching and editing required post-capture.”
Then, in 2015, Sharp heard about the launch of the iris360, a new
panoramic camera developed by NCTech. Remote-controlled by a
mobile phone or tablet, the iris360 quickly captures high-resolution
360 degree images from its four sensors.

With zero setup time, iris360 does not require photographic
experience to operate and, with one touch, captures and delivers
a huge 8K resolution, HDR panoramic image in less than two
minutes. iris360 is small and lightweight, making it easy to transport
and deploy, and is designed for use in both indoor and outdoor
environments.

Sharp received his new camera in early 2016 and hasn’t looked back.
“It’s exactly what I need – and so easy to use with its point-and-click
interface,” said Sharp. “The HDR quality is a pre-requisite for the real
estate sector, so it’s amazing to be able to capture such high quality
images so quickly. The speed of processing is also fantastic because
it means that I can show my customers an on-screen preview of the
image while I’m on-site!”
Sharp is just at the beginning of the 360 imaging component of his
business, but will be looking to expand that quickly. See some of his
initial images at www.mevotour.com.

For further information about iris360 or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – Architecture Documentation]

Preserving Edwardian architecture using 360º imaging
Author: Andy Roberts, Managing Director, Formby Surveys
Organisations involved: Formby Surveys
Products used: NCTech iSTAR and ColourCloud

“At Formby Surveys, we have been using the iSTAR
360 degree imaging for a couple of years to help with
maximising our time when surveying a site.
Whether we need to survey every room in a hotel, or
an architecturally significant site such as One Great
George Street; the iSTAR helps reduce our field times and
improves the quality of product to our client”
[Andy Roberts, Managing Director, Formby Surveys ]

Formby Surveys Ltd is a specialist in high-tech
precision measurement solutions, providing a
variety of professional sectors with land, property
and specialist surveying services.

Its dedicated and motivated team utilise the latest
technology and instrumentation in conjunction
with a complete ‘field to finish’ quality assurance
procedure.
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Project Profile
During the summer of 2015, under contract to international built asset
consultancy Arcadis NV, Formby Surveys delivered a new set of asbuilt drawings of the Institute of Civil Engineers (ICE) headquarters at
One Great George Street in London’s Borough of Westminster.
These as-built drawings were completed prior to embarking upon an
upcoming renovation of this famous and architecturally significant
building.

Improvements to One Great George Street
One Great George Street is a Grade II listed Edwardian building
situated close to Westminster Abbey, the Houses of Parliament,
Buckingham Palace and St James’ Park. Inside, it houses a range of
function rooms that host events ranging from conferences, through
to weddings and gala dinners; together with the great hall and the
ICE’s library.
One Great George Street holds special interest as a four-domed
building that is also one of the earliest examples of steel frame
construction. Its internal style has been described as a “modern
rendering of the late Renaissance”.
Portland stone is used extensively and many of the rooms are
ornately decorated with French walnut and oak panelling, carved
plaster ceilings and elaborate crystal chandeliers.
Announced in September 2015, the renovation of the building in 2016
will undergo a series of works designed to further improve facilities
for visitors, increase energy efficiency and improve accessibility.
As part of the ICE’s “Shaping the World” initiative, a state-of-the-art
interactive Knowledge Centre and exhibition space will be created in
the ICE’s main library and a new member’s lounge will be created in
the upper library.

Applying the latest imaging technologies
to precisely deliver as-built drawings

Given the significance of the building’s domed architecture and neoclassical designed ceilings, the surveying firm also returned a set
of vertical elevations and roof survey in One Great George Street’s
Library and Great Hall that included providing reflected ceiling plans of
rooms that are due to undergo renovation work.
The reflected ceiling plan shows a view of the room as if looking from
above, at an imaginary mirror installed one foot below the ceiling
level which shows the reflected image of that ceiling.
On this project Formby Surveys used multiple laser scanning
systems coupled with traditional survey techniques to collect the
data necessary for accurate dimensioning and drafting of the as-built
drawings.
The laser scanning systems used by the firm collect 1,000,000 3D
survey points per second, all to millimetre accuracy, from a sequence
of survey positions throughout the building.
To best capture the ornate nature of One Great George Street’s rooms
though meant that high definition photographic imagery was also of
great assistance to Formby Surveys’ drafting teams to interpret the
site’s structures.

Providing an immersive view to the
drafting process
To capture photographic imagery of the site, Formby Surveys
deployed its NCTech iSTAR 360 degree imaging camera.
Designed for rapid 360 degree imaging, the iSTAR precisely captures
full spherical immersive images for efficient visual documentation of
the environment.
Formby Surveys has been using the iSTAR 360 degree imaging for a
couple of years to help with maximising time when surveying a site.
Whether it needs to survey every room in a hotel, or an architecturally
significant site such as One Great George Street; the iSTAR helps
reduce time on-site and improves the quality of the firm’s product to
its clients.

To form the basis of plans to improve One Great George Street,
Formby Surveys delivered to Arcadis an as-built drawing set of floor
plans for each of One Great George Street’s rooms.

Figure 1: iSTAR 360º panoramic camera image of Great Hall
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A seamless high resolution image of the surrounding walls, all the
way up to the ceiling directly above the camera, was captured from
each camera position.
In the context of compiling internal elevations and reflected ceiling
plans, this enabled ornate in-room features to be better interpreted in
the drafting process.
While laser scanning captures precise 3D survey data of a room,
undertaking a full spherical capture of the scene, using the automatic
high dynamic range capabilities of the iSTAR camera, provided clarity
to the Formby Surveys team who needed to interpret each room’s
intricate and domed ceiling features.

The value of 360º imaging
Designers and decision-makers intuitively know how to interpret
photographs, and will often prefer to interpret a photograph ahead of
other technical information, such as design drawings when assessing
existing site conditions.
The iSTAR camera provided a fast and systematic method of capturing
high resolution panoramic imagery through the rooms that are due to
undergo renovation at One Great George Street.
Through deploying this specialist 360º camera in the survey process,
Formby Surveys was able to provide a better product, especially of
roof and ceiling detail.
Not only does this imagery provide a precise time-stamped record
of this historic environment before work is undertaken, the dataset
enables teams to interactively ‘walk through’ these rooms to assess
the impact of their decisions, all from the convenience of their
desktops.
For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com

Figure 2: High definition colourised point-cloud providing contextual
definition for production of reflective ceiling plans of the Great Hall
Formby Surveys compiled these panoramic images into an immersive
virtual tour, and used the same iSTAR data to colourise the terrestrial
laser scanning data using the iSTAR’s ColourCloud utility.
From these datasets, the Formby team were able to deliver the
necessary plan and elevation drawings for the site.
Through incorporating immersive imagery from the iSTAR into its
survey activities, Formby Surveys was able to undertake further
quality checks against the plans and elevations that it was producing,
and consequently return a better product to its customer, Arcadis NV.

Figure 3 (Top): 360º photographic image of ceiling in Great Hall;
(Bottom): Final Reflective Ceiling Plan for the Great Hall, drafted to
depict the intricacy of the mouldings, fixtures and fittings

Published in POINT OF BEGINNING 1st April 2017
http://www.pobonline.com/articles/100831-d-helps-preserve-edwardian-architecture
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[Case Study – 3D Documentation]

Capturing Oversley Castle development in 360 degrees
Organisations involved: Ruxton Surveys
Products used: NCTech iSTAR

Ruxton Surveys saves 30% on scanning time and expands
project scope using iSTAR 360 degree imaging

Located near Wixford in picturesque rural Warwickshire, the site of
Oversley Castle has views across seven counties and has attracted
settlements throughout history. The castle and the buildings in its 65
acres of grounds are being converted into a collection of 14 individual
luxury homes which are already up for sale.
Over two years were spent on design and planning work, and in
2015 a team of master builders and craftsmen embarked upon the

transformation of Oversley Castle and the properties in its grounds
into 14 unique luxury homes ideal for 21st century living, yet retaining
the original features.
Warwickshire-based property developers, Farm Page Limited, are
behind the historic conversion and appointed Ruxton Surveys to
provide the extensive surveying services required to complete the
ambitious project.
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Ruxton Surveys is a family practice established in 1987, specialising
in topographical surveys, measured building surveys, area surveys
and 3D surveys. The firm has successfully completed in excess of
3000 surveys across the United Kingdom, from Jersey to Aberdeen
and Tenby to Dover, with a reputation for being accurate, reliable and
flexible among its loyal and diverse client base.
Surveyor Ben Ruxton has been working on the site since the project
began.
“We did our first topographical survey in 2012 and in more recent
months we have documented the site using the Faro X130 laser
scanner,” said Ruxton. “There are two aims to laser scanning,
the first is to generate all of the measurements in 3D but also to
document the site for visualisation purposes.”
For projects like the Oversley Castle redevelopment, visualisation
is an increasingly important part of the surveying process, both for
demonstrating progress to investors and prospective purchasers,
and to support ongoing work with architects and other parties
involved in the development.
“In order to secure planning for additional developments, the
process is greatly assisted by visualisation, as it can be hard
for people to imagine what plans will actually look like without a
strong visual component,” said Ruxton. “Using modern surveying
technology, combined with the building models created by
architects, it’s possible to create a highly visual, augmented reality
environment to show a plan.”
Laser scanning a complete site like Oversley Castle is a thorough
and time-consuming task, requiring approximately 500 scans
to capture all of the external site data. Each scan took between
three and five minutes, and then required using the Faro scanner’s
built-in digital camera to collect the visual colour data, which took a
further three minutes.
“It took approximately 50 hours to scan and photograph the
entire site using the Faro scanner and camera,” said Ruxton. “In
this business, time is everything, and we are always looking
for ways to reduce how long we have to spend on site doing the
documentation. That’s what led us to iSTAR.”

Enter iSTAR
Ruxton Surveys decided to try using NCTech’s iSTAR – the world’s
highest resolution, fully automatic, 360-degree HDR camera.
Machined from solid metal for robustness and accuracy, iSTAR
precisely captures full spherical immersive images and high
resolution panoramic data streams for fast, efficient visual
documentation of almost any environment.
iSTAR uses four pre-calibrated camera sensors, fully synchronised
to deliver a highly accurate 50MP spherical image with excellent
high dynamic range (HDR). The camera is fast, with typical capture
times averaging around 10 to 20 seconds for a five-exposure HDR
image.

Saving time, improving quality
The difference was immediately noticeable on-site at Oversley
Castle. Instead of using the Faro scanner’s built-in camera, the team
simply replaced the scanner with the iSTAR after each scan and
took a single 360-degree image.
“The whole process with iSTAR takes less than a minute per scan to
capture a perfect image,” said Ruxton. “So we estimate that iSTAR is
saving us more than 30% in our total scanning time.”
But the time-saving is not the only benefit that iSTAR delivered.
“Working with iSTAR has also made a huge difference to the quality
of the images and colour data that we are collecting,” said Ruxton.
“The exposure setting limitations of the camera on the scanner
means that lighting conditions are much more consistent with
iSTAR. Ultimately, the contrast is much better, providing a superior
output when it comes to colourisation of the scans.”

Reliability is key
The iSTAR camera’s rugged reliability is designed to deliver
consistently good results, time after time. This holds particular
significance for firms like Ruxton Surveys.
“We’re an industry that needs things to work, which is why we still
walk around with tape measures – that’s the level of reliability we
expect,” said Ruxton. “iSTAR does exactly what it says on the tin
and it works every time.”

Next steps
As the Oversley Castle project moves forward, Ruxton Surveys
will be expanding the scope of its surveying to include the internal
details of the buildings on the site.
“This project is challenging us to do more with the technology that
is available to us, and a lot of our inspiration actually came from
using iSTAR, which made us realise how quickly we can gather high
quality 360 degree colour imagery of a site,” said Ruxton.
“We’ve been using the NCTech Colourisation Plugin for FARO Scene
to colourise the point cloud, but we are also looking to use the 360
imagery to support the building of virtual-tour type capabilities but
with added interactive enhancements such as details on the kind of
timber being used in a specific area and so on.”
“While there are a few solutions available that allow people to
navigate around a point cloud, we find them to be needlessly
clunky and complex. Thanks to the popularity of apps like Google
Street View, people are very familiar with navigating through
photospheres, so it makes much more sense to use a product like
iSTAR to collect that data. Plus it’s also much faster!”

“As soon as we got iSTAR, we realised the benefits it could deliver
to our business – a real testament to the product’s ease of use and
reliability,” said Ruxton. “The Oversley Castle project was the first
time we used it and it worked like a charm. The interface is very
simple to use and we were up and running in no time at all.”
“It’s so important to have equipment that is easy to use. There are
so many new products and technologies that are supposed to save
time and money, but it can be prohibitively expensive in terms of
the time required to get up to speed on using them.”

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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[Case Study – Construction Documentation]

Using 360-degree imagery to document the
construction of the TACC (Teck Acute Care Centre)
Organisations involved: Underhill Geomatics, Affinity Partnerships, CHW Design-Build
Products used: NCTech iSTAR

“Using the iSTAR 360 imaging system has been critical to
providing foresight to data management considerations
over the complete lifecycle of this project. Using such an
efficient and consistent method of image documentation,
means that we are sure to deliver within both an accurate
and competitive cost-structure for our customer.”
Chris El-Araj, Principal, Underhill Geomatics Ltd.

Background and customer requirements
In early 2014, the Affinity Partnerships consortium, and the CHW
Design-Build GP, a partnership with Balfour Beatty Construction and
Ledcor was selected to build and operate the new Teck Acute Care
Centre (TACC), housing facilities for both the BC Children’s Hospital

and the BC Women’s Hospital + Health Centre in Vancouver, British
Columbia, Canada. This is a $350 million redevelopment project of
a 59,400 m2 (640,000 ft2) facility that is due to open towards the
end of 2017.
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It is now standard practice that construction sites are
photographed on a regular basis.
Photographs provide an information source on current site
conditions that can be understood by everyone on the project.

Documenting the Teck Acute Care Centre
throughout construction using
360-degree photography

It is common-place for photographs to be used as a communication
method of as-built condition, progress and items of risk between
teams. Furthermore, digital photographs provide a data source that
is automatically time-stamped, and so can provide an auditable
record of progress.
On institutional builds, photographs are taken:

•

To meet contract compliance responsibilities,

•

for progress reporting to an asset owner,

•
•

to fulfill the requirements of a local jurisdiction
(for example, fire safety),
or as evidence to assist with any future claims processes.

To fulfill these requirements on the TACC contract, Balfour Beatty
Construction and Ledcor sought a supplier of inspection-grade
digital photography that is captured straight after each phase of
the build, indexed in terms of both time and location; and serviced
online to members across the consortium.
Specifically, photographs are taken of the inside of every interior
wall, ceiling and floor. In terms of phases, a set of images has been
taken before laying any concrete floor slabs.
Following this, the installation of mechanical, electrical and
plumbing systems is documented through the capture of an image
set in each room prior to, and then post, the dry-wall boarding of
each room.
The resultant photographic database, then provides a photographic
record of the site pre-construction and post-inspection.
Balfour Beatty Construction and Ledcor envisage that this database
would be updated on at least a monthly basis.

Vancouver-based professional land surveying firm, Underhill
Geomatics Inc., were successful in winning this contract to supply
this photographic documentation service to Balfour Beatty
Construction and Ledcor on the TACC project.
To provide seamless and overlapping imagery data, Underhill
deploy multiple high resolution 360-degree cameras, NCTech’s
iSTAR. NCTech design and manufacture 360-degree camera
systems that can be used repeatedly, accurately, consistently
by anyone anywhere. With a single-button operation, the iSTAR
automatically produces high resolution 50 megapixel panoramic
images. Due to the full automatic high dynamic range (HDR)
capabilities of the iSTAR, inspection-standard photography can be
collected under the widest range of illumination conditions across
the site. This gives confidence to the Underhill team, that they can
capture data first time, every time.
When viewed in an immersive viewer in a web browser, project
managers can seamlessly view the environment immediately
around the camera; whether this be detail on the walls, or more
importantly what is directly above the camera or at the interfaces
between the walls and the ceilings. Critically, all this information can
be seen for one camera position all in one view, at one time.

HDR OFF					

HDR ON

Typical differences seen when using HDR image capture
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The user interface to PhotoDocufy shows a plan view of each floor of
the build, upon which is marked the location of were each 360-degree
photograph has been taken. These are camera locations that the
Underhill team has indexed in accordance with a set of key plans, and
consistently located during each photography phase relative to walls
and other structures in the environment. Each of these locations is
a hyperlink that when selected, the user can interactively view the
360-degree photograph in an immersive manner through their web
browser. This enables stakeholders and decision makers to undertake
a virtual tour of the project site at any time that they see fit.

Underhill Geomatics’ PhotoDocufy website
Due to these characteristics, the principle reason to use 360-degree
photography is to streamline the process of image documentation.
Using a 360-degree camera means that the image from one camera
position will capture the same amount of information as up to eight
(8) conventional photographs.
This leads to much improved consistency when capturing
photographs of the same locations in the build during the different
phases of the survey.
In a multi-year project such as this where even with 360-degree
photography there are likely to be around 11,000 photographs taken
in total; there would be far more risk and complexity in the data
management procedures of this project, if conventional photographs
were used.

Mechanical and plumbing installations inside wall and ceiling seen in a
singular 360-degree photograph

Benefits of iSTAR 360-degree photography
to construction site documentation
Context
The main comment from the users of the Photodocufy service is that
360-degree photography provides the context that they need. Without
the omissions and impediments that are present in standard planar
photography, both the General Contractor (Balfour Beatty Construction
and Ledcor) and their customer (Affinity Partnerships) alike, can
undertake full review after each building trade has completed their
work at the end of each building phase.
Photodocufy per-floor camera location plan at the TACC
Underhill store, manage and share the photographs that they collect
for Balfour Beatty Construction and Ledcor via their PhotoDocufy
service. PhotoDocufy is an online platform that provides private
access to all relevant stakeholders on the TACC project. Stakeholders
can access all photographs collected, anywhere and anytime via a
secure web browser interface either through a conventional computer
or their mobile device.

From an audit point of view, the General Contractor can see exactly
what has been installed behind each panel of dry-wall and each
flooring slab. The customer can ‘virtually’ walk through the site at their
wish, to undertake a complete inspection and ensure the contract is
being delivered to as specified.
Cost
As already indicated, a singular 360-degree photograph contains
the same information as up to eight planar images. Considering that
as of December 2016, the Underhill team has made 170 visits to site
to capture 5,900 individual panoramic images; the incremental cost
savings with regards to onsite time, data storage and management,
on each visit are obvious.
Through minimizing the number of photos taken and using a
360-degree imaging technique that ensures complete coverage;
Underhill has better foresight of the data management considerations
over the complete life-cycle of the project and provides concise costs
to its client to underpin their planning as well.

Photodocufy user interface provides tools to interactively interrogate
the context of each photograph

For further information about iSTAR or NCTech software visit
www.nctechimaging.com or contact us sales@nctechimaging.com
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Using iSTAR - Hampshire Fire and Rescue Service

In response to a Government drive to
improve arson attack conviction rates,
Hampshire Fire and Rescue Service set
up - as did other Fire Services around
the UK - an Arson Task Force, working in
conjunction with Hampshire Constabulary.
Established in 2007 this partnership
continues to operate. As part of this joint
approach where the cause of any fire is
doubtful, or if there has been a fatality,
the Arson Task Force goes to work, with
the Fire Service Investigators working
alongside their police CSI colleagues. The
Fire Investigators produce the evidence
that the police need to prosecute or for a
coroner to determine cause of death. As
part of this the Fire Investigators are now
recognised as expert witnesses in court.
‘We Make Life Safer’
Since the Task Force was formed arrest
rates (55%) and conviction rates (68%)
have both risen significantly, in simple
terms meaning that they are identifying
arsonists and getting them off the streets.
The Hampshire Arson Task Force & Fire
Investigation Unit is recognised as one of
the best in the UK and is a busy one: at
time of writing it had 12 cases going to
court, nine cases for which reports are
being produced, plus several Coroner
Courts on-going. Around 30 cases of
arson go to court annually in the county.
The Unit is using iSTAR to help them
understand fires that are not cases of
arson but still require investigation to
establish what has happened, and iSTAR is
also proving to be an invaluable addition
to help tackle more routine incidents, plus
essential work aimed at improving the
safety of fire crews and the public. The
organisation’s strapline is ‘We make life
safer’ and Station Manager Damian Watts
explains some of the ways in which iSTAR
is rapidly becoming an indispensable part
of their equipment.

CASE STUDY: Using iSTAR
- Hampshire Fire and Rescue Service
“We read a magazine called ‘In
Attendance’, a tri-service publication
which is distributed to Fire, Police and
Ambulance stations across the country
highlighting good working practices. It
carried an article about West Midlands
police who used iSTAR in a murder case,
showing detailed 3D images of the crime
scene to the jury, judge and legal teams
without the need for them to leave the
courtroom. This got us interested in iSTAR.
“We take photographs with ordinary
digital cameras as part of the evidential
package, sometimes as many as 200, but
they don’t really put the scene in context
- it’s a 2D flat image of, say, a door with
some burn patterns on it. Having a 3D
image of the room shows where the door
fits into the fire scene and how it interacts
with that fire scene. This additional level
of information helps us for both criminal
investigations and organisational learning.
Easy Transmission of Images Back to
Base
“Through our Arson Task Force police
colleagues we do have access to a 3D
laser scanner but that takes a long time to
gather the information and when working
in a normal domestic room it often isn’t
worth the time it takes to set it up. Having
iSTAR, which is quick and simple to use,
allows us to easily transmit images back
to base or show to others, with minimal
software implications. It’s ideal.
“So, having read the article we
approached NCTech and Rob Jones came
to give us, and several other departments
in Hampshire Fire and Rescue Service, a
demonstration. This led to us taking an

iSTAR camera on a trial basis to see what it
could do at real fire incidents and evaluate
its use in real life situations.
“The key benefit is that it enables you to
put the whole scene in context, to be able
to see - and show other people who are
not fire investigators - how specific items
interact with everything else. While it
appears as a 2D image on your screen the
360 panoramic capabilities gives it a virtual
3D effect.”
Improving the Understanding of Fire
Risks
“Amongst those we have shown
iSTAR images to are, for example, the
Safeguarding Board which comprises
safeguarding professionals from the whole
of the county, including adult mental
health professionals, nurses, and staff
who look after the socially vulnerable. We
had a meeting with them on the same
day we had attended a fire in a residential
care unit. An elderly gentleman had
dropped a cigarette into his chair where
it smouldered and then ignited. Being
able to show the images we had taken
to that group of professionals showed
how the gentleman was living in his flat,
the dangers he had been exposed to and
also the dangers our firefighters had been
exposed to. That allowed the safeguarding
professionals to go away with a better
understanding of the whole situation and
how it affected the resident. They will be
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putting in interventions to help him once
he gets out of hospital.
“It will also help them avoid similar
situations in other care facilities and it
highlighted one of the problems we face
in the fire service - falling cables. This is
where there is a secondary fit of electrical
cables which are put inside plastic trunking
and fixed to ceilings and walls. In a fire the
trunking melts and the cables fall free and
can entangle those trying to escape or our
firefighters entering to rescue them and/or
put out the fire. This happened in the care
home. Fortunately the cables caught up
on a door, but by using iSTAR images we
could easily show the risk this represents
and those on the Board are now aware of
the problem.
“It’s been a very good addition to our kit.
We had it on a two week trial and then
bought it. I think we are the first Fire
Service to use it and I’ve put details onto
the Chief Fire Officers Association (CFOA)
forum on how it has helped us clarify our
thinking towards fire investigation and
I know this has led to some other Fire
Services contacting NCTech.
“iSTAR is easy to use - just like a ‘point
and click’ camera. It does what it says
on the box! The thing I like about it is its
very good low light capability, especially
in the HDR mode. A lot of the work we
do happens at night and it picks up good
quality images with minimal lighting.
That, plus the portability, confined space
capability and the ruggedness of it really
helps in the environments we work in.
Hot Spotting Tags Bring Up Essential
Information on the Image
“NCTech is doing more development work
on the camera, some of which we have
asked for. Things like ‘hot spotting’ where
you can bring up different information
from an image. A tag is put into an image
and, when you click on it, it will bring up a

separate image or a piece of information.
For example, I could click on a gas boiler in
an iSTAR image and it would bring up all
the risk information about that boiler unit.
“Something we think we will use it for in
the future is for SSRI - Site Specific Risk
Information - work on high risk buildings.
It’s also known as a 11D visit - section
1 paragraph 1 subsection D of the Fire
Services Act. This is about gathering
advance information on a building so
that we are best informed should there
be a fire - what the risks are and how to
tackle a fire there. Part of that is that I
can go and take 360 degree images in
the building using iSTAR and we can get
a detailed ‘walk through’ of the whole
building
We could then click on, say, the computer
room and ‘hot spotting’ will bring up all
the firefighting equipment in there and
what the risks are in the room. In historic
buildings, of which we do a fair number,
we could click on the image of a room and
then the tag will tell us what needs to be
salvaged first, for example, a particularly
valuable painting, or what can be left.
This type of information informs our
tactical plan. On the fireground, incident
commanders can look at the images and
prioritise what they need to do. Being able
to gather and then easily access this sort of
visual information in real time is invaluable.
“As I said, its portability is great. We can
get it set up in a couple of minutes and
get real time info, rather than wait 15 or
20 minutes while a laser scanner does its
work. iSTAR’s almost instant. I can take an
image as soon as I get there, then another
every, say, five minutes, and get a picture
of the incident progresses.
Delivering Tactical Management
Information to Incident Commander
“During the trial, any Level 2 fire that
occurred we took the camera along and

one of these instances was a ten-pump
fire in Portsmouth. We got there when
it was only at two pumps, took images,
processed them on the ground and
showed them to the Incident Commander.
Once an incident gets to ten pumps he
needs to stay back and deliver tactical
management from a nearby remote
location. Because we went there so early
we were able to take him those images
and show him his firegound and where his
resources were, so he was able to make
some real informed decisions about the
tactics to tackle that fire.
“We’ve also used it on a couple of RTCs Road Traffic Collisions - which are purely
investigated by the Police, who use the 3D
laser scanner for serious accidents. They
have been interested in what iSTAR can
do because if they can gather the essential
information faster and get the road open
quicker, then it’s a real plus.
“It’s also gone along to a large animal
rescue, a bull stuck in some mud. We used
the images from that for debriefing the
crews. We can use the images to jog their
memories and put the scene in context
- where they were positioned, what they
were doing and what we could have done
better. So, ideal for training purposes, too.
“There are operational implications we
need to address in that if we only have
one iSTAR unit I need to work out how we
keep it in use 24/7. Last thing we want is it
sitting on a desk not in use.
“NCTech have been very interactive. Rob
Jones gave my investigators a lot of time,
showing how to set it up, use it, and they
are doing work on the software side for
us, like the ‘hot-spotting’ on images we
supplied. The support we have had is
allowing us to use that camera to the best
of our ability.”
Photographs highlighting the iStar camera’s use
courtesy of Hampshire Fire and Rescue Service.
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Productivity with iSTAR - Precision Surveys

PRECISION
SURVEYS
achieves 10x productivity
improvement using iSTAR
for 360 degree imaging
Surveying firm wows
architect clients by
supporting laser scanning
with HDR panoramic images

F

or 40 years, Precision Surveys
Limited has been oﬀering a
comprehensive consulting
service orientated towards providing
land-related information to both public
and private sector clients throughout
Ireland. It has more than 8,000 surveys
completed which include building
surveys, reference plans, legal and
topographic surveys, laser scans, point
cloud to BIM, control and engineering
surveys, taking in charge and layouts.
Most architects and developers will
use architectural photo-montages—
computer generated images that show

BY CHRIS DRYDEN

what a future scheme might look like.
There are many factors and variables
that mean the visual accuracy of such
images can be questionable. Verified
views or orthographic photos are
architectural photo-montages which
have been created to a high level of
verifiable accuracy using collected
survey data, precise photography and a
strict recorded methodology.
“In the last three to four years we
have been increasingly focused on laser
scanning, particularly in conservationrelated projects,” said David Buﬃni,
director at Precision Surveys. “And

many clients in this area are very keen to
receive correlating panoramic images in
addition to the laser scan data to provide
an accurate, verified view of how a
structure appears visually.”
For its laser scanning projects,
Precision Surveys use the Leica P40
scanner, which does oﬀer the ability to
take photographic images in addition
to the scan, but this adds considerable
time to the scanning process and can
have significant limitations in low light
conditions, where colour accuracy can
be diﬃcult to achieve.
“A single scan typically takes about
three minutes, but adding a panoramic
image typically adds an extra seven to
eight minutes every time, which quickly
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Floorplans and elevations of Monaghan’s Cathedral.
Client: Foster, Morgan + Fuller Ltd

adds up as you scan a complete site,
which can involve hundreds of scans,”
said Buﬃni. “In addition, the scanner
camera takes a lot of single-frame
pictures, which are then stitched together
later, and this can also impact on the final
image quality if the light changes while
images are being captured.”

eﬃcient visual documentation of almost
any environment.
iSTAR uses four pre-calibrated
camera sensors, fully synchronised to
deliver a highly accurate 50MP spherical

image with excellent high dynamic
range (HDR). The camera is fast, with
typical capture times averaging around
10 to 20 seconds for a five-exposure
HDR image.

Enter iSTAR
Precision Surveys then came across
iSTAR—the world’s highest resolution,
fully automatic, 360-degree HDR
camera. Machined from solid metal
for robustness and accuracy, iSTAR
precisely captures full spherical
immersive images and high resolution
panoramic data streams for fast,

Capture of Dublin’s city centre rooftops.
Client: Virtus Project Management
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“The architects we work with have
been blown away by the quality of the
imaging we provide through iSTAR,” said
Buﬃni. “The colour output is incredible
and can actually provide our clients with
such confidence in the accuracy of their
images that they may not even require a
confirmation visit to the site.”

A Georgian House in Ballsbridge, Dublin city centre.
Client: Cummins & Voortman Ltd

“The iSTAR’s speed of capture is a
huge factor for us, coupled with its ease
of use,” said Buﬃni. “We can save a huge
amount of time—sometimes as much
as a full day—by simply being able to
quickly take a 360 degree colour image
after each scan. The images can then be
easily integrated with the laser scan data
to provide orthographic images that are
visually stunning as well as accurate.”
Processing and stitching the images
is also fast – iSTAR takes just seconds
to conduct batch stitching. The camera
can be mounted and deployed in various
methods: terrestrial, with a standard
tripod connected into the camera base;
vehicle-mounted using roof bars; tripod
suction feet, or; secured under a UAV
for airborne mapping.
“I’d estimate that iSTAR has provided
around a ten-fold improvement in
productivity when it comes to collecting
photographic imagery on a scanning
project,” said Buﬃni.
“And with the recent Leica integration
that automates the import of iSTAR
data, we expect to see even greater
productivity improvements.”

Delivering value in
conservation
Precision Surveys has already delivered
data for some compelling conservation
projects using the iSTAR camera.
The orthographic images provide the
basis on which the architect’s building
information models will be refined in
terms of geometry and texture. These
virtual models will then be used to
assist with the conservation strategy
and the proposed detailed design of the
refurbishment and extension.

About NCTech
NCTech designs and manufactures leading
360 degree reality imaging systems that
automate and streamline the workflow of
image documentation and can be used
repeatedly, accurately, consistently by
anyone anywhere.
NCTech’s industrial-grade camera, iSTAR®,
is a fast, fully automatic, 50 megapixel,
360 degree HDR camera. Fully calibrated
for high precision applications such as
colourisation of laser scans or extracting
photogrammetric measurements, iSTAR has
multiple applications: from covert operations
and police reporting of crime scenes to 3D
laser documentation and asset management
for the engineering and heritage sectors.
In 2015, the company launched iris360,
intended for aesthetic panoramic image
capture and fully integrated with Google
Maps’ new Street View app.
NCTech is headquartered in Edinburgh,
Scotland and is funded by Archangel
Investors Ltd and the Scottish Co-Investment
Fund. For more information, visit www.
nctechimaging.com

A very old building in Dublin’s Camden Street.
Client: Meehan Associates
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